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ВВЕДЕНИЕ 

 

Поиски и разведка полезных ископаемых важнейший раздел при-

кладной геофизики, называемый разведочной геофизикой. Рудные 

полезные ископаемые не являются исключением – в этом случае раз-

ведочную геофизику принято называть рудной. К рудным полезным 

ископаемым относят различные типы минерального сырья, из кото-

рого технологически возможно и экономически целесообразно из-

влекать в промышленных масштабах металлы или получать на их ос-

нове другие материалы. Геофизические методы при поисках и раз-

ведке месторождений рудных полезных ископаемых (рудная геофи-

зика) применяются на всех стадиях геологоразведочных работ – от 

региональных исследований до обслуживания рудничной геологии 

месторождений во время эксплуатации [1]. 

Частью разведочной геофизики, соответственно рудной геофи-

зики, является большая группа геофизических методов – электриче-

ская разведка или просто электроразведка. В этой группе геофизиче-

ских методов с помощью электромагнитных полей изучают строение 

Земли с целью поиска полезных ископаемых и решения множества 

других прикладных задач, включая инженерно-геологические. 

Электроразведка основана на исследовании электромагнитного 

поля различной природы, которое изменяется в зависимости от элек-

тромагнитных характеристик геологической (изучаемой) среды (со-

противление, поляризуемость и др.), узнав которые можно получить 

ценную информацию о строении изучаемого участка или района. 

В электроразведке имеется большое количество различных мето-

дов-технологий, основанных на конкретном физическом явлении, 

позволяющем производить с помощью электромагнитных полей ди-

станционное исследование геологических объектов. В основе каж-

дого метода лежит определенная геоэлектрическая модель геологи-

ческой среды. Для такой модели разрабатывается методика полевых 

работ, а также способы обработки и интерпретации данных. 

Одним из ведущих электроразведочных методов поиска и изуче-

ния в рудной геофизике является метод сопротивлений в различ-

ных его модификациях. До 90-х гг. прошлого столетия наиболее рас-

пространенным методом зондирования на постоянном токе был ме-

тод вертикальных электрических зондирований (ВЭЗ). Однако эта 
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методика, хорошо зарекомендовавшая себя при изучении горизон-

тально-слоистых сред, оказалась малоэффективна в сложнопостроен-

ных, неоднородных средах, которые характерны для большинства 

рудных районов. В последние два десятилетия метод ВЭЗ все чаще 

заменяют электротомографией (ЭТ) – комплексом, включающим в 

себя, как методику полевых наблюдений, так и технологию обра-

ботки и интерпретации полевых данных, для неоднородных сред. Для 

проведения работ методом электротомографии применяются специ-

альные многоэлектродные станции. Многоканальные системы изме-

рений обеспечивают высокую технологичность работ, но имеют 

ограничения по глубинности исследований [2]. 

В теории электроразведки, как и в любом геофизическом методе, 

выделяют прямые и обратные задачи. Не является исключением и 

метод электротомографии. Под прямой задачей ЭТ понимается рас-

чет электромагнитного поля при известном распределении электро-

магнитных свойств в Земле (геоэлектрическая модель разреза) для за-

данных источников поля. Обратная задача – определение электромаг-

нитных свойств и геометрии разведываемых объектов по известным, 

измеренным полям в рамках выбранных геоэлектрических моделей. 

Прямые и обратные задачи ЭТ решают (соответственно проводят 

интерпретацию данных) в рамках двумерных и трехмерных моделей 

с помощью специальных алгоритмов инверсии. 

Именно прямым и обратным задачам электротомографии посвя-

щено данное пособие. Здесь разобраны физические основы метода 

электротомографии. Излагаются вопросы методики и техники прове-

дения работ, рассматриваются особенности решения прямых и обрат-

ных задач в двумерной и трёхмерной постановке. Для этих целей ис-

пользуются простейшие программы: Res2DMod, ZondRes2D, 

Res3DMod – для прямого моделирования; Res2DInv, ZondRes2D, 

Res3DInv – для решения обратных задач. 

Учебное пособие можно считать неотъемлемой частью курса 

«Рудная геофизика» в Новосибирском государственном универси-

тете и курсов «Электроразведка» и «Математическое моделирование 

в геофизике» в Забайкальском государственном университете. 

Все примеры и задачи, представленные в данном пособии выло-

жены в свободном доступе в сети Интернет по адресу: 

http://www.geoelectriclab.com/NSU/OreGeophys. 

  

http://www.geoelectriclab.com/NSU/OreGeophys
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1. ЭЛЕКТРИЧЕСКИЕ СВОЙСТВА ПОРОД И РУД 

 

Одним из основных требований к применению метода сопротив-

лений в модификации электротомографии, как и любого геофизиче-

ского метода, является контрастность по физическим свойствам объ-

екта изучения относительно вмещающей среды. В нашем случае это 

означает, что изучаемый объект (тело, слой, пласт и пр.) должен за-

метно (желательно в несколько раз) отличаться по удельному элек-

трическому сопротивлению ρ (УЭС) от вмещающих пород. 

Помимо УЭС, к важным электромагнитным свойствам горных по-

род можно отнести: поляризуемость η, диэлектрическая ε и магнит-

ная μ проницаемости и др. Приведём краткое описание каждого из 

этих параметров. 

Удельное электрическое сопротивление 

Удельное электрическое сопротивление (УЭС), измеряемое в ом-

метрах (Ом·м), характеризует способность пород оказывать электри-

ческое сопротивление прохождению тока и является наиболее уни-

версальным электромагнитным свойством. Добавленное прилага-

тельное «удельное» указывает на фактор использования эталонной 

величины объема, принятой для рассматриваемого вещества. Это 

позволяет оценивать электрические параметры разных материалов. 

УЭС меняется в горных породах и рудах в очень широких преде-

лах: от 105 до 1015 Ом·м. Обратная к УЭС величина, 1   , назы-

вается электропроводностью и измеряется в сименсах на метр (См/м). 

Для наиболее распространенных осадочных, изверженных и мета-

морфических горных пород УЭС зависит от минерального состава, 

физико-механических и водных свойств горных пород, концентра-

ции солей в подземных водах и в меньшей мере от их химического 

состава, а также от некоторых других факторов (температуры, глу-

бины залегания, степени метаморфизма и др.). 

На рис. 1 приведены интервалы удельного электрического сопро-

тивления и удельной проводимости некоторых горных пород. 

УЭС минералов зависит от их внутрикристаллических связей. Для 

минералов-диэлектриков (кварц, слюды, полевые шпаты и др.) с пре-

имущественно ковалентными связями характерны очень высокие со-

противления (1012–1015 Ом·м). Минералы-полупроводники (карбо-

наты, сульфаты, галоиды и др.) имеют ионные связи и отличаются 
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высокими сопротивлениями (104–108 Ом·м). Глинистые минералы 

обладают ионно-ковалентными связями и выделяются достаточно 

низкими сопротивлениями (
410 Ом м  ). Рудные минералы (са-

мородные, некоторые окислы) отличаются электронной проводимо-

стью и очень хорошо проводят ток ( 1Ом м  ). Первые две группы 

минералов составляют «жесткий» скелет большинства горных пород. 

Глинистые минералы создают «пластичный» скелет, способный ад-

сорбировать связанную воду, а породы с «жесткими» минералами 

могут насыщаться лишь растворами и свободной водой, т. е. той, ко-

торая может быть выкачана из породы. 

 

Рис. 1. Удельное электрическое сопротивление и удельная проводи-

мость некоторых горных пород [3] 

 

Удельное электрическое сопротивление свободных подземных 

вод меняется от долей Ом·м при высокой минерализации (M>10 г/л) 
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до 1000 Ом·м – при низкой (M<0,01 г/л). Химический состав раство-

ренных в воде солей не играет существенной роли, поэтому по дан-

ным электроразведки можно судить лишь об общей минерализации 

подземных вод. УЭС связанных вод низкое и мало меняется (от 1 до 

100 Ом·м). Это объясняется достаточно постоянной их минерализа-

цией (3–1 г/л). 

Так как поровая вода отличается значительно более низким УЭС, 

чем минеральный скелет большинства минералов, то сопротивление 

горных пород практически не зависит от его минерального состава, а 

определяется такими параметрами пород, как пористость, трещино-

ватость, водонасыщенность. С их увеличением сопротивление пород 

уменьшается за счет увеличения ионов в подземной воде. Поэтому 

электропроводность большинства пород является ионной (электро-

литической). 

С ростом температуры на 40° сопротивление уменьшается при-

мерно в 2 раза, что объясняется увеличением подвижности ионов. 

При замерзании сопротивление горных пород возрастает скачком, 

так как свободная вода становится практически изолятором, а элек-

тропроводность определяется лишь связанной водой, которая замер-

зает при очень низких температурах (ниже 50 °С). Возрастание со-

противлений при замерзании разных пород различно: в несколько раз 

оно увеличивается у глин, до 10 раз – у скальных пород, до 100 раз – 

у суглинков и супесей и до 1000 и более раз – у песков и грубообло-

мочных пород. 

Глубина залегания, степень метаморфизма, структура и текстура 

породы также влияют на ее сопротивление, изменяя коэффициент 

микроанизотропии, за который принято брать n l    , где n  и 

l  – сопротивления породы вкрест и вдоль слоистости. Чаще всего λ 

меняется от 1 до 1,5, достигая 2–3 у сильно рассланцованных пород. 

Величина   может достигать нескольких единиц для мерзлых пород 

разной криогенной структуры. 

Несмотря на зависимость ρ от множества факторов и широкий 

диапазон изменения у разных пород, основные закономерности УЭС 

установлены достаточно четко. Изверженные и метаморфические по-

роды характеризуются высокими сопротивлениями (от 500 до 

10000 Ом·м). Среди осадочных пород высокие сопротивления (100–

1000 Ом·м) у гипcов, известняков, песчаников и некоторых других. 
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Обломочные осадочные породы, как правило, имеют тем большее со-

противление, чем больше размер зерен, составляющих породу, т. е. 

зависят прежде всего от глинистости. При переходе от глин к суглин-

кам, супесям и пескам удельное сопротивление изменяется от долей 

и первых единиц омметров к первым десяткам и сотням oмметров. 

Поляризуемость горных пород 

Способность пород поляризоваться, т. е. накапливать заряд при 

пропускании тока, а затем разряжаться после отключения этого тока 

оценивается коэффициентом поляризуемости  . Величина   вычис-

ляется в процентах как отношение напряжения, которое остается в 

измерительной линии МN по истечении определенного времени 

(обычно 0,5–1 с) после размыкания токовой цепи ВПU , к напряже-

нию в той же линии при пропускании тока U , т. е. 

100 % .ВПU U     

Поляризация – это сложный электрохимический процесс, проте-

кающий при пропускании через породу постоянного или низкоча-

стотного переменного (до 10 Гц) тока. Наибольшей поляризуемостью 

(10–40 %) отличаются руды с электронной проводимостью (суль-

фиды, сульфосоли, некоторые самородные металлы, отдельные 

окислы, графит, антрацит). Природа этих потенциалов вызванной по-

ляризации (ВП) связана с так называемой концентрационной и элек-

тродной поляризацией рудных минералов. Коэффициенты поляризу-

емости до 2–6 % наблюдаются над обводненными рыхлыми осадоч-

ными породами, в которых имеются глинистые частицы. Поляризуе-

мость их обусловлена возникающими зарядами на контакте твердой 

и жидкой фазы. Большинство изверженных, метаморфических и оса-

дочных пород, насыщенных минеральной водой, слабо поляризуются 

(меньше 2 %). 

Многолетнемёрзлые породы способны сильно поляризоваться на 

ранних временах (высоких частотах) процесса поляризации с посто-

янной времени  около 0,1 мс. Механизм этого процесса объясняется 

Максвелл-Вагнеровской поляризацией. На поздних временах поля-

ризации (в диапазоне десятков и сотен миллисекунд) поляризуемость 

мёрзлых пород будет низкая. Она зависит от содержания незамёрз-

шей воды в породе и у чистого льда будет равна нулю. 
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Диэлектрическая и магнитная проницаемости 

Диэлектрическая ε и магнитная μ проницаемости играют значи-

тельную роль лишь при электроразведке на высоких частотах и при 

электротомографии не используются. Тем не менее эти электромаг-

нитные свойства всё чаще используются в современной электрораз-

ведке. 

Относительная диэлектрическая проницаемость 0п     (где п  

и 0  – диэлектрические проницаемости породы и воздуха) показы-

вает, во сколько раз увеличивается емкость конденсатора, если вме-

сто воздуха в него поместить данную породу. Величина ε меняется от 

нескольких единиц до 80 и зависит, в основном, от процентного со-

держания воды и минералогического состава породы. У извержен-

ных пород ε меняется от 5 до 12 единиц, у осадочных – от 2–3 (у су-

хой), до 16–40 (у насыщенной водой породы). 

Магнитная проницаемость большинства пород равна магнитной 

проницаемости воздуха. Лишь у ферромагнетиков относительная 

магнитная проницаемость может возрастать до 10 единиц [1, 4]. 

В электротомографии используется различие пород по УЭС и по-

ляризуемости. Эти параметры позволяют решать задачи рудной гео-

физики, перечисленные в следующем пункте пособия. 
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2. ГЕОЛОГИЧЕСКИЕ ЗАДАЧИ ЭЛЕКТРОТОМОГРАФИИ 

ПРИ ПОИСКАХ РУДНЫХ МЕСТОРОЖДЕНИЙ 

 

Поиск новых рудных месторождений, а также изучение и дораз-

ведка известных месторождений имеют важное значение для дея-

тельности горнодобывающих компаний. В электроразведке накоплен 

богатейший опыт применения различных методов для поисков руд-

ных тел и решения сопутствующих геологических задач. В последние 

годы в практику производственных работ, для решения рудопоиско-

вых задач, активно внедряется электротомография. 

Поиски рудных ископаемых начинаются с постановки или ана-

лиза данных уже имеющихся региональных среднемасштабных 

(1:200000) геофизических съемок, а иногда с их целевой переинтер-

претацией. Такие работы позволяют установить основные законо-

мерности в распределении месторождений полезных ископаемых, 

связи между положением рудных поясов, полей и месторождений, 

рудовмещающих и рудоконтролирующих структур с глубинным 

строением земной коры. На этом этапе основную роль играют глу-

бинные электроразведочные методы – магнитотеллурическое зонди-

рование и аэроэлектроразведка методом переходных процессов. 

При крупномасштабном (1 : 50000) геологическом картирова-

нии основными задачами являются: определение мощности и состава 

рыхлого покрова; установление гипсометрии поверхности погребен-

ного фундамента; выявление мощности и состава коры выветривания 

погребенных пород; расчленение по литологическому составу; изу-

чение состава и морфологии интрузивных массивов; выделение важ-

нейших рудоконтролирующих структур и крупно-масштабный про-

гноз. На этой стадии возрастает роль наземных геофизических мето-

дов, а из электроразведочных – методы электромагнитного зондиро-

вания (АМТЗ, ЗСБ, ВЭЗ). Стоит сказать, что на данном этапе метод 

ЭТ практически не используется. 

На стадии поисков, работы в пределах разведуемого месторожде-

ния выполняются на локальных перспективных площадях, где выяв-

лены признаки, характерные для оруденения. Признаки могут быть 

как прямыми (проявления рудной минерализации), так и косвенными 

(наличие продуктивных горизонтов и свит, рудоконтролирующих 

структурных элементов, околорудных изменений пород и т. п.). Мас-

штаб поисковых работ может изменяться от 1 : 10 000 до 1 : 2000 и 
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выбирается с учетом размеров искомых рудных объектов и сложно-

сти геологического строения площади. На этой стадии массово при-

меняются наземные электроразведочные методы в различных моди-

фикациях. Обязательным является применение разновидностей ме-

тода вызванной поляризации, так как обычно аномалии ВП напря-

мую связаны с рудной минерализацией. На этой стадии, целесооб-

разно применять метод электротомографии для решения рудопоис-

ковых задач в 2-D или 3-D модификации, в зависимости от масштаба 

съемки. 

Поисково-оценочные работы (масштаб 1 : 5000 – 1 : 2000) в пре-

делах разведуемой площади ведутся с целью оценки возможного про-

мышленного значения оруденения на участках выявленных проявле-

ний полезных ископаемых. Геофизические исследования представ-

лены детализационными и микрогеофизическими съемками, рабо-

тами по изучению природы и оценке рудоносности геофизических и 

геохимических аномалий, скважинными исследованиями. Весьма эф-

фективна при таких масштабах исследований трёхмерная электрото-

мография с измерением вызванной поляризации. Информация этих 

работ используется для уточнения строения разведуемого участка и 

распространения в его пределах полезного ископаемого, отнесения 

выявленных рудных тел к определенному геолого-промышленному 

типу, приближенной геометризации контуров рудных тел, подсчета 

запасов полезного ископаемого по категории С2, оценки прогнозных 

ресурсов по категории P1 на слабо изученной части площади, состав-

ления технико-экономических соображений о возможном промыш-

ленном значении выявленного оруденения. 

Если по данным поисково-оценочных работ и предварительной 

разведки прогнозные запасы полезного ископаемого на выявленном 

месторождения достаточны, а предполагаемые горнотехнические 

условия его добычи благоприятны, то проводят детальную разведку 

месторождений. Целью детальной разведки является изучение осо-

бенностей морфологии и внутреннего строения отдельных рудных 

тел, что необходимо для подсчета запасов, оценки горнотехнических 

и гидрогеологических условий проведения эксплуатационных работ. 

Детальную разведку осуществляют главным образом с помощью 

скважин и горных выработок, и в последнее время эти работы всё 

чаще комплексируют с электротомографией с измерением ВП. Ана-



13 

логичная ситуация происходит и на стадии эксплуатационной раз-

ведки месторождений – бурение дополняется исследованиями мето-

дом ЭТ в карьерах и рудниках. 

Таким образом, можно выделить следующие основные задачи 

электротомографии при поисках рудных месторождений: 

 картирование рудоконтролирующих структур (разломов, ин-

трузий) для планирования горно-буровых работ, выделение зон суль-

фидной минерализации по аномалиям вызванной поляризации (ста-

дия поисковых и поисково-оценочных работ); 

 построение объёмных геоэлектрических моделей для про-

гноза ресурсов и оценки запасов (стадии предварительной и деталь-

ной разведки месторождения); 

 прослеживание известных рудных зон в пределах рудников и 

на флангах месторождений (стадии детальной и эксплуатационной 

разведки). 

Как уже говорилось все перечисленные задачи решаются методом 

электротомографии в связи с тем, что существует контрастность по 

физическим свойствам объекта изучения относительно вмещающей 

среды. Для электроразведки методами сопротивлений, частным слу-

чаем которого является метод электротомографии, это означает, что 

изучаемый объект (рудная зона, разлом, интрузия и пр.) должен от-

личаться по удельному электрическому сопротивлению  или пара-

метрам вызванной поляризации от вмещающих пород. 

Теперь, когда мы знаем задачи, которые решает электротомогра-

фия и свойства горных пород, используемые для этого, остаётся разо-

браться в физических основах метода, который является модифика-

цией метода сопротивлений. Разберём этот вопрос в следующем раз-

деле пособия. 
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3. ОСНОВЫ МЕТОДА СОПРОТИВЛЕНИЙ.  

ЭЛЕКТРОТОМОГРАФИЯ 

 

К методу сопротивлений относятся модификации электрораз-

ведки, теория которых основана на изучении распределения поля по-

стоянного электрического тока в проводящих геологических средах 

от искусственных источников с известными параметрами [5, 6]. Срав-

нительная простота и наглядность метода сопротивлений привела к 

его широкому распространению во всем мире. 

В рамках метода сопротивлений существует большое количество 

модификаций исследования. Приведём три основные. 

Электропрофилирование (ЭП) – установка перемещается по 

профилю без изменения своей конфигурации. Так как геометрия 

установки не меняется, глубина исследования остается постоянной. 

Эта методика предназначена для узкого круга задач. Например, при 

картировании горизонтальных неоднородностей геоэлектрического 

разреза. 

Вертикальное электрическое зондирование (ВЭЗ) – на каждой 

точке наблюдений проводятся измерения при возрастающих разме-

рах установки. С помощью электрических зондирований исследуют 

изменения удельного сопротивления пород с глубиной. 

Электротомография (многоэлектродные зондирования) – объ-

единение методик зондирования и профилирования. Особенностями 

этой модификации являются многоканальные измерения с помощью 

системы электродов, размещенных вдоль одного профиля на равных 

расстояниях друг от друга, а также двумерный или трёхмерный мате-

матический аппарат инверсии данных. 

В любом случае, каждая из модификаций метода сопротивлений, 

основана на одной теории – поле постоянного электрического тока в 

проводящих средах от искусственных источников. 

В основе метода сопротивлений лежит зависимость электриче-

ского поля, наблюдаемого на земной поверхности, от удельного элек-

трического сопротивления разреза. На поверхности земли собирают 

электроразведочную установку, которая, как правило, состоит из 

двух питающих и двух приемных электродов (рис. 2). В качестве 

электродов обычно применяют металлические штыри, которые заби-

ваются в землю. К питающим электродам, которые принято обозна-

чать буквами А и В, с помощью проводов подсоединяют источник 
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тока – специальный генератор. В земле возникает электрическое 

поле, вызванное током IAB, стекающим с электродов. На приемных 

электродах (чаще всего их обозначают M и N) возникает разность 

электрических потенциалов ∆UMN. Измерения тока и разности потен-

циалов проводят электроразведочным прибором. В результате можно 

судить об электрических свойствах горных пород на глубинах про-

никновения тока в землю. 

 

Рис. 2. Схема измерений в методе сопротивлений 

 

Существует много вариантов электроразведочных установок. Ре-

зультат измерения с данной установкой зависит от её конфигурации 

и от распределения удельного электрического сопротивления в неко-

торой области геоэлектрического разреза вблизи установки. Размер 

этой области, в том числе и глубина исследования, зависит от геомет-

рии установки, главным образом от расстояния между питающими и 

приёмными электродами. Это расстояние называется разносом уста-

новки, а глубина исследования – глубинностью установки (ме-

тода).  

Для удобства анализа и интерпретации наблюдаемого электриче-

ского поля было введено понятие кажущегося удельного электри-

ческого сопротивления (КС), которое обозначается как ρk, измеря-

ется в Ом·м и рассчитывается по формуле: 
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где K – геометрический коэффициент (зависит от взаимного располо-

жения и расстояний между электродами A, B, M и N), ∆UMN – разность 

потенциалов на приемных электродах M и N, IAB – сила тока, проте-

кающего в питающей линии. 

Кажущееся электрическое сопротивление является сложной функ-

цией изучаемого геоэлектрического разреза, т. е. зависит от удельных 

сопротивлений, размеров, глубин залегания слоев или включений [7] 

и характеризует интегральное значение УЭС горных пород в области 

исследования. Область исследования располагается чаще всего под 

центром установки и простирается от поверхности до глубины, при-

мерно равной половине длины установки – 2AB  (см. рис. 2). 

Если изучаемая среда однородна по УЭС, то значение получен-

ного кажущегося сопротивления ρk будет тождественно равно 

среды среды: k    . Если изучаемая среда неоднородна, т. е. в области 

исследования располагаются горные породы с различными значени-

ями УЭС, то значение полученного кажущегося сопротивления ρk бу-

дет больше наименьшего из УЭС пород, но меньше наибольшего: 

min maxk   .  

На базе приведённых основ и строятся различные модификации 

исследований методом сопротивлений. Например, если взять серию 

рассмотренных выше установок, постепенно увеличивая размер пи-

тающей линии АВ, можно добиться эффекта зондирования. Чем 

больше параметр 2AB  – тем глубже «погружается ток в землю» и 

тем больше глубинность исследований (рис. 3). Такой подход позво-

ляет проводить изучение разреза по глубине – это вертикальные элек-

трические зондирования (ВЭЗ). 

Если зафиксировать установку и перемещать её по профилю, то 

область исследования будет изменяться в горизонтальном направле-

нии – это электропрофилирование. 

Следующая методика – сплошные электрические зондирования 

(СЭЗ) возникла в конце 80-х гг., когда стало ясно, что при наличии 

приповерхностных неоднородностей (ППН) в разрезе, применение 

методики ВЭЗ и электропрофилирования дают неудовлетворитель-

ные результаты. 
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Рис. 3. Эффект зондирования в методе сопротивлений 

 

Кроме приповерхностных неоднородностей (ППН), обычно не 

представляющих интереса и являющихся помехой, существуют глу-

бинные неоднородности, которые, как правило, являются объектом 

поиска. Однако влияние ППН во много раз сильнее глубинных, так 

как они расположены ближе к точкам возбуждения и измерения поля, 

и поэтому аномалии от ППН необходимо удалить перед интерпрета-

цией. 

Искажающее влияние ППН может быть двух типов – искажение 

неоднородностями, расположенными вблизи измерительных элек-

тродов (Р-эффект) и вблизи питающих электродов (С-эффект). 

Такие помехи можно выявить с помощью СЭЗ, идея которых за-

ключается в следующем: минимизировать число попаданий питаю-

щих и приемных электродов в зону ППН. А поскольку расположение 

неоднородностей неизвестно, то зондирования выполняют, увеличи-

вая разносы с арифметическим шагом, равным расстоянию между 

точками измерения (пикетами) на профиле. Это делается для того, 

чтобы на разных точках зондирования питающие электроды попа-

дали в одни и те же места. При таком способе измерений искажения 

от ППН проявляются на кривых ρk как регулярная помеха, которую, 

в отличие от случайной, значительно легче обнаружить и удалить. 

В России данную методику впервые использовали А. А. Либер-

манн и В. К. Хмелевской. Как уже было сказано, в методике разносы 
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возрастают по закону арифметической прогрессии с постоянным ша-

гом. К тому же он жёстко связан с расстоянием между пикетами на 

профиле: одинаковые или кратные величины. Более того, само назва-

ние «сплошные» говорит о том, что отдельные кривые ρk рассматри-

ваются крайне редко или только на этапе предварительной обра-

ботки. Основной формой представления и анализа результатов для 

таких зондирований являются разрезы ρk, которые дополняются раз-

личными трансформациями, позволяющими увидеть проявление гео-

логических помех и глубинных структур. 

При проведении работ по методике СЭЗ чаще всего использовали 

трех-электродную комбинированную установку AiMN+MNAi (рис. 4, 

сверху). Электрод B относится в «бесконечность» на расстояние 

больше 7R вдоль профиля, или больше 3R в направлении, перпенди-

кулярном направлению профиля (где R – это максимальное расстоя-

ние между питающим электродом Ai и центром MN). На каждой точке 

зондирования электроды MN неподвижны, источники Аi движутся 

одновременно в разных направлениях с линейным шагом. В резуль-

тате получали два изображения, где горизонтально-слоистый разрез 

проявляется одинаково, а глубинные неоднородности – по-разному. 

В ряде случаев при СЭЗ реализуется другой тип установки с од-

ним неподвижным питающим электродом А (рис. 4, снизу). При этом 

эффект зондирования обеспечивается перемещением приемной ли-

нии MiNi. Так как положение токового электрода не меняется, то в 

этом случае можно использовать сразу несколько приемных линий 

MN и, соответственно, измерителей, что позволяет резко повысить 

производительность съемки. 

При СЭЗ со временем стали использовать две электроразведочные 

косы (многожильный коммутирующий кабель), которые подсоединя-

ются к прибору (рис. 4). Косы укладываются вдоль профиля наблю-

дений. Измерения начинаются с источников Аi (или с приёмников 

MiNi), расположенных в начале профиля – 1, 2 и т. д. После отработки 

первого электрода А1 (или приёмника M1N1) он передается в конец 

второй косы. Как только коса 1 отработана, она сдвигается дальше по 

профилю, в то время как начинаются замеры с косой 2. После изме-

рения на второй косе, первая коса уже на новом месте, можно прово-

дить измерения и перетаскивать косу 2. При этом переставляется 

всего один электрод, а процесс укладки кос идет практически непре-
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рывно. Такая технология дает высокую производительность и отлич-

ное качество полевых данных. Аналогичную схему можно вырабо-

тать для второго случай [28]. 

 

Рис. 4. Методика измерений установками СЭЗ с неподвижной приём-

ной линией и с неподвижным источником 

 

Один шаг (сдвиг) описанной выше методики СЭЗ изображен на 

рис. 4. Сверху изображён случай с неподвижным приёмником, 

снизу – с фиксированным источником. Помимо положений электро-
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дов на рис. 4 изображены маркеры (треугольники), каждый из кото-

рых соответствует одной четвёрке электродов ABMN. Другими сло-

вами – это условные точки измерения каждой из множества получа-

емых установок. На рис. 4 представлено начальное положение элек-

тродов (первая расстановка) и соответствующие маркеры. Ниже – 

вторая расстановка, на которой демонстрируются старые (серые) по-

ложения электродов и точки измерения (серые маркеры), а также но-

вая расстановка с соответствующими красными маркерами. Видно, 

что если сдвигать электроды дальше, то мы получим сплошные элек-

трические зондирования (полностью заполненную маркерами об-

ласть) до определённой глубины. 

Со временем, совершенствование электроразведочных кос и раз-

витие аппаратурной базы позволили реализовать следующую идею: 

использовать в качестве питающих и измерительных электродов 

одни и те же фиксированные на профиле заземления. Это привело к 

более современной модификации метода сопротивлений – электро-

томографии. Она позволяет получать сплошную картину зондиро-

вания одной расстановкой электродов (как в СЭЗ с многократным 

сдвигом установки) и нацелена на изучение сложно построенных 

сред. 

Электротомография (ЭТ) – это целый комплекс, включающий в 

себя как методику полевых наблюдений, так и технологию обработки 

и интерпретации полевых данных. Как уже говорилось, её особенно-

стью является многократное использование в качестве питающих и 

измерительных одни и те же фиксированные на профиле положения 

электродов. Количество их может достигать нескольких десятков и 

сотен штук. Такой подход позволяет с одной стороны, работать с со-

временной высокопроизводительной аппаратурой, а с другой сто-

роны, проводить интерпретацию данных электротомографии в рам-

ках двумерных и трехмерных моделей. 

Можно отметить некоторые методические особенности ЭТ. 

В электротомографии используется линейный шаг по разносам, поз-

воляющий многократно использовать одни и те же места заземлений, 

что в свою очередь обеспечивает высокую плотность наблюдений. 

С другой стороны, применение электроразведочных кос приводит к 

небольшому диапазону разносов, который определяется числом ис-

пользуемых электродов и расстоянием между ними. Это, есте-

ственно, ограничивает и интервал изучаемых глубин. Несомненным 
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плюсом ЭТ является возможность комбинирования различных элек-

троразведочных установок. Тем самым удается увеличить объем не-

зависимых измерений, используя различные виды возбуждения и 

приема электрического поля, и компенсировать недостатки отдель-

ных установок. 

Разрешающая способность (т. е. количество деталей геоэлектри-

ческого разреза, устойчиво проявляющихся в электрическом поле) 

тесно связано с плотностью измерений на одном профиле, т. е. рас-

стоянием между электродами. В свою очередь, увеличение разреша-

ющей способности обычно приводит к уменьшению общей глубин-

ности метода.  

При проведении полевых работ применяется специальная много-

электродная аппаратура с программируемой автоматической комму-

тацией электродов (обычно от 48 штук). В настоящее время наиболее 

известными из них являются Скала-48, Скала-64, Syscal Pro и др [8]. 

Такая аппаратура поочерёдно коммутирует и опрашивает различные 

комбинации электродов, по заранее запланированному оператором 

сценарию (последовательности, протоколу), которые создаются в 

специальных программах (например, SiberTools, x2ipi, ZondProtocol, 

RiPPP и др.). Таким образом, в результате измерений получают инфор-

мацию о распределении кажущегося удельного электрического сопро-

тивления по разрезу. При работах на длинных профилях после прове-

дения измерений с одной расстановкой электродов физически переме-

щается только часть электродов. Чаще всего относящихся к одной из 

кос. Такой подход существенно сокращает время измерений. 

На рис. 5 иллюстрируется технология электротомографии: приве-

дена типичная схема измерения двумя косам с последующим перено-

сом первой косы и прибора для непрерывного продолжения профиля. 

Как и при описании СЭЗ, помимо положений электродов на рис. 5 

изображены маркеры (треугольники), каждый из которых соответ-

ствует одной четвёрке электродов ABMN. Одна из таких комбинаций 

представлена на рис. 5, а соответствующий маркер (точка измерения) 

выделен увеличенным размером. Маркеры чёрного цвета относятся к 

регулярной (первой) расстановке электродов, расположенных на 

двух первых косах и использующих полную систему измерений 

(рис. 5, коса 1 и коса 2). После проведения всех запланированных из-

мерений на этой раскладке, прибор и коса 1 (или дополнительная 

коса) вместе с электродами переносятся в следующее положение. 
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В результате получаем расстановку, состоящую из кос 2 и 3 (рис. 5). 

Маркеры, соответствующие новой расстановки, и коса 3, продолжа-

ющая профиль выделены серым цветом. Теперь оператор должен 

учесть, при планировании последовательности измерений, что часть 

измерений (под косой 2) уже есть. Такую технологию называют наго-

няющим измерением. Таким образом, профиль можно продолжить 

до необходимой длины. 

 

Рис. 5. Принцип измерений при электротомографии: типичная схема 

измерения двумя косам с последующим переносом первой косы и при-

бора для непрерывного продолжения профиля 

 

Современное аппаратурное и программное обеспечение электро-

томографии, поддерживает большинство установок: Шлюмберже, 

Веннера, трёх-электродные и др. Каждую установку с помощью чис-

ленного моделирования (решения прямых и обратных задач) можно 

исследовать на предмет чувствительности к различным моделям. 

Например, известно, что установка Веннера характеризуется высо-

ким уровнем сигнала, хорошей чувствительностью к горизонталь-

ным границам, плохой чувствительностью к вертикальным границам 

и локальным неоднородностям. Дипольно-осевая установка характе-

ризуется низким уровнем сигнала, хорошей чувствительностью к 

вертикальным границам, средней чувствительностью к горизонталь-

ным границам. Установка Шлюмберже обладает одинаковой чув-

ствительностью к горизонтальным и вертикальным границам, явля-

ясь компромиссом между установками Веннера и дипольно-осевой. 

Трех-электродная установка, как и дипольно-осевая, имеет большую 

чувствительность к горизонтальным неоднородностям (вертикаль-

ным границам). Наилучшие же результаты при инверсии данных ЭТ 

могут быть получены при комбинировании различных типов устано-

вок с последующей совместной инверсией [8, 9]. 
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Параллельно с появлением многоэлектродных электроразведоч-

ных станций, реализующих плотные 2D томографические измерения, 

появлялись алгоритмы и их программные реализации, специализиро-

ванные на моделировании и инверсии данных электротомографии в 

сложных (двух- и трехмерных) средах. Для решения прямой задачи 

ЭТ в двумерной постановке можно привести программы Res2DMod, 

ZondRes2d; для инверсии Res2DInv, ZondRes2d, ERT Lab. Трёхмер-

ную прямую задачу ЭТ можно решить в программе Res3DMod, об-

ратную задачу решают Res3DInv, ZondRes3D, ERTLab и др. 

В данном пособии познакомимся с программами Res2DMod, 

ZondRes2d и Res3DMod для решения прямой задачи ЭТ. При реше-

нии обратных задач будем использовать Res2DInv, ZondRes2d и 

Res3DInv. Эти программы позволяют решать прямые и обратные за-

дачи метода сопротивлений и вызванной поляризации. При модели-

ровании будем использовать по большей части параметр сопротивле-

ния. Принципы моделирования полей с учётом вызванной поляриза-

ции горных пород идентичны. 

Моделирование данных ЭТ и последующая их инверсия позволит 

лучше понять принципы работы многоэлектродных методик, изучить 

чувствительность и разрешающую способность различных устано-

вок к заданной модели среды. В качестве примеров будут использо-

ваны как элементарные объекты, так и примеры геоэлектрических 

моделей рудных месторождений. Что в свою очередь позволит пе-

рейти к обработке полевых примеров. 
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4. ЭЛЕКТРОТОМОГРАФИЯ В ДВУМЕРНЫХ СРЕДАХ 

 

Прямая задача геофизики сводится к расчёту аномального физи-

ческого поля по известным параметрам возмущающего объекта. Па-

раметрами объекта являются: мощность, глубина залегания верхней 

и нижней кромок, угол падения, сопротивление, плотность и т. п. 

Прямую задачу геофизики обычно решают на стадии проектирования 

геофизических работ. Получаемая при этом ожидаемая геофизиче-

ская аномалия помогает выбирать соответствующую измерительную 

аппаратуру и методику наблюдений. 

Под прямой задачей электротомографии понимается расчет 

электромагнитного поля, которое в свою очередь можно пересчитать 

в кажущиеся сопротивления, при известном распределении электро-

магнитных свойств и для заданных источников поля. Под распреде-

лением электромагнитных свойств понимается геоэлектрическая мо-

дель среды – совокупность электрических и геометрических характе-

ристик материала, слагающего данную среду. Сложность рассматри-

ваемой модели определяется её параметризацией и размерностью. 

Плотность наблюдения, используемая в методе ЭТ, позволяет прово-

дить интерпретацию данных электротомографии в рамках двумер-

ных и трехмерных моделей. 

Обратная задача геофизики – определение по наблюдаемым ано-

малиям (полученным в результате полевых измерений) расположе-

ния вызывающих аномалии объектов, их геометрических и физиче-

ских параметров. В сложных случаях получают приближённое реше-

ние обратной задачи либо несколько решений, часть из которых от-

брасывается при введении дополнительных ограничений. Соответ-

ственно, обратная задача электротомографии – это определение 

модели среды по измеренным данным, полученным в результате при-

менения метода ЭТ. 

Существует множество программ для решения прямых и обрат-

ных задач ЭТ в рамках двумерных и трёхмерных моделей среды, не-

которые из которых будут разобраны в данном пособии. Одной из 

первых появилась программа Res2DMod, которая до сих пор является 

доступной и актуальной. 
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4.1. Решение прямой задачи ЭТ в программе Res2DMod 

Res2DMod – программа для моделирования данных электротомо-

графии, которая распространяется свободно с некоторыми функцио-

нальными ограничениями. Бесплатную версию можно свободно ска-

чать на сайте разработчиков Малазийской компании Geotomo 

Software [10]. Res2DMod позволяет решать двумерную прямую за-

дачу в случае метода электротомографии с определённым типом 

установки, т. е. рассчитывать и строить псевдоразрез кажущегося 

УЭС для заданной пользователем двумерной модели среды [11]. 

В Res2DMod можно моделировать разрезы кажущегося сопротив-

ления для следующих установок: трёх-электродная (pole-dipole), по-

тенциал-установка (pole-pole), Шлюмберже, Веннера (α, β, γ), ди-

польная осевая и экваториальная. На рис. 6 эти установки приведены 

с параметрами: a – размер приёмной линии (за исключением потен-

циала установки) и n – количество разносов AB для каждого приём-

ника.  

 

Рис. 6. Типы установок, используемые в программе Res2DMod 

 

Параметры a и n используются при решении прямой задачи, при-

чём в установке Веннера и двухэлектродной потенциал-установке 

меняется только размер a. В остальных случаях для одного приём-

ника может существовать несколько источников. Как уже говори-

лось, каждая из установок имеет свою особенную чувствительность, 

глубинность и разрешающую способность. 
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Прежде чем приступить к изучению возможностей программы 

Res2DMod, стоит сказать, что прямая задача решается конечнораз-

ностным или конечно элементным методом по выбору пользователя. 

Но в любом случае расчётная область (где будет рассчитываться ρk) 

разбивается на блоки, используя прямоугольную сетку с L1 столб-

цами и M строками. Соответственно, сетка состоит из L узлов на 

каждой горизонтальной линии разбиения и M – на каждой вертикаль-

ной (всего L M  узлов; см. рис 7). В них рассчитываются значения 

потенциала электрического поля и затем пересчитываются в кажуще-

еся УЭС. 

Каждому блоку сетки можно задавать значение сопротивления. 

Таким образом, используя достаточно мелкое разбиение, можно со-

ставлять сложные геологические структуры или объекты. Частота 

вертикальных линий сетки зависит от межэлектродного расстояния. 

Каждое межэлектродное расстояние можно разбить на 4 или 2 эле-

мента (см. рис. 7, а,б, соответственно). 

Стоит сказать, что от первого и последнего электрода до краёв об-

ласти помещено по 12 узлов (вертикальных линий) сетки для кор-

ректного учёта краевых эффектов. Частота горизонтальных линий 

обычно задаётся вручную, поэтому стоит быть внимательным и учи-

тывать, что от густоты разбиения зависит точность расчёта прямой 

задачи и требуемое для решения время. Как минимум, для коррект-

ного расчёта нужно, чтобы первые три разбиения по глубине не были 

больше трёх блоков вдоль профиля. Расстояние между остальными 

горизонтальными линиями может увеличиваться с глубиной не силь-

нее, чем по логарифмическому закону. Это связано с тем, что данные 

электроразведки отвечают логнормальному закону распределения: с 

глубиной становится хуже разрешающая способность, т. е. количе-

ство деталей геоэлектрического разреза, устойчиво проявляющихся 

в электрическом поле. 

Заготовки с параметрами сеток и моделей двумерной среды со 

значениями УЭС чаще всего делаются вручную в любом текстовом 

редакторе, а потом уже корректируются с помощью инструментов 

программы Res2DMod. Файлы с такими заготовками имеют соб-

ственный формат и расширение *.mod. Структура этого формата 

разобрана и описана в табл. 1 на примере модели однородного полу-

пространства HalfSpace.mod. 
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Рис. 7. Фрагменты расчётной сетки в программе Res2DMod с тремя (а) 

и одним (б) узлом между электродами 

 

Таблица 1 

Описание структуры *.mod для программы Res2DMod 

Структура 

файла 
№ строки и пояснения 

HalfSpace Строка 1 – название модели 

36 Строка 2 –количество электродов 

10 

Строка 3 – количество уровней для УЭС (максимум 

32) – зависит от типа установки, количества элек-

тродов и может корректироваться автоматически 

0 
Строка 4 – указатель на расчёт сигнала под водой. 

В нашем случае всегда 0 

1.0 Строка 5 – межэлектродное расстояние 

2 

Строка 6 – указатель на тип разбиения сетки по глу-

бине: 0 и 1 – автоматическое разбиение, 2 – ручное 

разбиений с указанием глубин 

0 

Строка 7 – смещение первого блока заданной сетки 

относительно первого электрода. В нашем случае 

всегда 0 

140 

Строка 8 – количество блоков вдоль профиля. Чтобы 

избежать проблем эту величину следуют вычислять 

по формуле (количество электродов – 1)‧(количество 

секторов между электродами) 
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Продолжение табл. 1 

Структура 

файла 
№ строки и пояснения 

3 
Строка 9 – количество значений УЭС, используе-

мых в модели (максимум 16) 

4 

Строка 10 – количество секторов между соседними 

электродами (2 или 4). Если 4, то максимум 75 элек-

тродов 

10.00, 

100.00, 

500.00 

Строка 11 – значения УЭС, используемые в модели 

14 
Строка 12 – количество рядов блоков сетки в мо-

дели (максимум 29)  

0.15, 0.3, 

0.5, 0.75, 

1.0, 1.6, 2.2, 

2.8, 3.6, 4.4, 

5.2, 8, 15, 25 

Строка 13 – глубины горизонтальных линий сетки. 

Задаются при ручном разбиении (значение 2 в 

строке 6) 

0000… 

… 

0000… 

Cтроки с 14 по 27 (14 строк равно количеству рядов 

блоков сетки в модели, заданное в строке 12). Число 

«0» соответствует первому значению УЭС (задано 

в строке 11), «1» – второму, и т. д. Для УЭС от 11 

до 16 используются буквы от «a» до «f». Для одно-

родного полупространства нужно ввести 14 строк, 

по 140 нулей в каждой 

1 

Строка 28 – тип установки: 1 – Веннера (α), 2 – pole-

pole, 3 – dipole-dipole, 4 – Веннера (β), 5 – Веннера 

(γ), 6 – ДО, 7 – Шлюмберже, 8 – ДЭ. Для 8 уста-

новки, через запятую нужно ещё ввести разнос 

между питающими и приёмными электродами (зна-

чение «a», см. рис. 6) 

0 

В строках 29 и 30 вводится «0», что указывает на 

необходимость записи в файл УЭС и потенциала 

электрического поля при сохранении результата 

расчёта 

0 
В строки 31–33 вводится ноль. Зарезервированные 

строки 
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Некоторые строки можно записывать в одну, используя запятую в 

виде разделителя. Например, можно объединить 2 и 3 строку, в ре-

зультате запишется 36, 10; или строки 7–9 можно записать в одну как 

0, 140, 3. 

Теперь мы можем создать файл с описанной сеткой и моделью од-

нородного полупространства с сопротивлением 10 Ом·м. Для этого 

нужно создать файл HalfSpace.mod и скопировать или внести данные 

из первого столбца табл. 1 с описанием структуры, представленной 

выше. При создании нужно не забыть, что в строках с 14 по 27 нужно 

ввести 140 нулей в каждой из них (можно больше, нельзя меньше). 

В 28 строке оставим 1, что соответствует установке Веннера (α). За-

кончить файл необходимо пятью строками с одним нулём в каждой. 

После редактирования нужно сохранить файл HalfSpace.mod. Со-

зданный файл с расчётной сеткой и моделью однородного полупро-

странства можно использовать в программе Res2DMod. 

Для начала работы в Res2DMod, необходимо скачать её с сайта 

разработчика (https://www.geotomosoft.com/r2dmodwin.zip) и устано-

вить. Запустив программу можно увидеть привычное для пользова-

телей ОС Windows главное меню (рис. 8). Чтобы загрузить создан-

ную ранее расчётную сетку и модель нужно выбрать п.  File→Read 

file with forward model. После этого нужно будет кликнуть файл 

HalfSpace.mod. 

 

Рис. 8. Меню программы Res2DMod 

 

В случае удачного прочтения сетки и модели, в окне программы 

отобразится некоторая полученная из файла информация (название 

модели, количество электродов и т. д.). На последней строке будет 

сообщение о завершении чтения файла (Reading of data file is 

complete). Также появится окно-сообщение с указанием пути к про-

читанному файлу: Completed reading of data file C:\...\HalfSpace.mod. 

Если в параметрах сетки или модели будут ошибки, то строчки 

Reading of data file is complete не будет и появится окно-сообщение 

об ошибке, где чаще всего указывается возникшая проблема. 

После успешной загрузки файла HalfSpace.mod с параметрами 

сетки и модели можно приступать к просмотру, редактированию мо-

дели и расчёту прямой задачи ЭТ. Для просмотра модели необходимо 
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выбрать пункт меню Edit→Display model. В результате отобразится 

разрез без сетки, который невозможно редактировать. В нашем слу-

чае – это одноцветная (цвет соответствует заданному сопротивлению 

10 Ом·м) прямоугольная область. Чтобы изменить модель нужно вы-

брать пункт Edit→Edit model, после чего появится модель с расчёт-

ной сеткой (рис. 9). Сверху по горизонтали отложена ось X, на кото-

рой указано расстояние по профилю в метрах. Деления соответ-

ствуют межэлектродному расстоянию (в нашем случае 1 м). Видно, 

что длина профиля составляет 35 м, что согласуется с заданными па-

раметрами установки (36 электродов). Можно заметить, что в гори-

зонтальном направлении между соседними электродами по 4 сектора 

сетки, как и было прописано в файле. В вертикальном направлении 

слева отложена ось Z, где указываются значения глубин. Над моде-

лью слева указано три значения УЭС: 10, 100 и 500 Ом·м. Эта инфор-

мация также прочитана верно из 9 и 11-й строк файла HalfSpace.mod. 

Находясь в режиме Edit Model можно приступать к редактирова-

нию модели изменяя УЭС блоков сетки интерактивно с помощью 

мыши и клавиатуры. Для этого нужно навести курсор на элемент 

сетки, который необходимо поменять и нажать правую кнопку 

мыши. Цвет блока изменится на белый. Это означает, что в этом 

блоке не задано никакое из представленных значений сопротивления. 

После этого необходимо выбрать одно из значений УЭС: кликнуть 

левой кнопкой мыши по одному из цветных прямоугольников, кото-

рые находятся над моделью слева, рядом со значениями сопротивле-

ний (в нашем случае 10, 100 и 500 Ом·м). В результате белый выделен-

ный блок приобретёт цвет, отвечающий выбранному сопротивлению. 

Таким образом можно изменять УЭС некоторой области в модели: вы-

делить группу блоков и присвоить им нужное сопротивление. 

Чтобы упростить работу с большими расчётными сетками и слож-

ными моделями в программе реализована возможность использовать 

горячие клавиши для выделения сразу группы блоков: 

Левая кнопка мыши – выделение 4-х блоков вправо от курсора 

мыши; 

D – выделение столбца блоков вниз от курсора до границы мо-

дели; 

] – выделение строки блоков вправо от курсора до границы мо-

дели; 

[– выделение строки блоков влево от курсора до границы модели; 
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} – выделение всех блоков вправо и вниз от курсора до границ мо-

дели; 

{ – выделение всех блоков влево и вниз от курсора до границ мо-

дели. 

 

Рис. 9. Режим редактирования модели однородного полупространства 

в программе Res2DMod 

 

Помимо изменения сопротивления выделенной области модели, в 

программе Res2DMod можно добавлять значения сопротивлений че-

рез пункт меню Edit→Add new model resistivity. В появившееся диа-

логовое окно нужно ввести новое значение УЭС (под надпись Please 

type in the new model resistivity value) и нажать «OK» или клавишу 

[Enter]. Если вернуться в режим редактирования, то можно будет уви-

деть дополнительный цветной прямоугольник (рядом с имеющимися 

ранее) и соответствующее значение УЭС над ним. Теперь это значение 

можно использовать при дальнейшем редактировании модели. Макси-

мальное количество значений УЭС, используемых в модели – 16. 

Используя приведённые инструменты редактирования и файл 

HalfSpace.mod, можно создать модель полупространства (10 Ом·м) с 

прямоугольным объектом, лежащем от 16 до 19 м по горизонтали и 

от 1 до 2,2 м по вертикали с сопротивлением 500 Ом·м (рис. 10, 

снизу). Чтобы не утратить первоначальную модель полупространства 

перед редактированием её нужно сохранить в новый файл, например, 

Block500.mod используя пункт меню File→Save results in 

RES2DMOD format. После того как модель с объектом (блоком со-

противлением 500 Ом·м) создана, её можно открыть в текстовом ре-

дакторе, где можно увидеть, что помимо нулей в строках с 14 по 27, 
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появились числа «2», которые соответствуют заданному блоку с УЭС 

500 Ом·м (см. табл. 1, строки с 14 по 27). 

 

Рис. 10. Режим редактирования модели однородного полупростран-

ства с непроводящим блоком и рассчитанные кажущиеся значения УЭС 

в программе Res2DMod 

 

Не стоит забывать, что при расчёте прямой задачи помимо расчёт-

ной сетки и модели среды участвуют параметры установки. Их 

можно редактировать в оболочке программы Res2DMod (рис. 11). 

Для редактирования параметров установки необходимо восполь-

зоваться пунктом меню Edit→Change array type. В появившемся окне 

(рис. 11) можно выбрать нужный тип установки, поставив точку 

напротив соответствующего пункта (в нашем случае – это Wenner 

Alpha). Также есть возможность задать количество приёмных и пита-

ющих линий (Number of ‘a’ spacings и Number of ‘n’ values, соответ-

ственно, см. рис. 6). Остальные параметры оставим для самостоятель-

ного изучения. 

После редактирования модели и выбора установки (в нашем слу-

чае, если ничего не менять, то это установка Веннера (α) с 36 элек-

тродами, межэлектродное расстояние 1 м) можно приступать к рас-

чёту прямой задачи ЭТ: пункт меню Model Computation→Calculate 

potential values. После расчёта появится информационное окно, в ко-

тором сообщается, что расчёт завершён (Calculations is completed) и 
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выводится затраченное время. Результатом будет псевдоразрез кажу-

щегося УЭС. Посмотреть его можно используя пункт меню 

Edit→Display model. Выбрав этот пункт появится диалоговое окно, 

где нужно выбрать способ (масштаб) отображения изолиний вычис-

ленного кажущегося  сопротивления  (линейный,  логарифмический 

 

Рис. 11. Окно выбора типа установки и её параметров 
 

и т. д.). По умолчанию точка стоит напротив логарифмических ин-

тервалов между изолиниями (Logarithmic contour intervals). В боль-

шинстве случаев на геоэлектрических разрезах используют именно 

логарифмическую шкалу, поэтому оставим этот вариант нажав «OK» 

или клавишу [Enter]. Отобразится псевдоразрез кажущегося УЭС 

сверху в виде изоом, под ним автоматически приводится модель 

среды (рис. 10) без сетки. Если прямая задача рассчитана один раз 

для текущей (открытой) модели, то псевдоразрез будет изображаться 

и в режиме редактирования, только теперь отобразится расчётная 

сетка и появится возможность редактирования модели (рис. 10). 
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На рис. 10 видно, что над псевдоразрезом указывается название 

модели и в скобочках тип установки, указанные в файле 

Block500.mod. В обоих случаях (модель и разрез) по горизонтали от-

ложена ось X, на которой указаны расстояние по профилю в метрах, 

по вертикали (ось Z) – глубина. Под псевдоразрезом, который пред-

ставлен в виде карты изоом, слева расположена цветовая шкала зна-

чений кажущегося сопротивления. Изоомы – это линии равных зна-

чений УЭС, которые проводятся методами интерполяции по дискрет-

ным (отдельно стоящим, рассчитанным в прямой задаче) значениям 

сопротивлений в точках разреза. Области между парами изолиний за-

крашиваются цветом, который соответствует одному из двух сопро-

тивлений. Цветовую палитру шкалы можно выбирать произвольно, 

но в электроразведке для выделения зон пониженных сопротивлений 

принято применять различные тона синего, голубого, зеленого (хо-

лодные цвета), а зоны повышенных сопротивлений раскрашиваются 

теплыми цветами: различные оттенки красного, коричневого, оран-

жевого. Есть исключения. Например, при изучении мерзлых пород 

чаще всего используют обратную палитру: синий – изолятор, крас-

ный – проводник. 

Видно, что в районе непроводящего объекта (500 Ом·м) сосредо-

точены изолинии с повышенным УЭС (тёплые цвета), что соответ-

ствует заданной модели среды. Затем они плавно переходят в холод-

ные цвета, что отвечает проводящей вмещающей среде. Полученный 

расчёт можно сохранить в тот же файл Block500.mod. Сделаем это 

используя пункт меню File→Save results in RES2DMOD format. Те-

перь в нём будут содержаться рассчитанные (результат решения пря-

мой задачи) и отображаемые на псевдоразрезе значения потенциала 

электрического поля и кажущееся УЭС, которые при следующем от-

крытии будут подгружаться автоматически без пересчёта (это было 

важно, когда компьютеры были не столь мощные). 

Мы научились с помощью программы Res2DMod создавать рас-

чётные сетки, геоэлектрические модели и решать прямую задачу для 

современной модификации метода сопротивлений – электротомогра-

фии. Теперь можно оперировать полученными данными. 

Одна из самых распространённых задач при проектировании гео-

физических работ – это изучение чувствительности и разрешающей 

способности метода (установки) к объектам изучаемой среды (слой, 

двумерный объект, трёхмерный объект). 
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Другими словами, нам нужно найти минимальное расстояние 

между двумя элементами, которые должны быть опознаны (предел 

разрешающей способности) и минимальные размеры элемента или 

различия в свойстве, которые создают измеряемое изменение в сиг-

нале (предел способности обнаружения – предел чувствительно-

сти). 

Для решения этих задач обычно используют относительное откло-

нение сигналов (rel.dev). Оно показывает отличие одного значения от 

другого для каждого разноса в процентах и вычисляется по формуле: 

нач изм

нач
rel.dev 100 %,k k

k

 
 


 

где 
нач

k  – значения кажущегося сопротивления, рассчитанные для 

начальной модели; 
изм

k  – для изменённой модели. 

Анализ рассчитанных данных можно делать с помощью программ 

MS Excel, а для визуализации (построение двумерных карт) получен-

ных данных можно использовать Surfer. Разберём один из примеров. 

Используя программу Res2DMod решим задачу на чувствитель-

ность метода электротомографии. Определим сопротивление объекта 

с заданными размерами, при котором он будет выделяться методом 

электротомографии. Объект находится в однородном полупростран-

стве с сопротивлением 10 Ом·м, а точность прибора составляет 5 %. 

Будем использовать объект и установку как в разобранной выше мо-

дели Block500.mod (прямоугольник от 16 до 19 м по горизонтали и от 

1 до 2,2 м; установка Веннера (α) с 36 электродами, между электро-

дами 1 м; рис. 10, 11). 

Сначала нужно решить прямую задачу ЭТ для модели неизменён-

ной среды. В данном случае – это модель полупространства с сопро-

тивлением 10 Ом·м. В результате будет получен набор значений УЭС 
нач

k , по которому строится псевдоразрез в виде карты изоом. Затем 

тоже самое нужно сделать для изменённой среды с объектом – рас-

считать прямую задачу в программе Res2DMod – получить значения 
изм

k . Сравнивая два полученных набора, можно вычислить их откло-

нения (rel.dev) относительно друг друга и провести дальнейший ана-

лиз. При анализе рассчитанных (модельных, теоретических) данных 

ЭТ можно построить двумерное распределение для визуальной 
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оценки, найти области максимальных ошибок и сравнить с заданным 

уровнем. 

Мы уже разобрали, как изготавливается сетка и модель и у нас 

есть готовый файл с параметрами установки и среды однородного по-

лупространства с сопротивлением 10 Ом·м – HalfSpace.mod. Рассчи-

таем для неё прямую задачу ЭТ (Model Computation→Calculate 

potential values) и экспортируем рассчитанные данные с помощью 

пункта меню File→Save results in RES2DINV format. В появившемся 

окне необходимо ввести имя файла с расширением *.dat, формат ко-

торого предназначен для программы инверсии данных ЭТ 

RES2DINV, к которой мы вернёмся позже. Для удобства назовём его 

идентично модели – HalfSpace.dat. После ввода имени нужно нажать 

кнопку «Cохранить» или клавишу [Enter], появится диалоговое окно 

Choose noise level, где можно выбрать уровень шума. Нам это пока не 

требуется, и мы нажимаем «ОК» или клавишу [Enter]. Полученный 

файл можно открыть в MS Excel, указав, что разделителями являются 

пробелы (файл Block.xlsx). В первой строке данных, как и в формате 

файлов *.mod, указано название модели HalfSpace, а в четвёртой, ука-

зано количество рассчитанных значений УЭС – 198 (точек измере-

ния, маркеров). Именно такое количество данных нужно анализиро-

вать. Они начинаются с седьмой строки и располагаются в трёх 

столбцах: первый – расстояние по профилю (координата X), второй – 

условная глубина (координата Z) и третий – ρk. Для удобства нужно 

скопировать эти три столбца (без первых шести строк) на новый лист 

и обозначить их X, Z и 10 (что соответствует сопротивлению блока 

10 Ом·м и равно сопротивлению вмещающей среды). Мы подгото-

вили набор значений УЭС 
нач

k  для сравнения с 
изм

k , которые нужно 

рассчитать в изменённой среде с объектом. Это мы сделаем следую-

щим шагом. 

Для получения 
изм

k решим прямую задачу ЭТ в случае изменённой 

среды (с объектом). Прежде всего необходимо добавить в модель по-

лупространства с сопротивлением 10 Ом·м (HalfSpace.mod) значение 

сопротивления близкое к вмещающей среде, например, 50 Ом·м 

(Edit→Add new model resistivity). Затем нужно создать, заданный в 

условиях задачи, объект: в режиме редактирования мышкой выде-

лить область и присвоить ей значение УЭС 50 Ом·м. Сохраним мо-

дель в файл Block50.mod. Теперь можно рассчитать прямую задачу 
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ЭТ (Model Computation→Calculate potential values). По аналогии с 

прошлым расчётом, экспортируем данные в Block50.dat в формат 

RES2DINV и откроем их в MS Excel. В связи с тем, что установка 

остаётся неизменной и точки измерения совпадают, то нам понадо-

бится не три столбца с координатами и соответствующими УЭС, а 

только последний. Нужно скопировать этот столбец на подготовлен-

ный ранее лист с данными ЭТ для неизменённой среды. Для самопро-

верки лучше 
изм

k  разместить рядом с 
нач

k  и обозначить 50 (что соот-

ветствует сопротивлению блока 50 Ом·м). Количество строк (значе-

ний УЭС) должно совпасть. В MS Excel можно найти столбец отно-

сительных отклонений rel.dev. двух имеющихся наборов ρk, для каж-

дой точки измерения. Таким образом, мы получили возмущения, ко-

торые возникают в данных ЭТ, при внесении в однородное проводя-

щее полупространство (10 Ом·м) объекта с сопротивлением 50 Ом·м 

заданных размеров. Назовём этот столбец rel.dev.50 – относительное 

отклонение при сопротивлении блока 50 Ом·м. 

Один из способов оценки рассчитанных отклонений rel.dev. – это 

построение значений ошибки в зависимости от одной из координат: 

X – распределение по профилю (рис. 12, чёрные квадраты) или Z – по 

глубине. Мы рассмотрим первый случай. Такие построения можно 

сделать в MS Excel с помощью соответствующего типа диаграммы 

(точечная), выбрав в качестве данных колонки X и найденные откло-

нения. На построенной диаграмме (рис. 12) по оси абсцисс отложено 

расстояние по профилю, а по оси ординат – величина отклонения в 

процентах. Видно, что максимальные отклонения возникают в цен-

тральной части профиля, над объектом и достигают 20 %. Поэтому 

можно сделать вывод, что объект таких размеров и сопротивления 

50 Ом·м методом ЭТ может быть выявлен, потому что возмущения, 

которые возникают в данных ЭТ, при внесении в однородное прово-

дящее полупространство (10 Ом·м) объекта с сопротивлением 

50 Ом·м значительно превышают 5 % – точность прибора. Нам же 

нужно определить предел чувствительности метода ЭТ к объекту та-

ких размеров. Для этого нужно уменьшать сопротивления до тех пор, 

пока отклонения не упадут до заданной по условию точность при-

бора – 5%. 

Используя программу Res2DMod рассчитаем ещё две прямые за-

дачи ЭТ в программе для объектов с сопротивлением 20 и 15 Ом·м, 

предварительно создав соответствующие модели (Block20.mod и 
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Block15.mod). Полученные значения ρk экспортируем в *.dat файлы 

по уже привычной схеме и скопируем их на лист MS Excel, который 

мы создали ранее, в соседние с имеющимися столбцами. Новые ко-

лонки обозначим 20 и 15, соответственно. После этого, по той же 

схеме, что и ранее, можно рассчитать ещё два столбца отклонений 

для каждого из приведённых случаев, относительно данных, вычис-

ленных над неизменённой средой – 
нач

k . Полученные столбцы назо-

вём rel.dev.20 и rel.dev.15. Все три ошибки изобразим в одной системе 

координат (рис. 12). Это можно сделать добавив данные на уже име-

ющуюся диаграмму, которую мы построили для случая, когда сопро-

тивление объекта равно 50 Ом·м. При построении будем использо-

вать разные цвета и разные фигуры: 15 Ом·м – серые ромбы, 

20 Ом·м – оранжевые кружки, 50 Ом·м – синие квадраты. Видно, что 

с уменьшением контраста (разницы) между сопротивлением объекта 

и вмещающей среды, относительные отклонения падают. В случае, 

когда блок имеет УЭС 15 Ом·м (рис. 12, ромбы), максимальные зна-

чения ошибки находятся вблизи 5 %. Поэтому можно утверждать, что 

мы нашли предел чувствительности метода ЭТ для данного случая. 

Другими словами, при сопротивлении объекта меньше 15 Ом·м и 

точности прибора 5 % методом ЭТ выявить объект рассмотренных 

размеров будет затруднительно. Результат проделанных действий 

можно сохранить в файл *.xlsx и сравнить с шаблоном Block.xlsx. 

 

Рис. 12. Анализ чувствительности метода ЭТ: распределение rel.dev по 

профилю 
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Построение ошибок в зависимости от одной из координат – не 

единственный подход для анализа чувствительности и решения дру-

гих методических задач электротомографии. Более наглядный спо-

соб – построение двумерного (зависящего от двух координат) распре-

деления относительного отклонения в изолиниях (рис. 13) с помо-

щью специализированных программ для создания таких карт-разре-

зов, например, Surfer фирмы Golden Software. Чтобы построить дву-

мерное распределение нужно создать грид-файл в специальном фор-

мате с расширением *.grd. Для этого в программе Surfer необходимо 

выбрать пункт меню Grids→Grid Data и в диалоговом окне выбрать 

файл данных (в нашем случае Block.xlsx, созданный выше). Затем по-

явится окно с настройками создаваемого грида, где указываются дан-

ные X, Y и Z (Data Columns), имя файла и путь к нему (Output Grid). 

В качестве первых двух будет расстояние по профилю и глубина – 

два столбца файле Block.xlsx, обозначенные нами как X и Z. Дан-

ными Z в гриде (не путать со столбцом глубин!) следует назначить 

рассчитанные относительные отклонения одного из случаев, напри-

мер, столбец rel.dev.15. Выбрав нужные данные и назначив имя, 

нужно нажать «OK» или клавишу [Enter]. Произойдёт генерация и 

сохранение грида в файл с расширение *.grd. Используя его строится 

двумерное распределение относительной ошибки с помощью инстру-

мента в программе Surfer – карта изолиний (Contour Map). Предпола-

гается, что студент уже имеет опыт работы в программе Surfer, по-

этому не будем останавливаться на таких построениях подробно. 

На рис. 13 представлено двумерное распределение относитель-

ного отклонения в изолиниях для случая, когда сопротивление объ-

екта 15 Ом·м (rel.dev.15 в зависимости от координат X и Z). Опреде-

ленному цвету соответствует величина относительного отклонения: 

чем темнее, тем больше ошибка. 

На построенной карте выделены изолинии (черные и белые линии), 

где цифрами обозначены соответствующие значения ошибок (1 и 

3,5 %). Белый контур – изолиния уровня 5 %, а всё что внутри – пре-

вышает этот порог. Помимо этого, поверх карты белым пунктиром 

нанесён контур объекта. Можно видеть, что максимальные значения 

отклонения относятся к центру объекта по горизонтали и распреде-

ляются ниже по глубине. Область, где отклонение превышает 5 % со-

поставима с размерами объекта. При уменьшении сопротивления 

объекта 5 %-зона будет сужаться, при увеличении – расширяться. Это 
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можно проверить, построив двумерное распределение отклонения 

данных, рассчитанных для модели полупространства, относительно 

данных, полученных для модели с объектом 20 или 50 Ом·м. 

 

Рис. 13. Анализ чувствительности метода ЭТ: двумерной распределе-

ние rel.dev по разрезу 

 

Нетрудно догадаться, что если в программе Surfer при создании 

грида в качестве данных Z взять столбец с рассчитанными значени-

ями сопротивлений (мы их обозначили 50, 20 и 15 в файле Block.xlsx), 

то можно построить карту изоом кажущихся значений УЭС. Постро-

енные таким образом двумерные распределения УЭС будут иден-

тичны приводимым в программе Res2DMod псевдоразрезам кажуще-

гося УЭС (см. рис. 10). 

Стоит сказать, что разобранный пример всего лишь идеализиро-

ванный случай, на котором показан принцип работы с прямой зада-

чей ЭТ. Кроме того, такую модель можно легко реализовать в любой 

другой программе для моделирования данных ЭТ и показать её прин-

цип работы. Не является исключением ZondRes2D. 

 

4.2. Решение прямой задачи ЭТ в программе ZondRes2D 

 

ZondRes2D – коммерческая программа, главным разработчиком 

которой является А. Е. Каминский, для двумерной интерпретации 

данных метода сопротивлений и вызванной поляризации, в том числе 

для решения прямых и обратных задач электротомографии. Версию 

с некоторыми ограничениями (максимальное количество точек зон-
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дирования-моделирования 300 и отсутствие ВП) и достаточно по-

дробную инструкцию пользователя можно скачать с сайта разработ-

чика [12]. Скачанный архив распаковывается, программа не требует 

установки. При запуске программы с помощью исполнительного 

файла ZondRes2D.exe возникает главное окно программы (рис. 14), 

где можно увидеть привычное для пользователей ОС Windows меню. 

Для начала моделирования в программе ZondRes2D необходимо 

перейти к диалогу создания системы измерения, содержащему набор 

опций по выбору параметров электротомографической измеритель-

ной установки. Нужно воспользоваться пунктом главного меню про-

граммы: Файл→Создать систему (File→Create synthetic survey для 

английской версии). В результате этих действий появится окно 

«Настройка шаблона протокола» (Electrodes array settings) (рис. 15, 

слева). Здесь можно создавать конфигурации измерений: в выпадаю-

щем списке напротив строки «Установка» (Electrodes array) нужно 

выбрать необходимую установку, а список «Подустановка» (Sub 

array type) позволяет выбрать подтип установки. Например, для уста-

новки Веннера – это подустановки Alpha, Betta и Gamma. 

В ZondRes2D при моделировании данных электротомографии можно 

использовать все установки упомянутые при разборе программы 

Res2DMod: трёхэлектродная, потенциал-установка, Шлюмберже, 

Веннера и дипольная (см. п. 4.1, рис. 6). 

 

Рис. 14. Главное окно программы ZondRes2D 
 

В группе «Геометрия установки» (Array’s geometry) указываются 

основные числовые параметры создаваемой конфигурации измере-

ний: шаг между электродами «Шаг косы, м» (Minimal separation, m), 

количество электродов в одной расстановке «Количество электро-

дов» (Electrodes number), количество электродов на одной косе 

«Сдвиг косы» (Cable shift), количество расстановок на профиле или 

количество переносов косы «Число сдвигов» (Number of shifts). 
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Промоделируем конфигурацию измерительной системы, которая 

уже была разобрана при использовании программы Res2DMod: уста-

новка Веннера, подустановка Alpha, шаг косы 1, количество электро-

дов 36 (рис. 15, слева). Сдвиг косы и число сдвигов в данном случае 

не используется. 

Вкладка «Шаблон» (Worksheet) (рис. 15, справа) позволяет задать 

дополнительные особенности геометрии наблюдений. По сути это 

параметры n и a, задаваемые в программе Res2DMod и описанные в 

п. 4.1 (см. рис. 6). Но здесь управление этими параметрами усовер-

шенствовано. В таблице, в нижней части вкладки, столбец 2AB  со-

держит все возможные значения разносов (формула на вкладке 

«Настройки» под полями с выбором установки, рис. 15, слева), 

столбцы n×a – длину приемной линии, столбцы step [K] – частота из-

мерений по горизонтали для выбранной длины приемной линии (для 

нашего случая по одному столбцу, ввиду определённой симметрии 

установки Веннера). Рисунок Data survey на вкладке «Шаблон» 

(Worksheet) содержит графическое изображение созданной конфигу-

рации измерений: круглые маркеры означают условные точки изме-

рения (рис. 15, справа). 

 

Рис. 15. Диалоговое окно настройка шаблона протокола: слева – 

вкладка «Настройки», справа – вкладка «Шаблон» 
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После выставления всех необходимых параметров конфигурации 

измерительной системы необходимо нажать кнопку «Создать» 

(Create), в результате чего появится диалоговое окно «Конструктор 

модели» (Mesh constructor) для настройки расчётной сетки и старто-

вой модели (рис. 16), которое также может быть вызвано через пункт 

меню Опции→Конструктор сети (Options→ Mesh constructor). Стоит 

сказать, что в программе ZondRes2D при решении прямой и обратной 

задачи, как и в программа Res2DMod, используется математический 

аппарат метода конечных элементов. Поэтому и регулярная сетка 

строится как описано в п. 4.1 (см. рис. 7), но с более удобным интер-

фейсом и расширенными возможностями. Все настраиваемые пара-

метры сетки находятся на вкладке Settings в областях «Вертикальная 

сеть» (Vertical nodes) и «Горизонтальная сеть» (Horizontal nodes), где 

можно задать параметры сетки по вертикали и горизонтали, соответ-

ственно. Программа автоматически выбирает эти параметры, но 

опытный пользователь имеет возможность их регулировать под нуж-

ную задачу. Мы воспользуемся только параметром «Промеж. Узлы» 

(Intermediate nodes), который задаёт количество промежуточных уз-

лов сетки между электродами. Увеличим значение до 3, как это было 

при проведении расчётов в программе Res2DMod, где задавалось 4 

сектора между электродами (см. табл. 1). Вкладка «Предпросмотр» 

(Preview) позволяет посмотреть изображение настроенной сети 

(рис. 16, справа). 

Если вернуться на вкладку Settings, то в нижней части окна можно 

увидеть поле «Сопротивление» (Start resistivity), где вводится удель-

ное сопротивление вмещающих пород. Выставим значение 10 Ом·м, 

как это было при моделировании в программе Res2DMod. Теперь 

можно нажать кнопку OK, после чего появится основное окно про-

граммы (рис. 17). Сверху будет изображён псевдоразрез «Расчётные 

кажущиеся сопротивления» в виде карты изоом – результат решения 

прямой задачи, расчёт которой проведётся автоматически. Снизу по-

явится «Разрез сопротивлений» – блоковая модель однородного по-

лупространства, которая построена по введённым выше параметрам 

и использовалась для расчёта прямой задачи ЭТ. 
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Рис. 16. Диалоговое окно конструктор модели в программе 

ZondRes2D: слева – вкладка «Настройки», справа – вкладка «Предпро-

смотр» 

 

Можно приступать к коррекции модели. Для работы с блоковой 

моделью в программе существует набор инструментов. Мы будем 

пользоваться выносной панелью инструментов и цветовой шкалой. 

Чтобы воспользоваться первой нужно выбрать пункт меню Оп-

ции→Модель→Инструменты редактируемой модели (Options→ 

Model→ModelEditor toolbar). Появится панель, где можно выбирать 

ту или иную функцию:  – включить или выключить режим редак-

тирования,  – изменение масштаба отображения модели,  – до-

бавить новую вертикальную или горизонтальную границу,  – уда-

лить выбранную вертикальную или горизонтальную границу,  – 

изменить толщину ряда или колонки с помощью мыши и др.  

Справа от области редактирования модели находится цветовая 

шкала, связывающая значение цвета со значением сопротивления. 

Для её настройки нужно щёлкнуть по ней правой кнопкой мыши. По-

явится меню, где можно устанавливать максимальное и минимальное 

значение, настраивать палитру и задавать текущее значение, которое 

можно выбрать также кликом левой кнопки мыши по шкале в режиме 

редактирования. Текущее значение отображается под шкалой. 

Теперь мы можем создать модель полупространства (10 Ом·м) с 

прямоугольным объектом, лежащем от 16 до 19 м по горизонтали и 

от 1 до 2,2 м по вертикали (рис. 17, снизу) – модель идентичная той, 
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что была использована при моделировании в программе Res2DMod. 

Для этого нужно выставить необходимые пределы шкалы сопротив-

лений (например, от 1 до 1000 Ом·м) и перейти в режим редактиро-

вания. Работа с ячейками сходна с редактированием растрового изоб-

ражения в графических редакторах. При перемещении курсора в об-

ласти модели, на нижней панели статуса главного окна программы 

отображаются координаты и параметры активной ячейки, в которой 

находится курсор. Активная в данный момент ячейка окружена пря-

моугольником более яркого цвета. Нажатие левой кнопки мыши по 

ячейке меняет ее параметр на текущий. Нужные пределы объекта 

можно регулировать с помощью инструментов добавления  и из-

менения положения линии сетки . Такие операции позволяют со-

здавать различные модели, например, прямоугольный объект, лежа-

щий от 16 до 19 м по горизонтали и от 1 до 2,2 м по вертикали в од-

нородном полупространстве с сопротивлением 10 Ом·м (рис. 17). 

После редактирования и создания нужного распределения сопро-

тивлений можно приступать к расчёту кажущихся параметров от за-

данной геоэлектрической модели (решение прямой задачи ЭТ). Для 

этого необходимо нажать кнопку  на панели инструментов или 

нажать клавишу «Пробел». После этого изменятся расчётные кажу-

щиеся сопротивления, изображённые в виде изоом над моделью 

среды (рис. 17). Созданную модель и рассчитанные данные нужно со-

хранить в файл с расширением *.z2d – формат программы 

ZondRes2D. Это можно сделать с помощью кнопки  на панели ин-

струментов или с помощью пункта меню Файл→Сохранить файл. 

Появится диалоговое окно, где нужно ввести имя и выбрать соответ-

ствующий тип файла – Zond Project data [*.z2d]. По аналогии с про-

шлыми расчётами, назовём наш файл Block15.z2d. 

Файлы формата программы ZondRes2D можно использовать в 

дальнейшем, в том числе для оперативного изменения параметров 

модели, пересчёта и извлечения данных. Полученные значения 

можно сохранить, нажав правой кнопкой мыши на верхнюю часть 

окна (вне поля разреза). В сплывающем меню нужно выбрать «Со-

хранить XYZ файл». Появится диалоговое окно, где нужно ввести со-

ответствующее название файла с расширением *.dat. Данные, кото-

рые в дальнейшем можно анализировать, в файле будут сгруппиро-

ваны в три столбца: первый – расстояние по профилю (координата 

X), второй – условная глубина (координата Z) и третий – ρk. 
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Рис. 17. Окно программы ZondRes2D в режиме решения прямой за-

дачи: рассчитанные кажущиеся сопротивления (сверху) для модели одно-

родного полупространства с блоком (снизу) 

 

Мы разобрались как создавать модели в программе ZondRes2D, 

корректировать их, рассчитывать и сохранять полученные данные 

для заданной заранее системы измерений. Теперь можно проверить 

верность решения задачи на чувствительность метода ЭТ, которую 

мы разобрали при изучении программы Res2DMod. При моделирова-

нии использовалась установка Веннера (α) с 36 электродами, между 

электродами 1 м. Рассматривался объект 3 х 1,2 м, верхняя кромка 

которого находится на глубине 1 м, в однородном полупространстве 

с сопротивлением 10 Ом·м. Было определено, что при сопротивлении 

объекта меньше 15 Ом·м и точности прибора 5 % методом ЭТ вы-

явить объект рассмотренных размеров будет затруднительно. То есть 

отклонения в данных ЭТ, вызванные таким объектом, сравнимы с 

точностью прибора. Чтобы проверить эти выводы нужно проделать 

такие же действий, как в п. 4.1. Во-первых, подготовить набор значе-

ний УЭС 
нач

k  – рассчитанные кажущиеся УЭС для модели однород-

ной среды с сопротивлением 10 Ом·м (установка Веннера (α) с 36 
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электродами, между электродами 1 м). Во-вторых, найти 
изм

k  для из-

менённой среды с объектом, заданных размеров, положения и сопро-

тивления 15 Ом·м. В-третьих, сравнить эти два набора данных по-

средством вычисления относительного отклонения rel.dev. 

Как мы уже знаем, один из способов оценки рассчитанных откло-

нений rel.dev – это построение значений ошибки в зависимости от ко-

ординаты X. На построенной диаграмме (рис. 18) по оси абсцисс от-

ложено расстояние по профилю, а по оси ординат – величина откло-

нения в процентах. На рис. 18 построены отклонения для объектов с 

сопротивлением 15 и 20 Ом·м (синие и оранжевые кружки, соответ-

ственно). Видно, что максимальные отклонения возникают в цен-

тральной части профиля, над объектом и достигают 5 % в случае 

15 Ом·м и 8 % – в случае 20 Ом·м. Аналогичная картина наблюдалась 

при моделировании в программе Res2DMod (см. рис. 12). 

 

Рис. 18. Анализ чувствительности метода ЭТ: распределение rel.dev по 

профилю 

 

Более наглядный способ – построение двумерного распределения 

относительного отклонения в изолиниях (рис. 19) с помощью специ-

ализированных программ для создания таких карт-разрезов, напри-

мер, Surfer фирмы Golden Software. На рис. 19 представлено двумер-

ное распределение относительного отклонения в изолиниях для слу-

чая, когда сопротивление объекта 15 Ом·м. Определенному цвету со-

ответствует величина относительного отклонения, а белой изолинией 

обозначена область, внутри которой относительная ошибка превы-

шает 5 %. Можно наблюдать картину схожую полученной при моде-

лировании в программе Res2DMod (см. рис. 13), а некоторые отличия 
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могут быть вызваны разными методами и расчётными сетками. В ре-

зультате мы подтвердили предел чувствительности в 15 Ом·м и он 

определяется независимо от используемой программы. 

 

Рис. 19. Анализ чувствительности метода ЭТ: двумерное распределе-

ние rel.dev по разрезу 

 

Таким образом, с помощью прямой задачи электротомографии, в 

частности, используя программы Res2DMod и ZondRes2D, можно ре-

шать различные методические задачи: исследовать разрешающую 

способность и чувствительность к заданным объектам, находить оп-

тимальную конфигурацию установки и т. д. Но зачастую применяют 

другой подход, с использованием обратной задачи ЭТ: на первом 

этапе проводится прямое моделирование, на втором – используется 

обратная задача для оценки качества восстановления исходной (за-

данной в прямой задаче) модели. Для инверсии томографических 

данных создано и продолжает разрабатываться множество программ: 

Res2DInv, ZondRes2d, ERT Lab и др. Мы разберём Res2DInv и 

ZondRes2d. Первую можно считать мировым эталоном двумерной 

интерпретации данных электротомографии, со второй мы продол-

жим начатое выше знакомство, но уже в рамках решения обратной 

задачи. 

 

4.3. Решение обратной задачи ЭТ в программе Res2DInv 

 

Res2DInv ‒ это ещё одна компьютерная программа Малазийской 

компании Geotomo Software [10], которая автоматически находит 
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двумерную (2-D) модель сопротивления среды для данных, получен-

ных с помощью томографических методик. Другими словами, 

Res2DInv решает обратную задачу метода ЭТ. Стоит сказать, что этот 

продукт является платным, в отличие от прямой задачи. Совместно с 

разобранной раньше программой Res2DMod, она образует полный 

программный пакет для двумерного прямого моделирования и инвер-

сии данных метода электротомографии. 

Программа Res2DInv разработана для инверсии больших масси-

вов данных (тысячи точек), полученных томографической системой 

наблюдений с большим числом электродов (тысячи электродов). Та-

кие измерения проводятся типичной схемой с двумя косами и после-

дующим переносом первой косы и прибора для непрерывного про-

должения профиля (см. рис. 5). 

Структура двумерной модели, используемая программой инвер-

сии Res2DInv, схожа с расчётной сеткой в прямой задаче (см. рис. 7) 

и состоит из прямоугольных блоков. Распределение и размер блоков 

автоматически генерируются программой, так что число блоков 

обычно не превышает числа точек измерения. Тем не менее, некото-

рые параметры расчётной сетки можно регулировать [15], но мы не 

будем касаться этого. 

В основе программы Res2DInv лежит прямая задача – по сути это 

модуль программы Res2DMod, который используется для расчёта 

значений кажущегося сопротивления. Поэтому, как и прямая задача, 

программа Res2DInv может работать с методом конечных разностей 

или конечных элементов. Многократное решение прямой задачи поз-

воляет применить метод нелинейной оптимизации на основе 

наименьших квадратов и решить обратную задачу ЭТ [13, 14]. Этот 

процесс выполняется в полностью автоматическом режиме, и от 

пользователя даже не требуется предоставлять начальную модель. 

Программа выбирает оптимальные параметры инверсии для опреде-

лённого массива данных. Тем не менее, некоторые из них могут кор-

ректироваться пользователем. Но в данном пособии мы разберём 

лишь основы инверсии и не будем касаться теории и настроек пара-

метров инверсии. Для более глубокого изучения этого вопроса суще-

ствует регулярно обновляемая инструкция пользователя Res2DInv 

[15]. 
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После установки программы на рабочую машину для её запуска 

используйте иконку Res2DInv. Появится привычное для пользовате-

лей Windows главное меню (рис. 20). 

 

Рис. 20. Главное меню программы Res2DInv 

 

Программа Res2DInv распознаёт данные, сгруппированные в 

определённом формате. Чаще всего они изготавливаются в специали-

зированных программах (обычно поставляемых с аппаратурой, 

например, SiberTools, RiPPP, Xeris и др.) и часто не требуют редак-

ции. Но всё же их структуру иногда приходится знать и её подробный 

разбор можно найти во многих источниках [15, 16]. В файле данных, 

который имеет расширение *.dat находятся данные, предназначен-

ные для инверсии – решения обратной задачи. Это может быть, как 

полевой материал, так и результаты решения прямой задачи ЭТ, в том 

числе полученный в программах Res2DMod и ZondRes2D. В любом 

случае, в этом файле содержится информация о системе наблюдений. 

Чаще всего это стандартные системы наблюдений вдоль линии с по-

стоянным шагом между электродами (см. п. 4.1, рис. 6). Но последнее 

время, не редкостью стало использование нестандартных установок 

(разный межэлектродный шаг, искривлённый профиль и т. д.) и такие 

расстановки также поддерживаются в современных программах ин-

версии, в том числе и в Res2DInv. 

Воспользуемся данными, которые мы уже получили в п. 4.1. 

Напомним, что после расчёта прямой задачи в программе Res2DMod 

(Model Computation→Calculate potential values), данные можно экс-

портировать с помощью пункта меню File→Save results in RES2DINV 

format. Таким образом, можно создать ещё раз или воспользоваться 

уже имеющимся файлом Block15.dat, где содержится результат реше-

ния прямой задачи для модели с прямоугольным объектом сопротив-

лением 15 Ом·м, лежащем от 16 до 19 м по горизонтали и от 1 до 2,2 м 

по вертикали, в однородном полупространстве с сопротивлением 

10 Ом·м. Откроем файл Block15.dat в программе Res2DInv с помо-

щью пункта меню File→Read data file. При успешном прочтении в 

окне программы отобразится информация о загруженных данных и 
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появится окно-сообщение Reading of data file is complete. Иначе по-

явится сообщение об ошибке, где чаще всего описана её причина. 

Устранить указанную неточность в структуре данных можно открыв 

файл в любом текстовом редакторе. 

Если данные прочитаны успешно, то можно приступать к реше-

нию обратной задачи. Не трогая настройки, произведём инверсию с 

помощью пункта меню Inversion→Least-squares inversion. Появится 

диалоговое окно, где будет предложено сохранить результаты инвер-

сии. По умолчанию это файл, имя которого совпадает с загружен-

ными данными и расширением *.inv – Block15.inv. Соглашаемся и 

нажимаем кнопку «Сохранить» или клавишу [Enter]. В окне про-

граммы появятся результаты инверсии в виде трёх разрезов (рис. 21):  

 

Рис. 21. Измеренный и рассчитанный псевдоразрезы кажущегося со-

противления для данных Block15.dat вместе с моделью, полученной в 

программе Res2DInv 

 

первый сверху – псевдоразрез измеренного кажущегося сопротивле-

ния (Measured Apparent Resistivity Pseudosection); второй – псевдораз-

рез вычисленного кажущегося сопротивления (Measured Apparent 

Resistivity Pseudosection), третий – геоэлектрический разрез (сгла-

женная модель), полученный в результате решения обратной задачи – 

инверсии (Inverse Model Resistivity Section). На каждом разрезе отло-

жено расстояние по профилю и глубина. Под картами изоом, внизу 

приведена, общая для всех, цветовая шкала значений УЭС. 
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Над полученной моделью (Inverse Model Resistivity Section) ука-

зывается итерация, на которой остановилась инверсия и среднеквад-

ратическое отклонение (RMS), рассчитанных от экспериментальных 

данных. В данном случае понадобилась одна итерация (Iteration 1), а 

RMS = 0,62 %. Такой качественный подбор за одну итерацию обу-

словлен простотой модели и использованием рассчитанных в 

Res2DMod данных в качестве экспериментальных. Такие данные 

называют синтетическими, модельными или теоретическими. 

Для удобства работы с результатом инверсии, в программе 

Res2DInv существует режим для просмотра, печати и экспорта полу-

ченных данных. Его можно вызвать с помощью пункта меню 

Display→Show inversion results. Появится окно RES2DINV: Display 

Section Window и сообщение-приветствие. Если ранее проведённая 

инверсия была успешна, то в режиме просмотра отобразятся пара-

метры установки, полученной модели, некоторые итоги инверсии, а 

в последней строке сообщение об успешном прочтении файла: 

Reading of file has been completed. Может появиться сообщение об 

ошибке, тогда нужно вернуться в основное окно программы 

RES2DINV, провести инверсию или в режиме просмотра загрузить 

готовый результат инверсии через пункт меню File→Read file with 

inversion results – файл с расширением *.inv. Если результаты инвер-

сии загружены, то мы можем его просматривать, настраивать па-

литру, изменять масштаб, печатать или сохранять результат в растро-

вый формат (*.bmp). Также существует возможность сохранить по-

лученный в результате инверсии геоэлектрический разрез для его ви-

зуализации в специализированных программах, например, Surfer. 

Для этого в режиме просмотра нужно воспользоваться пунктом меню 

File→Save data in Surfer format. Возникнет диалоговое окно Saving 

inversion results in Surfer format, где можно настроить формат выдава-

емых данных. Оставим значения по умолчанию, нажмём кнопку OK. 

В результате сохранится набор файлов (данные *.dat, палитра *.lvl, 

бланк контура разреза *.bln и др.), название которых соответствует 

прочитанным данным с некоторой добавкой. Для создания грида в 

Surfer нам понадобится файл Block15_modreslog.dat. С помощью по-

лученного грида можно построить геоэлектрический разрез в виде 

карты изолиний (рис. 22, а), который будет идентичен отображае-

мому в окне программы Res2DMod при инверсии (рис. 21). 
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Теперь мы можем качественно оценить, насколько точно восста-

навливается первоначальная модель. Для этого сравним контур объ-

екта (фиолетовый пунктир) и зону повышенных сопротивлений 

(красные тона). Видно, что инверсия даёт заниженное положение 

объекта (рис. 22, а). 

Таким образом, можно оценивать качество восстановления гео-

электрической модели, построенной по априорным данным, в зави-

симости от параметров установки (минимальный разнос, максималь-

ный разнос и др.), от её типа и других факторов. Такие численные 

исследования позволяют дать методические рекомендации до начала 

полевой части геофизических работ, что существенно сокращает, как 

временные, так и физические затраты. 

В приведённом выше примере использовался пакет программ од-

ного разработчика Geotomo Software. Это значит, что используются 

одинаковые алгоритмы: обратная задача многократно использует 

прямую, где в свою очередь и рассчитывались синтетические данные. 

Такой подход ничему не противоречит, но для чистоты эксперимента 

обычно используют сторонние программы (разные алгоритмы, 

сетки). Мы воспользуемся программой ZondRes2D, где рассчитаем 

прямую задачу для той же модели, используя заготовку Block15.z2d 

из п. 4.2. 

Открыв в программе ZondRes2D файл Block15.z2d, можно рассчи-

тать ещё раз прямую задачу и затем экспортировать данные в формат 

Res2DInv. Это можно сделать с помощью кнопки  на панели ин-

струментов или с помощью пункта меню Файл→Сохранить файл. 

Появится диалоговое окно, где нужно ввести имя и выбрать соответ-

ствующий тип файла – Res2DInv calculated data [*.dat]. Назовём файл 

Zond_Block15.dat. 

Теперь, используя рассчитанные данные, мы можем решить об-

ратную задачу в программе Res2DInv. Произведём инверсию с помо-

щью пункта меню Inversion→Least-squares inversion. Результат со-

храним в файл Zond_Block15.inv и экспортируем для построения в 

Surfer через пункт меню File→Save data in Surfer format. В результате 

получим геоэлектрический разрез в виде изоом кажущегося УЭС 

(рис. 22, б). Видно, что разрезы схожи на качественном уровне – вы-

деляется центральная высокоомная аномалия, связанная с прямо-

угольным объектом (фиолетовый контур). Тем не менее, можно за-

метить, что инверсия данных, рассчитанных в программе ZondRes2D, 
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даёт более локализованный результат, кроме того положение объекта 

по вертикали определяется с лучшей точность. Такой результат мо-

жет быть связан с различием в расчётной сетке – в программе 

ZondRes2D используется более густая начальная (по умолчанию) 

сетка. 

 

Рис. 22. Инверсия синтетических данных в программе Res2DInv: а – 

модельные данные получены в программе Res2DMod; б – ZondRes2D 
 

Итак, мы разобрали инверсию синтетических данных в программе 

Res2DInv разработчика Geotomo Software. В данном случае авторы 

разделили решение прямой и обратной задачи в разные продукты, од-

нако в большинстве современных программ эти две задачи объеди-

няются под одной оболочкой, как это сделано в ZondRes2D. 
 

4.4. Решение обратной задачи ЭТ в программе ZondRes2D 
 

Программа ZondRes2D позволяет решать не только прямую за-

дачу ЭТ, разобранную в п. 4.2, но и проводить инверсию данных ЭТ. 

Для решения обратной задачи (инверсии) используется метод 

наименьших квадратов с регуляризацией [12]. 

Для проведения инверсии необходимо загрузить файл с данными 

ЭТ. Как и при разборе программы Res2DInv будем использовать два 

синтетических массива данных, которые мы уже подготовили зара-

нее: Block15.dat – расчёт в программе Res2DMod; Zond_Block15.dat – 

расчёт в программе ZondRes2D. Чтобы открыть первый из файлов 

воспользуемся кнопкой  или пунктом меню Файл→Открыть 

файл. Появится диалоговое окно, где нужно выбрать соответствую-

щий файл, предварительно задав нужный тип файлов – 
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Res2DInv [*.dat]. При открытии файла появится знакомое нам окно 

«Конструктор модели» (Mesh constructor) для настройки расчётной 

сетки и стартовой модели. Оставляем значения по умолчанию и 

нажимаем ОК. Появится предупреждение о большом количестве па-

раметров (Very large number of parameters!) с возможностью их авто-

матического уменьшения. Мы нажимаем кнопу «Оставить как есть» 

(Cancel). В результате появится окно программы, разделенное на три 

части (рис. 23), как и в Res2DInv: сверху – измеренные кажущиеся 

сопротивления (Observed apparent resistivity data); в центре – расчёт-

ные кажущиеся сопротивления (Calculated apparent resistivity data), 

внизу – разрез сопротивлений (Resistivity block section). На каждом 

разрезе отложено расстояние по профилю и глубина, а справа приве-

дены цветовые шкалы значений УЭС. 

 

Рис. 23. Измеренный и рассчитанный псевдоразрезы кажущегося со-

противления для данных Block15.dat вместе с моделью, полученной в 

программе ZondRes2D 

Можно приступать к инверсии. Для этого нужно воспользоваться 

кнопкой  на панели инструментов. Начнётся автоматическая ин-

версия, при этом будут в реальном времени изменяться разрез рас-

чётных кажущихся сопротивлений и разрез сопротивления (модель). 
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Прогресс процесса инверсии отображается в процентах и нарастаю-

щей синей полоской в строке состояния, в нижней части окна про-

граммы. Рядом с ячейкой прогресс, справа, отображается значение 

относительной невязки, по величине которой можно сделать экс-

пресс оценку качества инверсии. Для нашего модельного случая это 

0,012 (рис. 23), но при реальной инверсии, при «среднем» качестве 

данных, значение не должно превышать 5 %. 

По завершению инверсии можно приступать к анализу данных. 

Для этого сохраним результат с помощью кнопки  на панели ин-

струментов или с помощью пункта меню Файл→Сохранить файл. 

Появится диалоговое окно, где нужно ввести имя и выбрать соответ-

ствующий тип файла – Grid file [*.dat]. Назовём файл 

Block15_grid.dat. Данные будут сгруппированы в четыре столбца: 

первый – расстояние по профилю (координата X), второй – условная 

глубина (координата Z), третий – логарифм ρk и четвёртый ρk. Для 

построения в Surfer будем использовать первые три. В результате по-

лучим геоэлектрический разрез в виде изоом (рис. 24, а). 

Теперь можем сделать всё тоже самое для второго набора синте-

тических данных – Zond_Block15.dat. Загружаем файл, проводим ин-

версию в программе ZondRes2D, сохраняем полученный результат и 

строим его в Surfer. В результате получаем геоэлектрический разрез 

в виде изоом (рис. 24, б). Сравнивая два полученные разреза на каче-

ственном уровне можно сказать, что при инверсии данных, рассчи-

танных в программе Res2DMod, точность определения вертикальной 

координаты объекта выше. Что касается локальности (определение 

границ объекта), то здесь небольшое визуальное преимущество воз-

никает при инверсии данных сгенерированных в программе 

ZondRes2D (фиолетовый контур). 

Стоит сказать, что при восстановлении модели мы использовали 

чистые данные, что не всегда корректно. На практике, где присут-

ствуют такие факторы, как помехи, низкий уровень сигнала вслед-

ствие плохих заземлений, такая идеальная ситуация возникает крайне 

редко. Поэтому для корректности численного эксперимента, кроме 

перекрёстной инверсии, т. е. использования разных программ для ре-

шения прямой и обратной задачи ЭТ, в данные необходимо вносить 

шум. Такая возможность реализована в программах Res2DMod и 

ZondRes2D, а примеры разобраны в пп. 4.5.1–4.5.3 и во многих ис-

точниках [12, 16]. 
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Рис. 24. Инверсия синтетических данных в программе ZondRes2D: а – 

модельные данные получены в программе Res2DMod; б – ZondRes2D 

 

Стоит ещё раз вспомнить, что мы в данном пособии не разбираем 

всех тонкостей решения прямой задачи и инверсии, а приводим лишь 

принципы их использования на этапе проектирования работ для 

определения методических рекомендаций. Поэтому, чаще всего, мы 

будем решать прямую и обратную задачу, используя значения по 

умолчанию. Если же использовать идентичные параметры для вы-

числения синтетических данных и их последующей инверсии в раз-

ных программах, то результат решения обратной задачи должен по-

лучиться идентичным. То есть, можно добиться, чтобы разрезы, 

представленные на рис.  22 и 24 повторяли друг друга с хорошей точ-

ностью. Для нас же более важным является разбор геологических мо-

делей рудных месторождений, их построение и расчёт в приведённых 

программах. 

Как уже говорилось, здесь и далее используется проводящая мо-

дель среды (без вызванной поляризации). Принципы моделирования 

полей с учётом вызванной поляризации горных пород будут иден-

тичны. 

 
4.5. Геоэлектрические модели рудных месторождений 

 

Геоэлектрическая модель среды является фундаментальным поня-

тием электроразведки, так как лежит в основе решения прямых и об-

ратных задач. Каждому изучаемому геологическому разрезу, в том 

числе рудному месторождению, (рис. 25, а) соответствует его мо-
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дель – упрощенное, усредненное представление реального геологи-

ческого объекта, сохраняющее основные его черты. В двумерном 

случае – это геоэлектрический разрез (рис. 25, б), который представ-

ляет собой совокупность электрических и геометрических характери-

стик горных пород и руд, слагающих данный разрез. На геоэлектри-

ческом разрезе обозначаются основные границы пород, отличаю-

щихся по электромагнитным свойствам. 

 

Рис. 25. Геологический (а) и геоэлектрический (б) разрезы: 1 – глины, 

2 – известняки, 3 – долериты, 4 – рудное тело [17] 

 

Необходимо подчеркнуть, что заданному геологическому разрезу 

соответствует конкретный геоэлектрический разрез, но заданный 

геоэлектрический разрез определяет геологический неоднозначно. 

Это связано с тем, что некоторые породы и руды могут обладать схо-

жими (или одинаковыми) физическими свойствами, но при этом 

имеют различный состав. Поэтому переход от геоэлектрического раз-

реза к геологическому требует наличия априорной геологической и 

петрофизической информации [17]. 

Исходными данными для формирования геоэлектрической мо-

дели служат сведения о геометрических параметрах моделируемого 

объекта и об электрических свойствах объекта и вмещающих пород. 

К геометрическим параметрам относятся форма и размеры объекта, 

глубина залегания, угол падения и т. п. Если объект приурочен к ка-

ким-то геологическим образованиям, таким, как тектонические зоны, 

области измененных пород, необходимы данные о геометрических 

параметрах и свойствах этих геологических тел и структур.  



59 

Источником сведений о геометрических параметрах формируе-

мой модели являются геологические представления об объекте поис-

ков, параметры известных подобных объектов в данном регионе и в 

других регионах с аналогичным геологическим строением. Сведения 

об электрических свойствах горных пород и полезных ископаемых 

могут быть получены путем измерений на образцах, по данным каро-

тажа и другими способами. При формировании обобщенной модели 

задают пределы возможных изменений параметров или определяют 

их среднестатистическое значение [18]. 

Большинство рудных месторождений можно описать несколь-

кими типичными обобщёнными геоэлектрическими моделями. Рас-

смотрим ряд таких моделей в следующих пунктах. 

 

4.5.1. Моделирование рудоконтролирующего разлома 

 

Разрывные нарушения (разломы) нередко являются рудоконтро-

лирующими структурами. По разломам внедряются гидротермаль-

ные растворы и формируют оруденение. Например, тектонический 

облик Гарганской структурно-формационной зоны (Восточные Са-

яны) определяется широким развитием складчатых структур и раз-

рывной тектоники северо-западного и субширотного простираний. 

Обычно эти разрывные нарушения являются рудоконтролирую-

щими, по крайней мере, на известных золоторудных объектах. Раз-

ломные зоны крутопадающие (70°), мощностью 20–100 м, включают 

дайки и кварцевые жилы. Разломы представляют собой зоны мило-

нитизации, тонкого рассланцевания и катаклаза. Рудные тела пред-

ставлены сульфидно-кварцевыми жилами. Геологическая модель 

разреза, включающего рудоконтролирующий разлом, показана на 

рис. 26. 

Для прямого моделирования данных ЭТ над моделью рудоконтро-

лирующего разлома будем использовать программу Res2DMod. По-

строим модель Fault.mod с соответствующей геометрией и значени-

ями УЭС (рис. 27, снизу). Будем имитировать трёх электродную уста-

новку (pole-dipole) с межэлектродным расстоянием 5 м, количество 

электродов 48 (аналог приборов Скала 48, Iris). В результате решения 

прямой задачи получим разрез кажущихся УЭС (рис. 27, сверху). 
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Рис. 26. Геологический разрез (а) и геоэлектрическая модель (б) ру-

доконтролирующего разлома: 1 – четвертичные отложения, 2 – граниты, 

3 – разломная зона, 4 – пиритизация 

 

По аналогии можно рассчитать разрез кажущихся УЭС для другой 

установки (например, осевая дипольная – Inline dipole-dipole) и по-

следовательно экспортировать оба набора данных для дальнейшей 

инверсии с помощью пункта меню File→Save results in RES2DINV 

format. Возникнет окно для введения шума Choose noise level, кото-

рое мы раньше игнорировали. Теперь добавим шум, поставив точку 

напротив «Yes» под вопросом «Do you want to add noise to the data?» 

и введём уровень 5 % в окошке ниже. Файлы назовём Fault_pd.dat и 

Fault_dd.dat для установок Шлюмберже и осевая дипольная, соответ-

ственно. 

Выбор дипольной и трёх-электродной установок неслучаен, 

именно их чаще всего применяют при измерениях методом электро-

фотографии на рудных месторождениях, особенно это касается ру-

доконтролирующих разломов, даек, жил и контактов интрузии и оса-

дочных пород. Это связано с повышенной чувствительностью ди-

польной установки к вертикальной границе. Применение трёх-элек-

тродной установки, помимо увеличенной глубинности исследований 
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и хорошей чувствительности к субвертикальным границам, повы-

шает качество измерений методом ВП, который чаще всего исполь-

зуется на упомянутых объектах. 

 

Рис. 27. Разрез рассчитанных кажущихся УЭС (сверху) и геоэлектри-

ческая модель (снизу) рудоконтролирующего разлома в программе 

Res2DMod 

 

Полученные наборы данных Fault_pd.dat и Fault_dd.dat будем ис-

пользовать для решения обратной задачи в программе ZondRes2D по 

схеме, описанной в п. 4.4. Но используем другой алгоритм инверсии – 

Focused, где применяется сглаживающий оператор с дополнительной 

фокусировкой [12]. Для этого нужно открыть настройки программы 

используя кнопку  на панели инструментов. В появившемся окне, 

на вкладке «Главные» в поле «Инверсия» выбрать пункт Focused. 

Применение такого алгоритма инверсии позволяет получать модели 

с более выраженными границами, что чаще всего соответствует гео-

логическому разрезу. В результате построим два разреза (рис. 28), 

анализируя которые можно выбрать более эффективную в данном 

случае установку. 

Видно, что заданная в прямой задаче модель разломной зоны 

(рис. 28, белый контур) восстанавливается несмотря на зашумлённые 

данные в обоих случаях. Но детальней прослеживается при исполь-

зовании дипольной установки (рис. 28, б): можно в некоторой сте-

пени проследить как направление, так и контуры разломной зоны. 
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Рис. 28. Результат инверсии в программе ZondRes2D данных ЭТ, рас-

считанных над моделью рудоконтролирующего разлома для трёх элек-

тродной (а) и осевой дипольной (б) установок в программе Res2DMod 

 

Таким образом, мы рассмотрели модель рудного месторождения в 

виде рудоконтролирующего разлома и провели моделирование дан-

ных электротомографии над ней. В результате установлена эффек-

тивность данного метода при изучении месторождений такого типа. 

Другим типичным примером является модель дайки, которая рас-

смотрена в следующем пункте. 

 

4.5.2. Моделирование дайки 

 

Дайковые образования, являющиеся одним из существенных эле-

ментов магматических и рудно-магматических систем, представляют 

исключительный интерес для решения фундаментальных проблем 

геологии, геодинамики, петрологии и рудообразования [19]. С дай-

ками нередко связаны месторождения платины, меди, никеля, а также 

золота. При этом, рудоносной может быть, как само дайковое тело, 

содержащее сульфидные руды, так и зоны контактов даек с вмещаю-

щей средой (зальбанды). 

Примером золоторудного месторождения, связанного с дайками, 

является месторождение Амурская дайка, расположенное в Забай-

кальском крае в Карийском рудном узле. Вмещающими породами яв-

ляются гранитоиды Кара-Чачинского массива. В районе развиты 

позднеюрские и раннемеловые дайки щелочных пород (J3-К1) – ги-

бридных порфиров, субщелочных гранитов, гранит-порфиров и «гро-
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рудитов» (эгирин-полевошпат-кварцевых образований). С внедре-

нием гранитоидов Кара-Чачинского массива и даек щелочных пород 

связывается формирование золотого оруденения района [20, 21]. На 

участке Амурская дайка в гибридных порфирах и вмещающих их 

кварцевых диоритах наблюдаются серии маломощных прожилков 

кварцевого и кварц-сульфидного, иногда существенно сульфидного 

состава с видимым золотом. Характерной особенностью оруденения 

участка Амурская дайка является присутствие в прожилках адуляра, 

карбоната, хлорита, серицита; сульфидные минералы представлены 

пиритом, висмутином, халькопиритом. Геологическая модель раз-

реза представлена на рис. 29, а. 

Для прямого моделирования данных ЭТ будем использовать про-

грамму ZondRes2D. Построим модель Dayka.z2d с соответствующей 

геометрией и значениями УЭС (рис. 29, снизу). Мы уже говорили, что 

для поисков крутопадающих тел, в частности дайки, необходимо ис-

пользовать трёх-электродную или осевую дипольную установки, по-

этому их и будем имитировать. Для сравнения эффективности разных 

расстановок ЭТ при изучении дайки, рассмотрим ещё установку 

Шлюмберже: межэлектродное расстоянием 5 м и 48 электродов (ана-

лог приборов Скала 48, Iris). В результате решения прямой задачи по-

лучим разрез кажущихся УЭС (рис. 30, сверху). 

Используя созданную модель Dayka.z2d и последовательно изме-

няя тип установки через пункт меню Файл→Изменить тип установки, 

можно рассчитать данные ЭТ. Экспортировать данные для инверсии 

в программе Res2DInv можно с помощью кнопки  на панели ин-

струментов или с помощью пункта меню Файл→Сохранить файл. 

Появится диалоговое окно, где нужно ввести имя и выбрать соответ-

ствующий тип файла – Res2DInv calculated data [*.dat]. Назовём 

файлы Dayka_Zond_dd.dat для осевой дипольной установки, 

Dayka_Zond_pd.dat для трёхэлектродной, Dayka_Zond_sh.dat – 

Шлюмберже. 
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Рис. 29. Геологический (а) и геоэлектрический (б) разрезы модели 

дайки: 1 – четвертичные отложения, 2 – кварцевые диориты, 3 – разлом-

ная зона, 4 – пиритизация, 5 – гибридные порфиры 

 

Рис. 30. Разрез кажущихся УЭС (сверху) и геоэлектрическая модель 

(снизу) рудоконтролирующего разлома в программе ZondRes2D 
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Полученные наборы данных будем использовать для решения об-

ратной задачи в программе Res2DInv по схеме, описанной в п. 4.3. 

При решении обратной задачи будем использовать робастный метод, 

который позволяет получить более точно положение границ, что 

чаще всего соответствует геологическому разрезу. Для этого необхо-

димо до начала инверсии воспользоваться пунктом меню Inver-

sion→Inversion methods and setting→Select robust inversion. Не будем 

вдаваться в подробности и установим в появившемся окне, внизу, 

точку напротив строки Select YES to all of the above options. После 

чего проведём инверсию. 

В результате построим три разреза (рис. 31), анализируя которые 

можно выбрать наиболее эффективную для поставленной задачи 

установку. Видно, что заданная в прямой задаче модель дайки 

(рис. 31, белый контур) восстанавливается лучше при использовании 

осевой дипольной и трёх-электродной установок (рис. 31, а,б). При-

чём можно констатировать, что восстановление происходит только 

до 20–25 м, как в случае дипольной, так и в случае трёх-электродной 

установки. Если же применять установку Шлюмберже (рис. 31, в), то 

здесь дайка восстанавливается лишь на качественном уровне:  можно 

 

Рис. 31. Результат инверсии в программе Res2DInv данных ЭТ, рас-

считанных над моделью дайки для осевой дипольной (а), трёх-электрод-

ной (б) и установки Шлюмберже (в) в программе ZondRes2D 
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говорить только о наличии дайки, но никак не о её геометрических па-

раметрах. В любом случае при выборе методики (тип установки, меж-

электродное расстояние и т. д.) измерений нужно руководствоваться 

поставленными задачами. Но моделирование показывает, что дайко-

вые образования хорошо дифференцируются методом электротомо-

графии, как и для прошлой модели рудоконтролирующего разлома. 

 

4.5.3. Модель контакта интрузии и осадочных пород 

 

Типичным рудным месторождением на контакте интрузии и оса-

дочного комплекса пород является скарновое месторождение желез-

ных руд.  

Месторождения этого типа приурочены к рудным поясам вулка-

ногенно-осадочных формаций геосинклинальных областей (Урал, 

Тургайский прогиб, Горная Шория) и располагаются в приконтакто-

вых зонах интрузий умеренно-кислого гранитоидного состава (дио-

ритов, гранодиоритов, гранитов). Интрузии обособляются в отдель-

ные узлы. Рудовмещающие палеозойские породы представлены: пор-

фиритами, туфами, глинисто-карбонатными сланцами, песчаниками, 

известняками (Тургай); эффузивами-ортофирами и кератофирами, 

известняками (Горная Шория); глинистыми сланцами, известняками 

и доломитами (Урал). Рудные залежи месторождений имеют пласто-

образную форму (Урал, Тургай); встречаются также тела со сложной 

и изменчивой формой – в виде линз, жил, гнезд, пластов (Горная 

Шория). Рудные зоны представлены магнетитом, рудными скарнами 

и скарнированными породами. Скопления магнетита наблюдаются в 

виде сплошных, массивных тел, линз, гнезд, вкрапленности в скар-

нах. В зонах окисления встречаются мартитовые и гематитовые руды.  

Геологическая и геоэлектрическая модель зоны контакта интру-

зивных и осадочных пород показана на рис. 32. 

Прямое моделирование данных ЭТ будем проводить с помощью 

программы Res2DMod. Построим модель Contact.mod с соответству-

ющей геометрией и значениями УЭС (рис. 33, снизу). Для расчётов 

используем осевую дипольную установку с межэлектродным рассто-

янием 5 м, количество электродов 48 (аналог приборов Скала 48, Iris). 

В результате решения прямой задачи получим разрез кажущихся 

УЭС (рис. 33, сверху). 
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Рис. 32. Геологический (а) и геоэлектрический (б) разрезы модели 

контакта интрузии и осадочных пород: 1 – четвертичные отложения, 2 – 

граниты, 3 –скарны, 4 –магнетит, 5 – известняки 

 

В данном примере покажем влияние шума, введённого в рассчи-

танный набор данных ЭТ, на результат инверсии. Для этого при экс-

порте (File→Save results in RES2DINV format) последовательно со-

здадим 2 набора данных ЭТ. Для первого набора в окне для введения 

шума «Choose noise level» оставляем нулевой шум, для второго – вво-

дим уровень 5 %. В результате получим 2 файла Contact.dat и Con-

tact_Noise.dat. 

Полученные наборы данных будем использовать для решения об-

ратной задачи в программе ZondRes2D по схеме, описанной в п. 4.4. 

В результате построим два разреза (рис. 34), где можно увидеть, что 

инверсия данных с шумом даёт достаточно неоднородную картину 

(рис. 34, б), в отличии от инверсии незашумлённого набора (рис. 34, а), 

где чётко выделяются все области и прослеживается контур контакта 

интрузии и осадочных пород (рис. 34, белый контур). Тем не менее, 

даже при уровне шумов 5 % такой разрез хорошо дифференцируется 

методом ЭТ. 
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Рис. 33. Разрез кажущихся УЭС (сверху) и геоэлектрическая модель 

(снизу) контакта интрузии и осадочных пород 

 

Рис. 34. Результат инверсии в программе ZondRes2D данных ЭТ без 

шума (а) и с шумом 5 % (б), рассчитанных над моделью контакта интру-

зии и осадочных пород для осевой дипольной установки в программе 

Res2DMod 

 

Таким образом мы провели моделирование данных ЭТ над тремя 

типичными моделями рудных месторождений. В результате модели-

рования показано, что любой из приведённых типов месторождения 

(для рассмотренных параметров) может быть выявлен и исследован 

с помощью метода электротомографии. Нужно сказать, что в некото-

рых случаях при отсутствии контраста по УЭС или вместе с ним, при-

ведённые месторождения зачастую хорошо дифференцируются по 
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вызванной поляризации (см. рис. 26, 29, 32, параметр η), моделиро-

вание которой мы не разбираем в данном пособии. Учёт данного па-

раметра возможен в программах разработчика Geotomo Software и в 

ZondRes2D, а принципы моделирования полей с учётом вызванной 

поляризации горных пород идентичны случаю проводящей модели. 

Поэтому мы предлагаем изучить эти возможности самостоятельно. 

Нетрудно догадаться, что помимо вызванной поляризации в разо-

бранных моделях не учитывается ещё множество параметров и фак-

торов. В первую очередь стоит понимать, что все геологические 

структуры (как и окружающий нас мир) являются трёхмерными. По-

этому перейдём к рассмотрению ЭТ в трёхмерной постановке. 
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5. ЭЛЕКТРОТОМОГРАФИЯ  

В ТРЁХМЕРНОЙ ПОСТАНОВКЕ 

 

Двумерный подход при интерпретации данных ЭТ в настоящее 

время является основным. Но стоит понимать, что все геологические 

структуры являются трехмерными по своей природе, поэтому трёх-

мерная съёмка методом ЭТ и последующая 3D инверсия теоретиче-

ски должны давать наиболее точные результаты. Тем не менее, трёх-

мерный подход до сих пор является предметом активных исследова-

ний и ещё не достиг того уровня, на котором используется 2D иссле-

дования. Основной причиной является экономическая целесообраз-

ность применения таких исследований: физические, временные и вы-

числительные затраты значительно возрастают при 3D исследовании, 

в сравнении с 2D. В настоящее время данная методика активно раз-

вивается и появляются многоканальные электроразведочные станции 

с возможностью увеличения количества используемых электродов 

(Скала-64к15, IRIS и др.), что позволяет сокращать время измерения. 

Развитие вычислительных технологий даёт возможность интерпрети-

ровать полученный такими измерителями огромный массив данных 

(десятки тысяч точек измерения и тысячи электродов) за приемлемое 

время. Одной из разработок, которая позволяет познакомиться с тех-

нологией трёхмерной ЭТ является пакет Res3DMod/Res3DInv уже из-

вестной нам фирмы Geotomo Software для прямого 3D моделирова-

ния и инверсии данных ЭТ. 

 

5.1. Решение прямой задачи ЭТ в программе Res3DMod 

 

Res3DMod – программа для моделирования данных электротомо-

графии в трёхмерном случае, которая распространяется свободно с 

некоторыми функциональными ограничениями. Полная версия 

Res3DModx64 распространяется платно и использует возможности 

64-разрядной ОС Windows. Бесплатную версию можно свободно ска-

чать на сайте разработчиков Малазийской компании Geotomo 

Software [10]. Res3DMod позволяет решать трёхмерную прямую за-

дачу в случае метода электротомографии с определённым типом 

установки, т. е. рассчитывать и строить трёхмерное распределение 

кажущегося УЭС для заданной пользователем трёхмерной модели 
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среды. В Res3DMod для моделирования можно использовать следу-

ющие установки: Веннера, дипольная (dipole-dipole) трёх-электрод-

ная (pole-dipole), потенциал-установка (pole-pole), Шлюмберже 

(см. рис. 6).  

При решении прямой задачи ЭТ в трёхмерной постановке про-

грамма Res3DMod использует метод конечных разностей или метод 

конечных элементов по выбору пользователя. При этом электроды, 

как и в двумерной задаче (программа Res2DMod), располагаются в 

узлах прямоугольной сетки (рис. 35). Только теперь сетка имеет трёх-

мерное строение. На рис. 35 показана схема расположения узлов в 

трехмерной сетке [22]. 

 

Рис. 35. Фрагмент расчётной сетки в программе Res3DMod 

 

Как и в двумерном случае, программа Res3DMod использует ещё 

несколько узлов (на рис. 35 приведён случай с одним промежуточ-

ным узлом) между соседними электродами и 10 дополнительных уз-

лов в каждую сторону, для корректного учёта краевых эффектов. 

Максимальное количество электродов зависит от объёма оператив-

ной памяти используемой вычислительной машины и разрядности 

программы. Стоит учитывать, что в программе Res3DMod, начало си-

стемы координат электродов расположено в левом верхнем углу 

сетки (если смотреть на сеть сверху). 

Как и в программах для двумерного моделирования, каждому 

блоку сетки можно задавать значение сопротивления. Таким обра-
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зом, используя такое разбиение, можно составлять трёхмерные гео-

логические структуры или объекты, получать для них сигналы ЭТ и 

трансформировать их в кажущееся сопротивление. 

Заготовки с параметрами сеток и моделей двумерной среды со 

значениями УЭС можно сделать вручную в любом текстовом редак-

торе, а потом уже корректировать с помощью инструментов про-

граммы Res3DMod. Файлы с такими заготовками имеют собственный 

формат и расширение *.mod. Структура формата схожа с разобран-

ной в разделе двумерного моделирования в программе Res2DMod 

(см. п. 4.1, табл. 1) и описана построчно в табл. 2 на примере модели 

однородного полупространства с сопротивлением 10 Ом·м. 
 

Таблица 2 

Описание структуры *.mod для программы Res3DMod 

Структура Файла № строки и пояснения 

HalfSpace10 Строка 1 – название модели 

8,8 
Строка 2 –количество электродов в 

направлении X и Y 

1.0, 1.0 
Строка 3 – межэлектродное расстоя-

ние в направлении X и Y 

Far electrodes included 

C2 far electrode X and Y lo-

cation 

500.00, -1000.00 

P2 far electrode X and Y lo-

cation 

500.00, 1000.00 

Строка 4–8 – эти строки необяза-

тельные. Задаётся положение уда-

лённого питающего (C2) и приём-

ного (P2) электродов для установок 

pole-dipole и pole-pol 

3 
Строка 9 – количество значений 

УЭС, используемых в модели 

1, 10.00, 100.00 
Строка 10 – значения УЭС, исполь-

зуемые в модели 

6 
Строка 11 – количество рядов бло-

ков (слоёв) сетки в модели  

LEVEL 1 
Строка 12 – строка, после которой 

идёт информация по первому слою  
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Продолжение табл. 2 

Структура Файла № строки и пояснения 

11111111111111 Строка 13–26 – информация по пер-

вому слою блоков сетки. Количество 

элементов в каждой строке зависит 

от выбора пользователя и кратно ко-

личеству расстояний между элек-

тродами (на один меньше количе-

ства электродов). От этого будет за-

висеть густота сетки – количество 

узлов между электродами. В нашем 

случае 14 = (8–1)*2, поэтому между 

каждой парой электродов будет 

один узел. 
 

Число «0» соответствует первому 

значению УЭС (задано в строке 11), 

«1» – второму, и т. д. 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

11111111111111 

LEVEL 2 
Строка 27 – строка, после которой 

идёт информация по второму слою  

… 
Строка 28–41 – информация по вто-

рому слою блоков сетки  

-------------- ------------------------------------------- 

LEVEL 6 
Строка 87 – строка, после которой 

идёт информация по шестому слою   

… Строка 88-101 – информация по ше-

стому слою блоков сетки  

0 Строка 102 – указатель на тип разби-

ения сетки по глубине: 0 – автомати-

ческое, 1 – ручное  

0.3, 0.6, 1, 1.5, 2.5, 4, 6 
Строка 103 – глубины горизонталь-

ных слоёв  

0, 0, 0, 0 Строка 104 – Указатель конца файла 

 

При формировании модели и сетки стоит учитывать, что густота 

сетки (частота вертикальных и горизонтальных линий) задаётся поль-

зователем и влияет на точность и время расчёта: чем точнее, тем 

дольше. Не стоит забывать требования к сетке, определённые при 
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двумерном моделировании в программе Res2DMod. Эти же правила 

будут справедливы и в трёхмерном случае: первые три разбиения по 

глубине не должны быть больше трёх блоков вдоль одной из гори-

зонтальных осей, начиная с четвёртого – мощность горизонтальных 

слоёв может увеличиваться по логарифмическому закону. 

Пользуясь табл. 2, можно сформировать файл модели однород-

ного полупространства с сопротивлением 10 Ом·м и заданными па-

раметрами расчётной сетки – HalfSpace10.mod и перейти непосред-

ственно к работе с программой. Для начала роботы в программе 

Res3DMod необходимо скачать её с сайта разработчика 

(http://www.geotomosoft.com/index.php) и установить. После запуска 

программы появится окно, где можно увидеть привычное для поль-

зователей ОС Windows меню (рис. 36). В связи с тем, что разработчик 

программ Res2DMod и Res3DMod один, то надо полагать, что интер-

фейс и работа в этих программах будет во многом схожа. 

 

Рис. 36. Главное меню программы Res3DMod 

 

Открыть созданный ранее файл HalfSpace10.mod можно выбрав 

пункт меню File→Read model data. В случае удачного прочтения 

сетки и модели, в окне программы отобразится некоторая полученная 

из файла информация (название модели, количество электродов, раз-

носы и т. д.) и появится окно-сообщение о завершении чтения файла 

(Reading of data file is complete), где необходимо нажать кнопку «ОК». 

Если в параметрах сетки или модели будут ошибки, то появится 

окно-сообщение, где чаще всего указывается возникшая проблема. 

После успешной загрузки файла HalfSpace10.mod с параметрами 

сетки и модели можно приступать к просмотру, редактированию мо-

дели и расчёту прямой задачи ЭТ. Для просмотра и редактирования 

модели необходимо выбрать пункт меню Edit/Display→Edit resistivity 

model. Появится окно редактирования модели, где отобразится по-

слойно модель с расчётной сеткой (рис. 37). В нашем случае – это 

шесть одноцветных квадратов в соответствии с заданным количе-

http://www.geotomosoft.com/index.php
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ством слоёв сетки (табл. 2, строка 11), над каждым из которых обо-

значены его границы (табл. 2, строка 103). Цвет соответствует задан-

ному сопротивлению 10 Ом·м, значение которого можно отследить 

ниже под моделью слева: 1, 10 и 100 Ом·м. Эта информация также 

прочитана верно из 4 и 5-й строк файла HalfSpace10.mod. Каждый 

квадрат это 14 х 14 элементов или 7 х 7 м, а электроды обозначены 

чёрными точками. В абсолютных величинах, горизонтальные раз-

меры каждого элемента сетки 0,5 х 0,5 м, потому, что межэлектрод-

ное расстояние 1 м разбивается ещё пополам (табл. 2, строки 13–26). 

Нельзя забывать, что начало системы координат расположено в ле-

вом верхнем углу сетки. Это понадобится при анализе рассчитанных 

данных. 

 

Рис. 37. Редактирования модели HalfSpace10 в программе Res3DMod 

 

Находясь в режиме Edit Model можно приступать к редактирова-

нию модели изменяя УЭС блоков сетки интерактивно с помощью 

мыши и клавиатуры. Для этого нужно навести курсор на элемент 

сетки, который необходимо поменять и нажать правую кнопку 

мыши. Цвет блока изменится на чёрный. Это означает, что в этом 

блоке не задано никакое из представленных значений сопротивления. 

После этого необходимо выбрать одно из значений УЭС: кликнуть 

кнопкой мыши по одному из цветных прямоугольников, которые 

находятся под моделью слева, рядом со значениями сопротивлений 
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(в нашем случае 1, 10 и 100 Ом·м). В результате чёрный блок приоб-

ретёт цвет, отвечающий выбранному сопротивлению. Таким обра-

зом, можно изменять УЭС некоторой области в модели: выделить 

группу блоков и присвоить им нужное сопротивление. 

Чтобы упростить работу с большими расчётными сетками и слож-

ными моделями в программе реализована возможность использовать 

горячие клавиши для выделения сразу группы блоков: левая кнопка 

мыши – выделение 4-х блоков вправо и вниз от курсора мыши; D – 

выделение столбца блоков вниз от курсора до нижней границы мо-

дели. При этом, если зажать клавишу D и водить мышью, будет не-

прерывное выделение элементов (столбцов модели) ниже слоя, на ко-

тором находится мышь. 

Используя приобретённые выше знания, смоделируем знакомую 

нам с двумерного случая ситуацию: 36 электродов в каждую сторону, 

между каждой парой 1 м и один дополнительный узел сетки. Для рас-

чётов создадим модель однородного полупространства с сопротивле-

нием 10 Ом·м, в которой находится объект от 16 до 19 м по горизон-

тали в направлении X и от 1 до 2,2 м по вертикали. Нужно задать 

границы горизонтальных слоёв так, чтобы они позволили задать нуж-

ные размеры объекта. Кроме того, если в двумерном случае у нас объ-

ект был неограничен в третьем направлении, то теперь нам нужно за-

дать размеры ещё по одной координате – Y – от 10 до 25 м (рис. 38). 

Намеренно сделаем размер по Y в несколько раз больше межэлек-

тродного расстояния. Это сымитирует двухмерность, что позволит 

сравнивать результат моделирования с двумерными расчётами, про-

ведёнными ранее (пп. 4.1, 4.2). 

Сопротивление объекта зададим 15 Ом·м, что соответствует по-

рогу чувствительности, который мы определили при рассмотрении 

двумерного случая в программах Res2DMod и ZondRes2D (пп. 4.1, 

4.2). После окончания редактирования нужно выйти из текущего 

окна с помощью клавиши Esc или через пункт меню Exit→Quit edit 

widow. При выходе программа предложит вам сохранить изменения. 

Нужно согласиться и после выхода, чтобы не потерять созданную мо-

дель, её нужно ещё раз сохранить, используя пункт меню File→Save 

result in Res3DMod format. Назовём эту модель Block2D.mod. 

Не меняя параметров программы, можно приступать к расчёту 

трёхмерной прямой задачи ЭТ. Для этого нужно выбрать пункт меню 
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Calculate→Calculate potential values. В окне программы появится раз-

мер сетки (количество узлов в каждом направлении и общее количе-

ство узлов) и начнётся расчёт, который может занять некоторое 

время в зависимости от размера сетки. После завершения вычисле-

ний появится окно-сообщение, где отобразится информация об 

успешном завершении расчёта и потраченное на это время. Нужно 

нажать кнопку OK. 

 

Рис. 38. Окно редактирования модели Block2D в программе Res3DMod 

 

Рассчитанные данные можно просматривать, извлекать одним 

трёхмерным массивом и попрофильно по сети электродов, которая 

совпадает с заданной в модели. Для просмотра данных необходимо 

воспользоваться пунктом меню Edit/Display→Display apparent resis-

tivity, после чего появится диалоговое окно (Select type of Data to Dis-

play) для задания типа установки, направления и количества отобра-

жаемых разрезов (рис. 39).  

Выберем установку Wenner в поле Array Type. Зададим направле-

ние профилей (измерений) Y-Direction в поле Measurement Direction 

и горизонтальный тип псевдоразрезов Horizontal sections в поле Pseu-

dosection Type. Ниже строка, где указано общее количество разрезов 

Number of sections, под которой можно ввести начальный разрез 

(Enter first section number), количество строк (No of sections per row) 

и количество разрезов для отображения (No of sections to Display). 

Начнём с первого горизонтального псевдоразреза и отобразим их по 
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4 штуки в одной строке. Все вышеперечисленные параметры отобра-

жения данных можно увидеть на рис. 39. 

 

Рис.39. Диалоговое окно программы Res3DMod для настройки отоб-

ражаемых данных 

 

После выставления нужных параметров отображения нужно 

нажать OK или клавишу [Enter]. В результате чего появятся срезы по 

плоскости XY в виде изоом и соответствующая цветовая шкала: в 

нашем случае это четыре среза по глубине, рассчитанных значений 

кажущегося УЭС для заданной модели Block2D.mod (рис. 40). При 

a=1 (примерно 1,5 м для заданной нами установки Wenner) чётко про-

слеживается влияние объекта. Постепенно, с глубиной, высокоомная 

аномалия рассеивается, что отвечает заданной модели. 

Если вернуться к окну для задания типа установки, направления и 

количества отображаемых разрезов через пункт меню 

Edit/Display→Display apparent resistivity (рис. 39), то можно отобра-

зить наши модельные данные в более привычном виде – двумерные 

вертикальные псевдоразрезы (рис. 41): Vertical sections в поле Pseu-

dosection Type. Обычно используют направление X. Кроме того 

нужно учесть, что у нас объект начинается не сразу, как это происхо-

дило на горизонтальных срезах, а только с 10 м по Y. Поэтому в поле 
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начального разреза введём 10, количество строк – 1 и количество раз-

резов для отображения – 3. В результате на экране отобразится три 

разреза кажущегося УЭС в плоскости XZ (рис. 41) с фиксированными 

координатами Y=9, 10, 11 м. Хорошо видно, что с увеличением Y вы-

сокоомная аномалия, связанная с объектом, проявляется всё сильнее. 

Это говорит о том, что влияние объекта усиливается при движении 

измерительных профилей к центру объекта, а картина всё больше 

становится похожа на двумерную (см. рис. 10, 17). 

 

 

Рис. 40. Отображение рассчитанных данных по нескольким глубинам 

в плоскости XY для модели Block2D в программе Res3DMod  

 

 

Рис. 41. Отображение рассчитанных данных для модели Block2D в 

программе Res3DMod. Вертикальные разрезы в плоскости XZ 

 

Просмотр данных в программе Res3DMod используют как пред-

варительный. Анализируют весь массив данных, который можно со-

хранить в формат XYZ, и обработать в удобной программе: Excel, 

Surfer, Voxler. Для экспорта данных нужно воспользоваться пунктом 

меню File→Save results in XYZ format. Появится диалоговое окно, где 

нужно выбрать тип установки и направление измерений (обычно 

вдоль X). После выбора нажать OK и ввести имя, например, 

Block2D.xyz. Данные в файле будут сгруппированы в четыре 
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столбца: первые три – координаты XYZ и четвёртый – ρk. Для удоб-

ства можно открыть или скопировать полученный файл в Excel, от 

фильтровать по требуемой координате или глубине и провести их 

анализ. 

Таким образом, мы разобрали как составлять трёхмерную модель 

с необходимой сетью измерения, рассчитывать, отображать и извле-

кать результаты решения прямой трёхмерной задачи ЭТ в программе 

Res3DMod. 

Рассмотрим пример анализа результатов, по подобию проведён-

ного уже в двумерном случае. Для этого в качестве изменённой среды 

будем рассматривать разобранный пример Block2D.mod, а за началь-

ную модель примем однородное полупространство с сопротивлением 

10 Ом·м (без объекта). Рассчитаем и экспортируем данные для этих 

случаев в файлы Block2D.xyz и HalfSpace10_3D.xyz, выбрав уста-

новку Wenner, чтобы соответствовать двумерным случаям. Затем пе-

ренесём данные в Excel, где каждый из наборов можно отфильтро-

вать по заданному значению координаты Y. Таким образом, мы по-

лучим два набора данных 
нач

k  и 
изм

k  с привязкой по координатам и 

можем их сравнить посредством вычисления относительного откло-

нения rel.dev. 

Напомним, что размерность расчётной сетки 36 х 36 м, а размеры 

объекта от 16 до 19 м по горизонтали в направлении X, от 1 до 2,2 м 

по Z и от 10 до 25 м по Y. Размеры по координате Y в несколько раз 

превышают межэлектродное расстояние, поэтому, если рассмотреть 

профиль вдоль X, проходящий через центр объекта (центр расчётной 

сетки), то влияние объекта будет максимальным, а рассчитанные сиг-

налы, в некотором приближении, будут повторять двумерный случай 

(пп. 4.1, 4.2). Поэтому рассмотрим профиль, проходящий по коорди-

нате Y=18. Оценим, уже по привычной схеме, рассчитанные откло-

нения rel.dev через построение значений ошибки в зависимости от 

координаты X. На построенной диаграмме (рис. 42, синие маркеры) 

видно, что для профиля Y=18 м, относительное отклонение достигает 

6 % в центральной части (15–20 м). Это соответствует примерам, 

разобранным при двумерном моделировании (см. рис. 12, 18).  

Теперь рассмотрим положение профиля на границе объекта (за 1 м 

до края), т. е. наборы данных 
нач

k  и 
изм

k  перед сравнением надо от-

фильтровать по Y=11. Вычислим для этого профиля относительное 
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отклонение и построим диаграмму совместив с уже имеющейся 

(рис. 42, оранжевые маркеры). Значения rel.dev уменьшились до 4 %. 

Это говорит о том, что при точности прибора 5 % метод электрото-

мографии не сможет выявить такой объект, если профиль будет про-

ходить в 1 м от его края. 

 

Рис. 42. Анализ чувствительности метода ЭТ в трёхмерном случае: 

распределение rel.dev по профилю для Y=18 м и Y=11 м 

 

По вычисленным относительным отклонениям мы можем постро-

ить двумерное распределение ошибки для каждого из профилей Y=18 

и Y=11, которые повторяют результат, полученный при одномерном 

отображении ошибки вдоль координаты X (рис. 42). Центральное по-

ложение, профиль Y=18, даёт картину идентичную, полученной при 

двумерном моделировании (рис. 43, а): максимальное значение от-

клонения превышает 5 % (серая изолиния) и относительно точно обо-

значают расположение объекта (фиолетовый пунктир). Однако, при 

положении профиля Y=11, т. е. за один метр до края объекта, макси-

мальное значение относительного отклонения уменьшается до 4 % 

(рис. 43, б). 

Ещё один способ изучения чувствительности метода ЭТ и реше-

ния других методических задач – это использование прямого трёх-

мерного моделирования и последующей двумерной инверсии рассчи-

танных данных. Для этого в программе Res3DMod после расчёта 

можно экспортировать данные в формат Res2DInv с помощью пункта 
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меню File→Save results in Res2DInv format. После чего появится диа-

логовое окно Extract 2-D Profile (рис. 44), где нужно установить не-

обходимые параметры экспорта. 

 

Рис. 43. Анализ чувствительности метода ЭТ в трёхмерном случае: 

двумерное распределение rel.dev по профилю Y=18 м (а) и Y=11 м (б) 

 

В нашем случае, как изображено на рис. 44, в поле Type of profile 

укажем вдоль направления X (Along X direction), в поле Set limits on 

data to save – начальное положение по X = 0 и по Y=18 (11 для второго 

случая), установку Веннера (Wenner) в поле Array Type и в нижнем 

поле параметры установки оставим по умолчанию. 

После настройки всех параметров требуется нажать кнопку ОК и 

ввести имя файла Block2D_18.dat (Block2D_11.dat для второго про-

филя). Теперь можно проводить двумерную инверсию двух получен-

ных наборов данных ЭТ. Для решения обратной задачи ЭТ в двумер-

ной постановке воспользуемся программой ZondRes2D.  

В результате инверсии профиля при Y=18 получен геоэлектриче-

ский разрез в виде изоом кажущегося УЭС, полностью отвечающий 

рассмотренной модели (рис. 45, а): выделяется центральная высоко-

омная аномалия, связанная с прямоугольным в плане объектом (фио-

летовый контур). Для второго профиля (Y=11) характер аномалии не 

изменяется, однако понижается её контраст со вмещающей средой 

(рис. 45, б): максимум восстановленного сопротивление уменьшается 

до 12 вместо 14. 

Таким образом, двумерная инверсия восстанавливает заданный 

при трёхмерном моделировании объект в обоих случаях. Но нельзя 
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забывать, что мы рассматривали идеальный случай (отсутствие шу-

мов и помех). Поэтому мы имеем возможность восстанавливать такие 

небольшие возмущения в сигналах. Однако, первый численный экс-

перимент, где вычислялась относительная ошибка rel.dev показал, 

что при уровне помех в 5 % (в том числе точности прибора) второй 

разрез не восстановится, потому что возмущения, вызванные объек-

том в данных ЭТ будут сравнимы с шумами. Это необходимо пом-

нить при моделировании данных ЭТ и решении методических задач 

путём численных экспериментов, а при возможности вводить помеху 

в синтетические данные. 

 

 

Рис. 44. Диалоговое окно экспорта данных из программы Res3DMod в 

формат Res2DInv 

 

Итак, мы разобрали решение прямой задачи ЭТ для трёхмерного слу-

чая, возможности экспорта и анализа полученных данных посредством 

вычисления относительного отклонения rel.dev и с помощью инверсии 

рассчитанного материала, рассматривая его попрофильно (в виде дву-

мерных разрезов). В настоящее время существуют программы для трёх-

мерной инверсии данных ЭТ, которые можно использовать для инвер-

сии рассчитанного массива данных трёхмерной ЭТ и последующего 

анализа. Одной из них является программа Res3DInv. 
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Рис. 45. Анализ чувствительности метода ЭТ в трёхмерном случае: ре-

шение обратной задачи в программе ZondRes2D для профилей при 

Y=18 м (а) и Y=11 м (б) 

 

5.2. Решение обратной задачи ЭТ в программе Res3DInv 

 

Res3DInv ‒ это ещё одна компьютерная коммерческая программа 

Малазийской компании Geotomo Software [10], которая автоматиче-

ски находит трёхмерную (3D) модель сопротивления среды для дан-

ных, полученных с помощью томографических методик по сети па-

раллельных профилей, с помощью специально изготовленных после-

довательностей измерений или по произвольной системе наблюде-

ний. Другими словами, Res3DInv решает обратную задачу метода ЭТ 

в трёхмерной постановке, с числом электродов до 300000 для профес-

сиональной версии программы и компьютера с оперативной памятью 

256 Гб. Структура трёхмерной модели, используемая программой ин-

версии Res3DInv, схожа с расчётной сеткой в прямой задаче (см. 

рис. 35) и состоит из параллелепипедов. Распределение и размер бло-

ков автоматически генерируются программой. Некоторые параметры 

расчётной сетки можно регулировать, с чем детально можно ознако-

мится в инструкции пользователя [23]. 

В идеале электроды для трёхмерной ЭТ располагаются в виде пря-

моугольной сетки (рис. 46, a,б). Однако на практике, в зависимости 

от имеющегося оборудования, рельефа поверхности, времени съемки 

и бюджета, используются различные виды съемочных процедур. По-

этому в программе Res3DInv поддерживаются следующие конфигу-

рации съёмки: простые прямоугольные – трёхмерное измерение и 
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сеть параллельных двумерных профилей (рис. 46, a,б); непрямо-

угольные (рис. 46, в); наборы данных, собранные из профилей в про-

извольном направлении (рис. 46, г). 

 

Рис. 46. Возможные расстановки электродов для инверсии в про-

грамме Res3DInv 

 

Для трехмерных съемок чаще используются трёх-электродные 

(pole-dipole), двухэлектродные (pole-pole) и дипольные (dipole-dipole) 

установки, потому что они имеют лучшую плотность на краях про-

филей. Существует множество работ [24, 25], в которых даётся до-

статочно полное описание особенностей использования двумерных 

(профильных) измерений для последующей трёхмерной инверсии 

полученных данных ЭТ. Для качественной трёхмерной инверсии по 

сети профилей расстояние между ними не должно превышать двух 

межэлектродных, но существуют и исключения. В любом случае при 

выборе той или иной методики нужно пользоваться априорной ин-

формацией и понимать возможные последствия. 

Для начала работы в программе Res3DInv её нужно установить и 

запустить, в результате чего появится сообщение об ограничениях на 

количество электродов и узлов, приняв которое можно увидеть глав-

ное меню программа (рис. 47). 

Нам понадобится массив данных ЭТ для трёхмерной инверсии. 

Изготовим такие данные в программе Res3DMod. Используем заго-

товку Block2D.mod, изготовленную в прошлом пункте. Рассчитаем 

для данной модели прямую трёхмерную задачу ЭТ 

(Calculate→Calculate potential values) и сохраним полученные значе-

ния с помощью пункта меню File→Save results in Res3DInv format. 
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Появится диалоговое окно, где необходимо выставить нужные пара-

метры (рис. 48). Для нашего случая нужно поменять только тип уста-

новки Веннера (Wenner Inline) в поле Array Type. Остальные поля, 

где можно добавлять шум в данные, настраивать параметры уста-

новки и задавать некоторые другие настройки, мы оставим без изме-

нений. После нажатия кнопки ОК будет предложено ввести имя 

файла в соответствии с используемой моделью – Block2D.dat. Теперь 

эти данные можно использовать в программе Res3DInv для решения 

обратной задачи ЭТ в трёхмерной постановке. 

 

Рис. 47. Главное меню программы Res3DInv 

 

Для загрузки файла Block2D.dat воспользуемся пунктом 

File→Read data file главного меню программы Res3DInv. При успеш-

ном прочтении файла в окне программы отобразится информация о 

данных (размер сетки, межэлектродное расстояние и др.) и появится 

окно-сообщение Reading of data file is complete, где нужно нажать ОК. 

В противном случае появится сообщение, где чаще всего указывается 

возникшая проблема. 

Для начала инверсии нужно выбрать пункт главного меню Inver-

sion→Carry out inversion. В главном окне программы отобразятся па-

раметры инверсии и появится окно с предложением принять данные 

параметры, где нужно согласиться и в следующем диалоговом окне 

ввести имя файла с результатами инверсии Block2D.inv. Начнутся 

вычисления, которые займут некоторое время. После пятой итерации 

(если настройки инверсии не менялись) появится окно с предложе-

нием о продолжении вычислений, где можно ввести количество до-

полнительных итераций. Закончим процесс инверсии, введя 0 и 

нажав ОК. После чего программа сообщит об успешном завершении 

инверсии. 
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Рис. 48. Диалоговое окно экспорта данных из программы Res3DMod в 

формат Res3DInv 

 

Результат инверсии можно просматривать в программе Res3DInv. 

Для этого существует режим для просмотра, печати и экспорта полу-

ченных данных, который активируется с помощью пункта меню 

Display→Display results. Появится окно приветствие и если ранее 

проведённая инверсия была успешна, то в режиме просмотра отобра-

зятся размеры расчётной области, параметры и тип установки, неко-

торые итоги инверсии и окно-сообщение известит об успешном про-

чтении файла: Reading of file completed. При возникновении ошибки 

нужно вернуться в основное окно программы Res3DInv, провести ин-
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версию или в режиме просмотра загрузить готовый результат инвер-

сии через пункт меню File→Read file with inversion results – файл с 

расширением *.inv. Когда результат инверсии загружен, мы можем 

его просматривать, настраивать палитру, изменять масштаб, печатать 

или сохранять результат в растровый формат (*.bmp). В режиме про-

смотра нужно воспользоваться пунктом меню Display→Display 

inversion model. Появится диалоговое окно с настройками отображе-

ния результата – Display model options (рис. 49). В окне ввода номера 

итерации для отображения (Iteration number to display) оставим по-

следнюю, 5-ю итерацию. Ниже можно ввести количество отображае-

мых срезов (Number of sections to display) из возможных 8 – введём 4. 

В поле типа отображения (Display Type) указывается плоскость сре-

зов – оставим отметку горизонтальные срезы (Horizontal Sections), 

что соответствует плоскости XY при фиксированном Z. 

 

Рис. 49. Диалоговое окно с настройками отображения результата ин-

версии в программа Res3DInv 

 

После нажатия ОК или клавиши ввод, нужно в появившемся окне 

выбрать тип отображения изолиний. Так как значения кажущегося 

УЭС лежат в достаточно узком интервале, для корректного отобра-

жения зададим этот интервал, выбрав пункт User defined linear con-

tour intervals. Затем нажмём ОК или клавишу [Enter]. В следующем 

окне выберем Use minimum-maximum range и введём значение 7 в 



89 

окно Enter minimum contour value. Следом будет предложено ввести 

номер начальной глубины (Z) для отображения, где поставим 1 и 

нажмём ОК. 

В результате проведённой настройки отобразятся 4 среза получен-

ной геоэлектрической трёхмерной модели в виде карт изоом кажуще-

гося УЭС на разной глубине (рис. 50). Над каждым из них указан ин-

тервал глубин, которому соответствует этот срез. По вертикали слева 

и горизонтали снизу отложено расстояние по X и Y, а внизу приве-

дена, общая для всех, цветовая шкала значений УЭС. 

 

Рис. 50. Отображение результатов инверсии в программе Res3DInv: 

горизонтальные срезы – плоскость XY 

 

На рис. 50 видно, что основные сопротивления вмещающей среды 

близки к 10 Ом·м, а в центре присутствует более высокоомная ано-

малия, которая выделяется по X от 15 до 20 м, по Y от 10 до 25 м и 

начинает проявляться с самых первых глубин (0–0,5 м). Наибольший 

контраст возникает на четвёртом срезе (глубина 1,74–2,5 м), что в хо-

рошем приближении соответствует исходной модели Block2D.mod, 

используемой при прямом моделировании: во вмещающей среде 

10 Ом·м располагается объект от 16 до 19 м по X, от 10 до 25 м по Y, 

от 1 до 2,2 м по Z, а его сопротивление 15 Ом·м. Если понадобится 

проанализировать другие глубины, то нужно вернуться в окно с 

настройками отображения результата – Display model options через 

пункт меню Display→Display inversion model и отобразить бо́льшее 

количество срезов или выбрать другую начальную глубину. 

Кроме приведённых выше срезов, программа Res3DInv в режиме 

просмотра позволяет отображать трёхмерную модель в более при-

вычном виде – двумерные разрезы по глубине – вертикальные срезы. 

Для этого, находясь в режиме просмотра, вернёмся в окно с настрой-

ками отображения результата – Display model options через пункт 
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меню Display→Display inversion model (рис. 49). Здесь оставим 5-ю 

итерацию (Iteration number to display). В поле типа отображения 

(Display Type) выберем вертикальные срезы (Vertical Sections) в не-

обходимой плоскости – «XZ slice». Максимальное количество срезов 

будет 35 в соответствии с расчётной сеткой и заданными парамет-

рами системы измерения в модели Block2D.mod. Увеличим количе-

ство отображаемых разрезов с 4 до 8 (Number of sections to display). 

После нажатия ОК или клавиши ввод нужно в появившемся окне вы-

брать тип отображения изолиний (например, как при отображении 

горизонтальных срезов). Затем будет предложено ввести начальный 

номер профиля из 35 возможных. Введём 9-ю и нажмём ОК. В ре-

зультате выбранных параметров отобразятся 8 разрезов геоэлектри-

ческой трёхмерной модели (рис. 51) в виде карт изоом кажущегося 

УЭС для разных положений профиля по Y (с 9 по 17-й, из 35 возмож-

ных). Под каждым профилем указан интервал координаты Y, кото-

рому соответствует данный срез. По вертикали и горизонтали отло-

жено расстояние по Z и Y, а внизу приведена, общая для всех срезов, 

цветовая шкала значений кажущихся УЭС. 

 

Рис. 51. Отображение результатов инверсии в программе Res3DInv: 

вертикальные срезы – плоскость XZ 

 

На рис. 51 видно, что высокоомная аномалия выделяется по X от 

16 до 20 м, по Z от 0,5 до 3 м, которая начинает отчётливо проявляться 

на профиле в положении Y между 10 и 11 (рис. 51, Y dist: 10–11 m), а 

максимальный контраст достигается на последнем в данном наборе 

профиле (рис. 51, Y dist: 15–16 m), который проходит практически 

через центр объекта. Для изменения количества и положения профи-

лей нужно вернуться в окно с настройками отображения результата – 

Display model options через пункт меню Display→Display inversion 

model и отобразить бо́льшее количество срезов или выбрать другой 

начальный профиль. В меню Change display setting можно изменить 

масштабирующий фактор, цветовую гамму, выбрать тип заливки. 
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Итак, мы провели инверсию данных ЭТ, рассчитанных в про-

грамме Res3DMod для модели Block2D.mod, и рассмотрели варианты 

послойного отображения результата в разных плоскостях в про-

грамме Res3DInv. Тем не менее, двумерные срезы не всегда дают 

полное понимание полученной трёхмерной модели. Более наглядно 

результат инверсии может быть представлен в специализированных 

программах. В частности, это можно сделать в программе фирмы 

Golden Software – Voxler, которая предназначена для визуализации 

трёхмерных массивов данных. 

Программа Res3DInv позволяет сохранить полученные в резуль-

тате инверсии данные в разные форматы, один из которых предна-

значен для работы в Golden Software Voxler. Для создание такого мас-

сива в режиме просмотра программы Res3DInv (с предварительно за-

груженным результатом инверсии) нужно воспользоваться пунктом 

меню File→Model Export→ Export model to Voxler XYZC format (или 

в более ранних версиях File→ Export model to RockWorks XYZG for-

mat). Возникнет диалоговое окно с настройками сохраняемых дан-

ных, где поменяем только формат вывода значений сопротивления с 

линейного на логарифмический поставив метку (точку) напротив со-

ответствующего пункта – Save logarithm of values. При нажатии 

кнопки ОК появится окно с выбором номера итерации для сохране-

ния (оставляем предложенную по умолчанию последнюю итерацию 

№ 5) и следом возникнет диалоговое окно с предложением сохранить 

файл, название которого определяется в соответствии с используе-

мыми при инверсии данными с некоторой добавкой: 

Block2D_log10_res_voxler.dat. Данные в файле будут сгруппированы 

в пять столбцов: первые три – координаты XYZ, четвёртый – lg(ρk), 

пятый чувствительность, которая нам пока не понадобится. 

Для использования коммерческой программы Voxler нужно её за-

пустить и импортировать полученный набор данных 

Block2D_log10_res_voxler.dat с помощью сочетания клавиш Ctrl+I 

или через пункт меню File→Import. Появившееся диалоговое окно 

позволит выбрать нужный файл после чего будет предложено настро-

ить импорт данных. Наши данные сформированы в соответствующем 

формате, поэтому потребуется принять значения по умолчанию 

нажатием кнопки ОК или клавиши [Enter]. В результате в окне 

Network Manage появится новый объект, название которого иден-

тично импортированному файлу – Block2D_log10_res_voxler.dat. В 
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окне Property Manager можно увидеть и корректировать свойства, в 

том числе выбирать координаты XYZ и компоненты для изображе-

ния. В нашем случае выбор произойдёт автоматически, а нам пона-

добится только убедиться, что координаты соответствуют заданным 

и единственная компонента для изображения – это Log Resistivity. 

Следующим действием нужно сделать активным объект 

, кликнув по нему левой кнопкой мыши и 

связать с ним модуль Gridder с помощью двойного клика левой 

кнопки мыши по соответствующему элементу  в окне 

Module Manager. Связь двух объектов обозначится чёрной линией. 

С помощью модуля  можно формировать грид для даль-

нейшего использования. Для этого его нужно сделать активным, 

кликнув по нему левой кнопкой мыши и в окне Property Manager 

нажать кнопку Begin Gridding. При успешном расчёте кружок напро-

тив модуля станет зелёным. Чтобы визуализировать трёхмерную гео-

электрическую модель, нужно сделать активным объект  

в окне Network Manage, кликнув по нему левой кнопкой мыши и свя-

зать с ним модуль VolRender с помощью двойного клика левой 

кнопки мыши по соответствующему элементу  в окне 

Module Manager. Связь двух объектов обозначится чёрной линией, а 

в окне отображения (по умолчанию левая часть окна программы) по-

явится куб данных, где цвета соответствуют значениям сопротивле-

ний. По умолчанию будет выбрана чёрно-белая палитра. Но сделав 

активным модуль  в окне Property Manager можно вы-

брать и настроить палитру (Colormap) в таблице свойств Rendering. 

Теперь можно работать с визуализированной в Voxler трёхмерной 

геоэлектрической моделью. Установив связь между модулем 

VolRender и Axes по привычной схеме (выбираем объект и кликаем 

дважды на соответствующий элемент  в окне Module Manager) 

появится координатные оси. Модуль  позволяет разрезать 

построенный куб по заданной плоскости. Кроме того можно постро-

ить изоповерхности для определённого значения кажущегося УЭС, с 

помощью модуля  связывая его с объектом Gridder. Ком-

бинация приведённых инструментов программы Voxler позволяет со-

здавать понятные для восприятия (наглядные) представления трёх-

мерной модели. 
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На рис. 52 приведен один из возможных вариантов представления 

геоэлектрической модели, полученной в программе Res3DInv в ре-

зультате трёхмерной инверсии данных Block2D.dat. В данном случае 

из куба вырезана четверть по плоскостям XZ и YZ проходящим через 

центр области. Видно, что в центре находится высокоомная аномалия 

(тёмно-красные оттенки), вызванная объектом, срез которого пред-

ставлен фиолетовыми линиями. На срезах также виден край изопо-

верхности (тёмный контур), соответствующий значению 11,4 Ом·м 

кажущегося УЭС (рис. 52). Не забывайте делать сохранение получен-

ной визуализации после каждого действия в файл формата про-

граммы Voxler – Block2D.voxb. 

 

Рис. 52. Отображение результатов трёхмерной инверсии в программе 

Res3DInv с помощью GS Voxler 

 

Таким образом, в программе GS Voxler, можно наглядно представ-

лять полученные в результате трёхмерной инверсии модели, в част-

ности оценивать на качественном уровне результаты численных экс-

периментов для определения методических рекомендаций. 

В прошлом примере мы использовали готовый набор данных ЭТ, 

сформированный с помощью программы Res3DMod. На практике та-

кие готовые наборы трёхмерной электротомографии, но уже полу-

ченные приборами, всё чаще используются, но ввиду затратности 

трёхмерной электротомографии, чаще используются измерения по 
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серии параллельных двумерных профилей (площадные исследова-

ния), которые можно сформировать в набор данных для трёхмерной 

инверсии. Разберём такой случай, используя уже сделанные ранее 

расчёты. 

Рассмотрим пример площадных исследований по четырём парал-

лельным профилям. Воспользуемся уже имеющимися данными, ко-

торые были сгенерированы ранее в п. 4.1. В качестве первого и чет-

вёртого профиля возьмём набор HalfSpace.dat – полупространство с 

сопротивлением 10 Ом·м. Второй и третий профиль – Block50.dat – 

расчёт для модели, где прямоугольный объект с сопротивлением 

50 Ом·м (от 16 до 19 м, по горизонтали и от 1 до 2,2 м, по вертикали) 

находится в однородном полупространстве с сопротивлением 

10 Ом·м. Для удобства следует переименовать рабочие названия про-

филей: 1.dat и 4.dat – это файл HalfSpace.dat, а 2.dat и 3.dat – 

Block50.dat. 

Напомним, что для моделирования данных HalfSpace.dat и 

Block50.dat была использована установка Веннера (α) с 36 электро-

дами, между электродами 1 м. Поэтому, при формировании трёхмер-

ного набора данных, будем задавать расстояние между профилями 

2 м (два межэлектродных расстояния). Нельзя забывать, что про-

грамма Res3Dinv использует следующую координатную систему – 

первый профиль вверху (на севере), начало профилей – слева. На 

практике важно не перепутать порядок профилей – в файле 1.dat 

должны быть данные с профиля, верхнего на плане местности, а ну-

мерация его электродов должна начинаться слева (рис. 53). Кроме 

того, при обработке полевых измерений нужно использовать факти-

ческие расстояния между профилями, а не формальные 2 м, как в 

нашем примере. 

 

Рис. 53. Расположение профилей в соответствии с системой координат 

программы Res3DInv и нумерация файлов данных 
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Подготовить сводный файл данных из имеющихся четырёх можно 

с помощью программы Res2DInv. Для этого необходимо создать 

папку, в удобном месте и поместить в неё файлы данных 1.dat, 2.dat, 

3.dat, 4.dat. Для простаты создадим папку 3D на диске С в корневом 

каталоге – C:\3-D. Кроме файлов с данными, поместим в созданную 

папку управляющий файл 3D.txt, где необходимо прописать входные 

параметры двумерных данных: количество сшиваемых файлов, их 

расположение и положение в единой системе координат (положение 

первого электрода каждого профиля). Структура управляющего 

файла подробно разобрана в табл. 3. 

Таблица 3 

Описание структуры управляющего файл 3D.txt 

Структура Файла № строки и пояснения 

Conversion of several data files 

in RES2DINV format to one file 

in RES3DINV format 

Заголовок файла 

Number of files to collate Пояснение к следующей строке 

4 Количество сшиваемых файлов 

File 1 parameters  
Начало описания параметров 1-го 

файла 

Name of data file in RES2DINV 

format 
Пояснение к следующей строке 

C:\3-D\1.dat Имя и расположение первого файла 

X and Y location of first elec-

trode along this line 
Пояснение к следующей строке 

0.0,0.0 
Расположение 1-го электрода из 1-го 

файла данных 

Line direction (0=X,1=Y) Пояснение к следующей строке 

0 
0 – Расположение профиля вдоль 

оси X; 1 –вдоль Y 

Line sign (0=positive,1=negative) Пояснение к следующей строке 

0  

Направление данных по профилю: 

0 – положительное направление, 

1 – отрицательное 

File 2 parameters  
Начало описания параметров 2-го 

файла 
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Продолжение табл. 3 

Структура Файла № строки и пояснения 

Name of data file in RES2DINV 

format 

Такие же параметры, как и в слу-

чае с первым файлом. 

Чаще всего меняются только коор-

динаты первого электрода 

C:\3-D\2.dat 

X and Y location of first elec-

trode along this line 

0.0, 2 

Line direction (0=X,1=Y) 

0 

Line sign (0=positive,1=nega-

tive) 

0  

File 3 parameters  
Начало описания параметров 3-го 

файла 

Name of data file in RES2DINV 

format 

Такие же параметры, как и в слу-

чае с первым, вторым файлом. 

Чаще всего меняются только ко-

ординаты первого электрода 

C:\3-D\3.dat 

X and Y location of first elec-

trode along this line 

0.0, 4 

Line direction (0=X,1=Y) 

0 

Line sign (0=positive,1=nega-

tive) 

0  

File 4 parameters  
Начало описания параметров 4-го 

файла 
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Продолжение табл. 3 

Структура Файла № строки и пояснения 

Name of data file in RES2DINV 

format 

Такие же параметры, как и в слу-

чае с первым, вторым файлом. 

Чаще всего меняются только ко-

ординаты первого электрода 

C:\3-D\4.dat 

X and Y location of first elec-

trode along this line 

0.0, 6 

Line direction (0=X,1=Y) 

0 

Line sign (0=positive,1=nega-

tive) 

0  

Name of Output file in 

RES3DINV format 
Пояснение к следующей строке 

C:\3-D\3D.dat 
Имя и расположение выходного 

файла 

End of file Конец управляющего файла 

 

После того как будет сформирован управляющий файл 3D.txt, 

нужно его выбрать в программе Res2Dinv через пункт меню 

File→Collate data into Res3DInv format. В результате чего сформиру-

ется трёхмерный массив данных для программы Res3DInv, который 

появится в указанной папке, в нашем случае C:\3-D\3D.dat. 

Чтобы провести инверсию подготовленного сводного файла, 

нужно запустить программу Res3DInv и действовать по уже извест-

ной схеме. Воспользоваться пунктом File→Read data file для выбора 

файла 3D.dat, запустить инверсию выбрав пункт главного меню 

Inversion→Carry out inversion, согласиться с предложенными пара-

метрами и в следующем диалоговом окне ввести имя файла с резуль-

татами инверсии 3D.inv. Начнутся вычисления, которые займут не-

которое время. После этого появится окно с предложением о продол-

жении вычислений, где можно ввести количество дополнительных 

итераций. Закончим процесс инверсии, введя 0 и нажав ОК. После 

чего программа сообщит об успешном завершении инверсии. 

После окончания инверсии, для просмотра результатов обраща-

емся к меню Display → Display results и попадаем в режим просмотра 

(Display Window), работа в котором была описана выше. Здесь нужно 
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воспользоваться пунктом меню Display→Display inversion model. По-

явится диалоговое окно с настройками отображения результата – 

Display model options (см. рис. 49), где выберем последнюю итерацию 

и три разреза модели. Последовательно отображая горизонтальный 

(YX) и вертикальный (XZ) тип среза, можно проанализировать полу-

ченную геоэлектрическую модель (рис. 54). На горизонтальных сре-

зах проявляется высокоомная аномалия от 15 до 20 м по X и от 2,5 до 

3,5 м по Y, на вертикальных – от 14 до 21 по X и от 0,5 до 2,5 м по Z. 

Восстановленная трёхмерная аномалия с некоторой допустимой по-

грешностью соответствует заданному при прямом моделировании 

объекту – от 16 до 19 м – по горизонтали и от 1 до 2,2 м –по вертикали 

(модель Block50.mod). Что касается размеров по оси Y, то они тоже 

отвечают исходным данным: объект присутствует только на двух 

центральных профилях (2.dat и 3.dat), а по краям (1.dat и 4.dat) у нас 

задано однородное полупространство с сопротивлением 10 Ом·м. 

 

 

Рис. 54. Отображение результатов трёхмерной инверсии в программе 

Res3DInv: срезы по плоскости XY (сверху) и XZ (снизу) 

 

Как уже говорилось, более наглядно результат инверсии может 

быть представлен в специализированных программах фирмы Golden 

Software – Surfer и Voxler. Для экспорта данных в GS Voxler в режиме 

просмотра программы Res3DInv (с предварительно загруженным ре-

зультатом инверсии) нужно воспользоваться пунктом меню 

File→Model Export→ Export model to Voxler XYZC format (или в бо-

лее ранних версиях File→ Export model to RockWorks XYZG format) 

и сохранить полученную модель в файл 3D_res_voxler.dat. Данные в 

файле будут сгруппированы в пять столбцов: первые три – коорди-

наты XYZ, четвёртый – lg(ρk), пятый чувствительность. Такой фор-

мат данных может сразу использоваться для визуализации трёхмер-

ной модели в Voxler. 

 



99 

Выше уже приводилось краткое описание работы в Voxler. Нужно 

импортировать полученный набор данных 3D_res_voxler.dat и свя-

зать с ним модуль Gridder. Чтобы визуализировать трёхмерную гео-

электрическую модель, необходимо воспользоваться модулями 

VolRender, Axes, ClipPlane, Isosurface. Комбинируя инструменты 

программы Voxler можно получать удобные для восприятия виды 

трёхмерных геоэлектрических моделей и анализировать полученные 

в результате инверсии данные. 

На рис. 55 приведен один из возможных вариантов представления 

геоэлектрической модели, полученной в программе Res3DInv в ре-

зультате трёхмерной инверсии данных 3D_res_voxler.dat. В данном 

случае из куба вырезана четверть по плоскостям XZ и YZ проходя-

щим через центр области. Сохраним полученную визуализации в 

файл 3D_res_voxler.voxb. 

 

Рис. 55. Отображение результатов трёхмерной инверсии в программе 

Res3DInv с помощью GS Voxler 

 

Видно, что в центре находится высокоомная аномалия (тёмно-

красные оттенки), вызванная объектом, контур которого представлен 

фиолетовыми линиями. Как и в случае двумерных срезов, трёхмерная 

аномалия проявляется от 15 до 20 м по X и от 2,5 до 3,5 м по Y и от 

0,5 до 2,5 м по Z, что соответствует исходной модели. 

Трёхмерное представление позволяет лучше анализировать полу-

ченную геоэлектрическую модель геофизику-интерпретатору, од-

нако при написании отчётов и представлении результатов на бумаге 
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чаще применяют двумерные срезы. В Res3DInv такая возможность 

существует и уже была разобрана, но программа ограничивается 

стандартными параметрами и не всегда можно отобразить интересу-

ющий срез. Поэтому для отображения двумерных разрезов зачастую 

используют экспортированные данные и программный продукт GS 

Surfer. 

Существует как минимум два способа построить двумерный раз-

рез. Если экспортированные для Voxler данные вставить в Excel, то 

их можно будет отфильтровать по нужной глубине или координате. 

Для этого откроем файл 3D_res_voxler.dat в Excel или скопируем его 

содержимое в лист, назвав его AllData. Данные с этого листа, как и 

сам файл 3D_res_voxler.dat, можно использовать для построения 

трёхмерной модели в Voxler по описанной выше схеме. Теперь дан-

ные можно отфильтровать по одной глубине (или координате) и ско-

пировать его в новый лист, присвоив ему имя глубины, например, 

h0.25m или h1.4m (рис. 56). 

 

Рис. 56. Фрагмент книги Excel с примером фильтрации результата 

трёхмерной инверсии данных ЭТ по разным глубинам для построения 

двумерных срезов 

 

Теперь можно использовать Surfer для построения карт распределе-

ния УЭС по разным глубинам, выбрав соответствующий лист при со-

здании грида. Построим срез на глубине 1,4 м – лист h1.4m (рис. 57, а). 

На срезе видно аномалию повышенного сопротивления от 15 до 

20 м – по X и от 2 до 4 м – по Y. В нашем примере ситуация симмет-

ричная, однако для более сложных моделей и тем более при обра-

ботке реальных данных нельзя забывать, что направление осей коор-

динат в Res3DInv отличается от привычного направления осей. По-

этому это нужно учитывать при построениях в Surfer, выбирая соот-

ветствующую колонку или разворачивая оси. 
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Такие же карты можно построить, используя уже созданную в 

Voxler визуализацию трёхмерной модели, в нашем случае – это 

3D_res_voxler.voxb. Загрузив этот файл в Voxler, нужно нажать пра-

вой кнопкой мыши на модуль  и в всплывающем списке 

выбрать пункт Save Data. Появится диалоговое окно, где нужно вы-

брать тип файлов (GRD Surfer 7 Binary Grid (*.grd)), указать папку 

для сохранения и нажать сохранить (или клавишу [Enter]). В следую-

щем окне можно настроить количество срезов (ввести номер первого 

и последнего), количество пропусков и задать имена файлов. Мы 

оставим значения по умолчанию: номер первого среза 1, последнего – 

50, пропусков – 0 и файлы Gridder##.grd, где ## – это номер соответ-

ствующего среза. В результате сохранится 50 гридов. Gridder01.grd 

соответствует максимальной глубине модели – 6,1984 м, а 

Gridder50.grd – 0 м. Все остальные распределены между ними с рав-

номерным арифметическим шагом. 

 

Рис. 57. Двумерное распределение результата трёхмерной инверсии 

данных ЭТ на разных глубинах построенные c использованием MS 

Excel (а) и GS Voxler (б) 

 

Построим глубину, примерно равную 1,4 м, чтобы сравнить со сре-

зом, полученным в результате использования MS Excel (рис. 57, а). 

Этой глубине, точнее 1,39 м, будет соответствовать файл Gridder39.grd. 

Используем этот грид для построения контурной карты в Surfer. В ре-

зультате можно получить разрез (рис. 57, б), который идентичен пер-

вому (рис. 57, а). Небольшие отличия могут быть вызваны разными 

подходами в сглаживании (интерполяции) при создании гридов. 
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Приведённые способы визуализации данных, полученных в ре-

зультате трёхмерной инверсии, легки для восприятия и показательны 

для понимания структуры данных и работы с ними. Попробуем закре-

пить полученные знания о моделировании данных трёхмерной ЭТ на 

некоторых примерах рудных месторождений, которые уже приводи-

лись при разборе программ двумерного моделирования данных ЭТ. 

 

5.3. Моделирование рудоконтролирующего разлома 

 

Для моделирования трёхмерных данных ЭТ над моделью ру-

доконтролирующего разлома воспользуемся программой Res3DMod, 

где, пользуясь табл. 2 из п. 5.1, создадим соответствующую модель 

Fault3D.mod (рис. 58) – разломная зона начинается при Z=7,5 м и про-

должается на всю глубину, распространяется от края, сужаясь к цен-

тру расчётной сетки в направлении Y, как это показано на рис. 58. 

Расчётная сетка состоит из 36 электродов по X и по Y, между каждой 

парой электродов расстояние 5 м и один дополнительный узел сетки. 

В вертикальном направлении зададим автоматическое разбиение. 

Значения УЭС соответствуют двумерной геоэлектрической модели, 

приведённой в п. 4.5.1. 

Используя созданную модель рассчитаем в программе Res3DMod 

значения кажущегося УЭС (Calculate→Calculate potential values), ко-

торые можно отобразить (рис. 59) и экспортировать для дальнейшей 

инверсии через пункты меню Edit/Display→Display apparent resistivity 

и File→Save results in Res3DInv format, соответственно. Данные бу-

дем сохранять для осевой дипольной установки и введём шум уровня 

5 %, введя при настройке экспорта в окно «Enter percentage noise to 

add» значение 5. Назовём набор данных Fault3D_Noise5.dat. 

Полученный в результате решения прямой задачи набор данных 

Fault3D_Noise5.dat будем использовать для инверсии в программе 

Res3DInv (Inversion→Carry out inversion). Результат инверсии сохра-

ним для визуализации в программе Voxler (File→Model Export→ 

Export model to Voxler XYZC format) в файл 

Fault_Noise5_log10_res_voxler.dat. В результате, используя инстру-

менты программы Voxler, можно отобразить полученный набор дан-

ных и убедиться, что разломная зона, чётка выделяется в виде пони-

женных значений сопротивления (рис. 60). 
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Рис. 58. Трёхмерная модель рудоконтролирующего разлома в про-

грамме Res3DMod 

 

 

Рис. 59. Рассчитанные значения кажущихся УЭС над трёхмерной мо-

делью рудоконтролирующего разлома для осевой дипольной установки  

 

Таким образом, рудные месторождения, приуроченные к разлом-

ным зонам, выделяются методом трёхмерной электротомографии. 

Применение трёхмерной методики ЭТ и последующего анализа ре-

зультата инверсии в Voxler даёт более наглядное представление о 

строении месторождения по сравнению с двумерными разрезами. Не-
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редко на практике геоэлектрические разрезы, полученные в резуль-

тате 2-D инверсии, с трудом поддаются интерпретации, а в некото-

рых случаях объект поисков не проявляется вовсе. Как правило, по-

сле трёхмерной инверсии, модель среды генерализируется и в ней 

проявляются основные структурные элементы и объект поисков. 

Следующая модель – дайка – может быть получена с помощью неко-

торой модификации прошлой. Разберём это ниже. 

 

Рис. 60. Результат инверсии данных ЭТ, рассчитанных над трёхмер-

ной моделью рудоконтролирующего разлома для осевой дипольной уста-

новки 

 

5.4. Моделирование дайки 

 

Для моделирования трёхмерных данных ЭТ над моделью дайки 

воспользуемся программой Res3DMod, где создадим соответствую-

щую модель Dayka3D.mod (рис. 61), пользуясь табл. 2 из п. 5.1. Раз-

меры и ориентацию разломной зоны возьмём из прошлого примера 

(модель Fault3D.mod): начинается при Z=7,5 м и продолжается на 

всю глубину, распространяется от края, сужаясь к центру расчётной 

сетки в направлении Y. В описанный разлом добавим, ориентирован-

ную вдоль него, дайку с максимальной шириной 10 м, как это пока-

зано на рис. 61. Расчётная сетка состоит из 36 электродов по X и по 
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Y, между каждой парой электродов расстояние 5 м и один дополни-

тельный узел сетки. В вертикальном направлении зададим автомати-

ческое разбиение. Значения УЭС соответствуют двумерной модели, 

приведённой в п. 4.5.2. 

 

Рис. 61. Трёхмерная модель дайки в программе Res3DMod 

 

Используя созданную модель рассчитаем в программе Res3DMod 

значения кажущегося УЭС (Calculate→Calculate potential values), ко-

торые можно просмотреть и экспортировать для дальнейшей инвер-

сии через пункт меню File→Save results in Res3DInv format. Данные 

будем сохранять для осевой дипольной установки без шума. Назовём 

файл Dayka3D.dat. 

Полученный в результате решения прямой задачи набор данных 

Dayka3D.dat будем использовать для инверсии в программе Res3DInv 

(Inversion→Carry out inversion). Результат инверсии сохраним для ви-

зуализации в программе Voxler (File→Model Export→ Export model 

to Voxler XYZC format) в файл Dayka3D _log10_res_voxler.dat. Ис-

пользуя инструменты программы Voxler, можно отобразить получен-

ную в результате инверсии модель и убедиться, что, как и в прошлом 

примере, разломная зона выделяется в виде пониженных значений 

сопротивления (рис. 62). Помимо самой разломной зоны, внутри неё 

можно заметить объект, имеющий повышенные значения сопротив-

лений – это дайка (рис. 62). 
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Опираясь на проведённое моделирование трёхмерных данных ЭТ, 

констатируем, что рассмотренные модели рудных месторождений 

при заданных параметрах хорошо дифференцируются методом элек-

тротомографии. Поэтому применение данной модификации метода 

сопротивлений чаще всего приводит к положительному результату 

при разведке и исследовании месторождений такого типа. 

 

Рис. 62. Результат инверсии данных, рассчитанных над трёхмерной 

моделью дайки для осевой дипольной установки 

 

Приведённые выше модели – идеализированные, а созданные син-

тетические данные, хоть и имеют некоторые шум, тем не менее явля-

ются модельными. В реальной ситуации данные осложнены поме-

хами, а иногда точки зондирования отсутствуют (или отбраковыва-

ются) совсем. Поэтому получить такие выразительные геоэлектриче-

ские модели далеко не всегда представляется возможным. Чтобы по-

нимать, насколько реальная ситуация отличается от модельной, рас-

смотрим программы для обработки реальных данных ЭТ и разберём 

примеры первичной обработки и инверсии полевого материала. 
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6. ОБРАБОТКА ПОЛЕВЫХ ДАННЫХ ПОЛУЧЕННЫХ  

С ПОМОЩЬЮ МЕТОДА ЭЛЕКТРОТОМОГРАФИИ 

 

6.1. Обработка данных 2-D электротомографии,  

       полученных на россыпном месторождении золота 

 

Все данные, которые были использованы выше являются синтети-

ческими, рассчитанными в программах для прямого моделирования 

сигналов электротомографии (2D или 3D). Стоит сказать, что при ин-

версии таких данных не возникает проблем с шумами и помехами, 

хотя для чистоты эксперимента эти параметры обычно вводятся. При 

обработке реальных полевых измерений прежде всего необходимо 

проанализировать полученный материал и провести первичную об-

работку (чистку). Такую процедуру можно сделать непосредственно 

в программах для решения обратной задачи ЭТ (например, в 

Res2DInv [15, 16]), но чаще используются специализированные про-

граммы, поставляемые вместе с аппаратурой для измерения методом 

ЭТ. Одной из таких программ является SiberTools. 

Программа SiberTools предназначена для первичной обработки 

данных ЭТ и обычных ВЭЗ – фильтрации, компоновки и экспорта в 

распространённые форматы (IPI2Win, Res2dInv). Также она позво-

ляет создавать и редактировать протоколы измерений (последователь-

ности включения и опроса электродов при измерениях) как для электро-

томографии, так и для традиционных одномерных зондирований (ВЭЗ). 

Данная разработка создавалась специально для многоэлектродных элек-

троразведочных станций Скала-48 (совместная разработка ООО КБ 

«Электрометрии» и ИНГГ СО РАН) и находится в свободном доступе в 

сети Internet (URL: https://nemfis.ru/soft/setup_2013.03.01_SibER.rar). 

Здесь же можно скачать инструкцию по эксплуатации прибора [26], 

где содержится краткое описание работы с программой. 

Работа с шаблонами в программе SiberTools описана в учебном 

пособии [16]. Там же в подробностях описана первичная обработка, 

главные моменты которой разберём ниже. 

Для начала работы в программе её нужно скачать и запустить 

(установка не требуется). В качестве примера будем использовать 

файл Kamchatka_Shl_Single.d2d, полученный прибором Скала-48 на 

одном из россыпных месторождений золота полуострова Камчатка, 

где решалась задача определения мощности рыхлых отложений. Для 
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измерений использовалась установка Шлюмберже, что отражено в 

названии файла данных. При открытии данных через пункт меню 

File→Open или используя сочетание клавиш Ctrl+O в дереве объек-

тов появится новый объект Data 2D#пп и его свойства ниже, также 

отобразится информация об измерениях, а в поле графики – псевдо-

разрез кажущегося УЭС (рис. 63, а). По этой информации тяжело оце-

нить качество данных (хотя в некоторых случаях большие выбросы 

на разрезе видно). Для первичной обработки используют режимы 

отображения данных AllSounding Curves и All Profile Curves. 

Для отображения всех кривых зондирования в поле Visible 

Diagrams нужно выбрать All Sounding Curves. После этого, вместо 

разреза появится множество измеренных значений УЭС в зависимо-

сти от разноса / псевдоглубины (рис. 63, в). Это облако кривых чаще 

всего отвечает некоторому тренду (или нескольким трендам), а вы-

бивающиеся из него измерения считаются некондиционными (брако-

ванными, выбросами) и удаляются. В нашем случае видно, что боль-

шинство данных имеет схожее поведение (один тренд). Выделяется 

только одна точка (рис. 63, в). Удаление таких бракованных измере-

ний можно осуществлять единичными кликами левой кнопкой мыши 

по отдельным точкам или, нажав Ctrl+Shift, непрерывно указывать 

точки (без нажатия клавиш мыши), которые следует отфильтровать. 

Такие же действия можно проводить в режиме отображения всех 

профильных кривых Visible Diagrams = All Profile Curves (рис. 63, д). 

Значения сопротивлений по уровням чаще всего должны изменяться 

плавно, а соседние уровни – иметь схожее поведение графиков (корре-

лировать). Выброс, замеченный, на кривых зондирования (рис. 63, в) 

выделяется и здесь (рис. 63, д, овал). Кликая левой кнопкой мыши 

или наводя курсор при нажатых Ctrl+Shift, эту точку можно отфиль-

тровать. 

Помимо ручного редактирования в некоторых случаях удобна ав-

томатическая фильтрация по заданным пределам того или иного па-

раметра. Это можно сделать, задав границы (Min и Max) в реестре 

свойств в подразделе Bound Filter: Quality Filter – фильтр по макси-

мальной ошибки, Voltage Filter – по заданным пределам входящего 

напряжения, Current Filter – по заданным границам подаваемого тока, 

Resistivity Filter – по значениям УЭС. 
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Рис. 63. Просмотр и редактирование данных в программе SiberTools в разных 

режимах: Pseudodepth (а, б); AllSounding Curves (в, г) и All Profile Curves (д, е) 

 

Не стоит забывать, что основной принцип ЭТ – это непрерывность 

измерений. А профили чаще всего состоят из нескольких раскладок 

(последовательных переносов кос). В таких случаях для экономии 

времени используются нагоняющие (roll along) измерения. Получен-

ные таким образом данные необходимо соединить. Эта возможность 

также реализована в программе SiberTools. 
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Разберём объединение данных в единый профиль в программе 

SiberTools. Для этого сначала загрузим данные, полученные на пер-

вой раскладке профиля, чаще всего стандартные полные (протокол 

Single) измерения. В нашем случае это уже рассмотренный выше 

файл Kamchatka_Shl_Single.d2d. Теперь мы можем присоединить к 

загруженным данным следующий участок профиля. Это можно сде-

лать с помощью пункта меню File→Append или нажав сочетание кла-

виш Ctrl+A. Появится диалоговое окно, где нужно выбрать присоеди-

няемый файл Kamchatka_Shl_Roll.d2d. В результате два набора объ-

единятся, а в поле графики отобразится псевдоразрез длиной 355 м, 

вместо 235 м (рис. 63, б). Такой размер профиля получается при непре-

рывном измерении методом ЭТ с межэлектродным расстоянием 5 м и 

одним переносом первой косы. Присоединять файлы нужно в правиль-

ной последовательности, соответствующей реальным положениям 

сегментов разреза. Таким же образом можно соединять вместе файлы 

с измерениями прямой и обратной трёхэлектродной установкой. 

Объединённые в один профиль данные также можно отфильтро-

вать, если это не было сделано для отдельных частей. В нашем случае 

в режиме отображения всех кривых зондирования (рис. 63, г) наблю-

дается несколько выбросов, которые легко определяются и на про-

фильных кривых (рис. 63, е, овалы). Данные чистые и лежат в узком 

диапазоне сопротивлений (имеется тренд). Удалим два бракованные 

значения, кликая левой кнопкой мыши или наводя курсор на них при 

нажатых Ctrl+Shift. Отредактированные и объединённые данные 

необходимо проинтерпретировать. Для этого экспортируем их в фор-

мат *.dat с помощью пункта меню File→Export или нажав сочетание 

клавиш Ctrl+E. После этого появится диалоговое окно, где нужно вы-

брать тип данных *.dat и ввести имя создаваемого файла – 

Kamchatka_Shl.dat. Полученный набор имеет структуру, пригодную 

для инверсии в различных программах, в том числе Res2DInv и 

ZondRes2D. 

Нельзя забывать, что полевые работы проводятся по пересечённой 

местности, где на одном профиле может сильно изменяться рельеф 

поверхности, о котором мы ранее не упоминали и не учитывали. Но 

теперь, при интерпретации реального материала, игнорирование ре-

льефа может привести к неверному истолкованию измерений. По-

этому при инверсии полевых данных ЭТ, зачастую приходится учи-

тывать топографию профиля. К сожалению, программа SiberTools 
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при экспорте не позволяет вводить рельеф в данные. Но это можно 

сделать в любом текстовом редакторе. 

Введём рельеф в данные Kamchatka_Shl.dat. Для этого откроем их 

в текстовом редакторе (например, Блокнот) и перейдём в конец 

файла. Добавим строки с информацией о топографии из первого 

столбца табл. 4, где описана структура, которой нужно придержи-

ваться. Как уже говорилось, вставить данные о рельефе нужно в 

конце файла с данными ЭТ, сразу после окончания описания уста-

новки (положения электродов) и соответствующих значений кажу-

щегося сопротивления. 

Таблица 4 

Описание структуры топографии в файле данных ЭТ *.dat 

Структура Пояснения 

Topography Вспомогательная строка, указывающая на 

начало топографии 

1 

Тип задания горизонтальных координат точек 

измерения, соответствует заданному в начале 

*.dat файла параметру (строка после количе-

ства измерений) 

10 Количество заданных точек топографии 

0 273,5 

40 276,3 

80 280 

120 283,6 

160 287,7 

200 290,9 

240 295,2 

280 299,6 

320 303,2 

355 307,1 

Горизонтальная координата точки на профиле 

и соответствующая альтитуда (или относи-

тельное превышение – высота) 

1 
Номер точки рельефа, совпадающий с первым 

электродом 

0, 0, 0, 0 Четыре нуля как признак конца файла 

 

Если рельеф изменяется равномерно, то не обязательно измерять 

и указывать высоту каждого электрода. В нашем случае альтитуда 
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постепенно увеличивается по профилю, поэтому, без ущерба каче-

ству инверсии, при использовании в данных 72 электродов вводятся 

только 10 точек высот (максимум 500). После последней точки с то-

пографией вводится номер точки рельефа, в которой расположен пер-

вый электрод, причём высотная отметка первого электрода вводится 

в обязательном порядке. Чаще всего (как и в нашем случае) первая 

точка рельефа совпадает с первым электродом. Модернизированный 

набор данных пригодный для инверсии с учётом рельефа сохраним 

под названием Kamchatka_Shl_topo.dat. К инверсии данных мы вер-

нёмся позже, а пока рассмотрим ещё одну программы для первичной 

обработки данных – RiPPP. 

Программа RiPPP предназначена для первичной обработки дан-

ных ЭТ (УЭС и ВП) – фильтрации, компоновки и экспорта в распро-

странённые форматы (IPI2Win, Res2dInv, ERTLab). Данная разра-

ботка создавалась для многоэлектродных электроразведочных стан-

ций Скала-48, Скала-64 (совместная разработка ООО КБ «Электро-

метрии» и ИНГГ СО РАН) и находится в свободном доступе в сети 

Internet (URL: https://nemfis.ru/soft/RiPPP_1.12.zip). В архиве содер-

жится краткое описание работы с программой. Принципы первичной 

обработки данных в программе RiPPP идентичны уже разобранной 

программе SiberTools. Но небольшие отличия присутствуют. 

Для начала работы в программе её нужно скачать и запустить 

(установка не требуется). В качестве примера будем использовать 

файлы Kamchatka_DD_Single.d2d, Kamchatka_DD_Roll.d2d, получен-

ные прибором Скала-48 на упомянутом выше россыпном месторож-

дении золота полуострова Камчатка. Измерения проходили на том же 

профиле, но при измерениях использовалась другая установка – осе-

вая дипольная.  

Запустим программу RiPPP и откроем данные через пункт меню Про-

ект→Загрузить файлы данных УЭС и ВП, выбрав оба файла. В результате 

возникнет таблица, где указаны названия файлов, используемая уста-

новка, количество электродов, межэлектродный интервал, количество из-

мерений (отсчётов) и горизонтальное положение. Последний столбец 

нужно изменить в соответствии с положением первого электрода каждого 

из загружаемых измерений: для Kamchatka_DD_Single – это 0, а для 

Kamchatka_DD_Roll – это 120 – нагоняющее измерение со смещением на 

одну косу (120 м). После нажатия клавиши [Enter] или кнопки OK, окна 

программы заполнятся (рис. 64). 
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Рис. 64. Просмотр и редактирование данных в программе RiPPP в раз-

ных режимах: кривые зондирований (а); профильные диаграммы (б) и 

разрез (в) 

 

В поле «Данные» (слева) отобразится список загруженных файлов 

или файл топографии в соответствии с выбранной вкладкой. Ниже 

параметры активных (подсвеченных оранжевым цветом) данных 

(Прибор, Установка и т. д.), где можно поменять горизонтальное по-

ложение каждого измерения. 
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В центральном окне программы отображаются данные в зависи-

мости от выбранной вкладки: таблицы, кривые зондирований 

(рис. 64, а); профильные диаграммы (рис. 64, б) и разрез (рис. 64, в). 

Причём данные уже будут объедены в один профиль в соответствии 

с введёнными горизонтальными положениями. 

Отбраковка данных происходит по описанным при разборе про-

граммы SiberTools принципам. Только чистка делается с помощью 

оконтуривания некачественных измерений полигонами (многоуголь-

никами), которые создаются последовательными кликами левой 

кнопкой мыши. При замыкании таких контуров внутри выделенной 

области точки зондирования выключаются. В нашем случае нужно 

очистить данные выделенные красными овалами на рис. 64, а,б. Для 

удобства, при отбраковке, можно масштабировать или перемещать 

графики и разрезы вращая или зажимая колесо мыши. 

Одним из преимуществ программы RiPPP, по сравнению с 

SiberTools, является возможность введение рельефа в редактируемые 

данные. Для этого нужно подготовить текстовый файл с расшире-

нием *.top, где содержится два столбца: горизонтальная координата 

точки на профиле и соответствующая альтитуда или высота. Созда-

дим такой файл, скопировав 10 строк из табл. 4, начиная с четвёртой 

и назовём его Kamchatka.top. Теперь нужно загрузить этот файл через 

пункт меню Проект→Загрузить файлы данных топографии. В ре-

зультате на вкладке «Разрез» основного окна программы можно уви-

деть двумерное распределение значений кажущего УЭС уже с учётом 

рельефа, где обозначено линейное приближение рельефа, а точками 

загруженные из файла горизонтальные координаты на профиле и со-

ответствующие высоты (рис. 64, в). 

На любом из этапов первичной обработки или после введения ре-

льефа нужно сохранить проект через пункт меню Проект→Сохра-

нить проект или используя горячие клавиши Ctrl+S. Назовём файл 

Kamchatka_DD.ppp. Теперь, окончательный вариант обработанных 

данных можно экспортировать для дальнейшей инверсии в програм-

мах Res2DInv. Это можно сделать через пункт меню Проект→Экс-

портировать проект. В появившемся диалоговом окне выберем тип 

файла «Файлы данных Res2DInv(*.dat)» и введём название, напри-

мер, Kamchatka_DD.dat. В файл данных автоматически запишется 

информация о рельефе.  
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Таким образом, мы имеем два набора обработанных данных, по-

лученных методом электротомографии на одном из россыпных ме-

сторождений полуострова Камчатка. Данные получены по одному и 

тому же профилю, но разными установками. Kamchatka_Shl.dat – 

установка Шлюмберже, Kamchatka_DD.dat – осевая дипольная уста-

новка. 

Полученные наборы данных будем использовать для решения об-

ратной задачи в программе Res2DInv по схеме, описанной в п. 4.3. 

Нельзя забывать, что в данных присутствует рельеф. И после инвер-

сии нужно сохранить полученный результат для построения в про-

грамме Surfer с учётом рельефа. Для этого в режиме просмотра про-

граммы Res2DInv (Display→Show inversion results) при сохранении 

(File→Save data in Surfer format) в диалоговом окне Saving inversion 

results in Surfer format нужно поставить галочку напротив пункта 

Model resistivity with topography. Получим несколько файлов, в том 

числе Kamchatka_Shl_modres.dat и Kamchatka_DD_modres.dat для 

установки Шлюмберже и осевая дипольная, соответственно. Исполь-

зуя их, в программе Surfer можно создать гриды и построить геоэлек-

трические разрезы в виде изоом (рис. 65). 

 

Рис. 65. Результат инверсии полевых данных, полученных прибором 

Скала-48 на одном из россыпных месторождений золота полуострова 

Камчатка: а – установка Шлюмберже; б – осевая дипольная 

 

Проанализируем полученные разрезы с точки зрения поставлен-

ной задачи – определить мощность рыхлых отложений на месторож-

дении. В результате визуального сравнения построенных разрезов 
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можно сказать, что в обоих случаях задача решена: мощность отло-

жений отслеживается в виде проводящей зоны (рис. 65, оттенки си-

него) и увеличивается от 4 м, в начале профиля, до 15 м, в конце. 

Можно отметить, что при использовании осевой дипольной уста-

новки (рис. 65, б) глубинность уменьшается по сравнению с измере-

ниями установкой Шлюмберже (рис. 65, а), но при этом детальность 

разреза улучшается.  

Таким образом, мы разобрали практически полный цикл обра-

ботки данных двумерной ЭТ полученных аппаратурой Скала-48 (за 

исключением геологической интерпретации). На первом этапе это 

просмотр, объединение, первичная обработка данных ЭТ, в том числе 

учёт рельефа, в специализированных программах, например, 

SiberTools или RiPPP. На втором этапе – инверсия обработанных дан-

ных и анализ полученных результатов. Стоит сказать, что на третьем 

этапе проводится геологическая интерпретация, после чего делается 

заключение о качестве измерений и проведённой обработки. При не-

совпадении полученных геоэлектрических моделей с априорной гео-

логической информацией цикл обработки данных повторяется. Ана-

логичным образом проводится обработка данных трёхмерной элек-

тротомографии. 

 

6.2. Трёхмерная инверсия данных электротомографии  

       и построение карт распределения УЭС на разных глубинах 

 

Разберём трёхмерную инверсию данных, полученных на упомяну-

том выше россыпном месторождении золота полуострова Камчатка, 

по семи параллельным профилям длиной 355 м, расположенным на 

расстоянии 50 м друг от друга. Стоит сказать, что такие расстояния 

между профилями допустимы только при априори слабо меняю-

щемся разрезе и при решении определённых задач. В данном случае 

это структурная задача по определению мощности рыхлых отложе-

ний, поэтому такая методика трёхмерной электротомографии допу-

стима. Измерения проводились прибором Скала-48. Использовалась 

установка Шлюмберже с межэлектродным расстоянием 5 м. Первич-

ную обработку мы разбирали в прошлом разделе, поэтому этот этап 

опустим и начнём работу с уже подготовленными для инверсии набо-

рами данных: файлы 1.dat-7.dat. 
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Подготовить сводный файл данных пригодный для трёхмерной 

инверсии в программе Res3DInv из имеющихся семи можно с помо-

щью программы Res2DInv, как это описано в п. 5.2. Для этого нужно 

создать папку в удобном месте, куда поместить все семь файлов с 

данными и там же создать управляющий файл 3D_Kamchatka.txt 

(см. п.5.2, табл. 3), где необходимо прописать входные параметры 

двумерных данных с учётом того, что профили параллельны и рас-

стояние между ними 50 м, а результирующий файл назовём 

3D_Kamchatka.dat. После того как будет сформирован управляющий 

файл 3D_Kamchatka.txt, нужно его выбрать в программе Res2Dinv че-

рез пункт меню File→Collate data into Res3DInv format. В результате 

будет сформирован файл данных трёхмерной электротомографии 

3D_Kamchatka.dat для программы Res3DInv, который появится в ука-

занной в управляющем файле папке. 

Чтобы провести инверсию подготовленного сводного файла 

нужно в программе Res3DInv воспользоваться пунктом File→Read 

data file для выбора файла 3D_Kamchatka.dat, запустить инверсию вы-

брав пункт главного меню Inversion→Carry out inversion, согласиться 

с предложенными параметрами и в следующем диалоговом окне вве-

сти имя файла с результатами инверсии 3D_Kamchatka.inv. Начнутся 

вычисления, которые займут некоторое время. После этого появится 

окно с предложением о продолжении вычислений, где можно ввести 

количество дополнительных итераций. Закончим процесс инверсии, 

введя 0 и нажав ОК. После чего программа сообщит об успешном за-

вершении инверсии. 

После окончания инверсии, для просмотра результатов обраща-

емся к меню Display → Display results и попадаем в режим просмотра 

(Display Window). Здесь можно просмотреть различные срезы полу-

ченной модели пользуясь пунктом меню Display→Display inversion 

model. Мы перейдём сразу к построению результатов в программах 

Surfer и Voxler. Для этого экспортируем данные в GS Voxler в режиме 

просмотра программы Res3DInv (с предварительно загруженным ре-

зультатом инверсии) воспользовавшись пунктом меню File→Model 

Export→ Export model to Voxler XYZC format (или в более ранних 

версиях File→ Export model to RockWorks XYZG format). Настройки 

экспорта изменим и поставим точки напротив Save logarithm of values 

и сохраним файл 3D_Kamchatka_log10_res_voxler.dat без рельефа. За-

тем повторим экспорт, но уже сохраним данные с рельефом в файл 
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3D_Kamchatka_log10_res_voxler_topo.dat, поставив точку напротив 

соответствующего пункта – Model with topography – в настройках 

экспорта. Данные в полученных файлах будут сгруппированы в пять 

столбцов: первые три – координаты XYZ, четвёртый – lg(ρk), пятый 

чувствительность.  

Первый набор данных без рельефа 3D_Kamchatka_log10_res_voxler.dat 

мы используем для построения двумерных срезов полученной гео-

электрической модели по разным глубинам. Для этого экспортируем 

или скопируем содержимое файла в лист Excel, назвав его AllData. 

Данные можно отфильтровать по одной глубине (или координате) и 

скопировать их в новый лист, присвоив ему имя глубины. Сделаем 

это для глубины 7,2 и 17 м. Теперь можно использовать Surfer для 

построения карт распределения УЭС по разным глубинам, относи-

тельно дневной поверхности. Создадим гриды, последовательно вы-

брав листы Excel 7,2 и 17, и построим карты распределения УЭС на 

заданных глубинах в виде изоом (рис. 66). 

На срезе по глубине 7,2 м (рис. 66, а) видно, что площадь делится 

на 2 части: слева до 160 м высокоомные породы, а справа, после 

160 м, рыхлые отложения в виде низкоомной области. Если перейти 

на глубину 17 м (рис. 66, б), то можно заметить, что рыхлые отложе-

ния практически исчезли – осталась небольшая полоса в конце иссле-

дуемой площади: от 330 до 350 м. Проанализировав остальные глу-

бины, можно сказать, что наименьшая мощность рыхлых отложений 

в начале площади составляет 4 м, а с увеличением координаты X 

мощность возрастает и достигает 20 м. 

Более наглядно результат инверсии может быть представлен в 

трёхмерном виде с помощью программы Voxler. Для этого нужно 

воспользоваться вторым набором данных, где учитывается рельеф. 

Импортируем файл 3D_Kamchatka_log10_res_voxler_topo.dat в 

Voxler, сразу сохраним проект под названием 3D_Kamchatka.voxb и 

свяжем с ним модуль Gridder. Чтобы визуализировать трёхмерную 

геоэлектрическую модель, необходимо воспользоваться модулями 

VolRender, Axes, ClipPlane, Isosurface. Кроме того, в построении дан-

ной модели нужно учесть, что расстояния между профилями больше, 

чем между точками по профилю, поэтому для корректного построе-

ния модели нужно воспользоваться настройками анизотропии на 

вкладке Search в окне свойств модуля Gridder: например, длина оси 

эллипсоида по X – 100, по Y – 50, по Z – 10. Таким образом можно 
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визуализировать различные трёхмерные виды, полученной в результате 

инверсии геоэлектрической модели 

 

Рис. 66. Результат инверсии данных электротомографии в программе 

Res3DInv, горизонтальные срезы распределения УЭС на разных глуби-

нах: а – 7,2 м; б – 17 м 

 

На рис. 67 приведен один из возможных вариантов трёхмерного 

представления геоэлектрической модели исследуемого месторожде-

ния. В результате детального анализа, можно сделать такое же заклю-

чение, как и при рассмотрении двумерных срезов по глубине: 

наименьшая мощность рыхлых отложений на исследуемой площади 

составляет 4 м, а с увеличением координаты X (при наборе высоты) 

мощность возрастает и достигает 20 м. На рис. 67 рыхлые отложения, 

имеющие относительно низкие сопротивления, подчёркнуты изопо-

верхностью 500 Ом·м, которая резко погружается на 5–7 м начиная с 

150–160 м по X, но затем выполаживается и плавно опускается до 

20 м. Такое трёхмерное представление позволяет геофизику-интер-

претатору анализировать целостную картину модели изучаемого ме-

сторождения, а использование изоповерхностей позволяет оценивать 

объёмы (прогнозные ресурсы) рудных зон. 

Иногда требуется рассмотреть распределение УЭС по абсолют-

ным глубинам (срезы по альтитуде). Такие построения можно сде-

лать, используя уже созданную в Voxler визуализацию трёхмерной 

модели 3D_Kamchatka.voxb. Как уже говорилось в п. 5.2, для этого 

нужно нажать правой кнопкой мыши на модуль  и в всплы-

вающем списке выбрать пункт Save Data. Появится диалоговое окно, 

где нужно выбрать тип файлов (GRD Surfer 7 Binary Grid (*.grd)), ука-

зать папку, сохранить гриды и использовать их для построения дву-

мерных карт в программе Surfer. 
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Рис. 67. Трёхмерное представление результата инверсии данных элек-

тротомографии в программе Voxler 

 

Заметим, что все приведённые двумерные и трёхмерные построе-

ния проводятся в условных координатах. Для построения карт рас-

пределения УЭС в реальных координатах нужно добавить к услов-

ным координатам X и Y координаты, определённые по GPS/ГЛО-

НАСС. Не обязательно привязывать с помощью GPS все электроды 

на профиле. Достаточно определить координаты первого и послед-

него электрода, а также электродов в местах резкого изменения рель-

ефа местности. Координаты остальных электродов вычисляются пу-

тём интерполяции в Excel. Для этого поместите координаты элек-

трода в ячейку с соответствующим номером (первый электрод в 

первую ячейку, сорок восьмой – в сорок восьмую, и т. д.). Выделите 

столбцы с реальными координатами. На вкладке «Главная» в группе 

Редактирование нажмите кнопку «Заполнить» и выберите пункты 

«Прогрессия», отметьте «Арифметическая». Excel автоматически 

расставит недостающие координаты электродов. Для самоконтроля, 

выделите столбцы с координатами и постройте точечную диаграмму. 

Точки на графике должны отображать положение ваших электродов 

на местности. 
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Теперь, установив соответствие между условными и реальными 

координатами, можно выбрать соответствующие столбцы листа 

Excel и построить двумерные и трёхмерные геоэлектрические модели 

в реальных координатах. Такие построения можно накладывать на 

топографические карты и космоснимки. 

Таким образом, мы на практических примерах кратко рассмотрели 

обработку полевых данных полученных с помощью метода электро-

томографии: препроцессинг (первичная обработка), объединение в 

единый профиль и экспорт данных для дальнейшей инверсии в про-

граммах SiberTools и RiPPP. Решение двумерной и трёхмерной об-

ратной задачи электротомографии в программах Res2DInv и 

Res3DInv, соответственно, в том числе с учётом рельефа; визуализа-

ция и анализ полученных в результате инверсии моделей в програм-

мах Surfer и Voxler. 

Все разобранные программы позволяют работать как с проводя-

щей, так и с поляризующейся моделью. При моделировании и обра-

ботке данных мы использовали только параметр сопротивления. 

Принципы обработки данных, где присутствует параметр вызванной 

поляризации идентичны. 

Главное, что нужно понимать при обработки данных ЭТ – инвер-

сия геофизических данных, в том числе электроразведочных, это не-

корректная задача. Поэтому итоговая геоэлектрическая модель зави-

сит не от выбранной программы или метода решения обратной за-

дачи, а по большей части от опыта и знаний геофизика-интерпрета-

тора.  
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ЗАКЛЮЧЕНИЕ 

 

Вы познакомились с электротомографией – наиболее распростра-

нённой в настоящее время модификацией метода сопротивлений, од-

ного из основных методов электроразведки. Помимо основ метода 

были рассмотрены вопросы методики и техники проведения работ. 

Кроме того, в основной части пособия, представлены принципы при-

менения численного моделирования: двумерные и трёхмерные пря-

мые и обратные задачи электротомографии при решении методиче-

ских и практических задач рудной геофизики. 

В учебном пособии приводятся примеры работы с программами 

прямого и обратного моделирования данных метода электротомогра-

фии, где используются простейшие, тривиальные геоэлектрические 

модели и типичные модели рудных месторождений. Разобранные 

примеры позволяют будущему специалисту познакомиться с воз-

можностями и значением математического моделирования в разве-

дочной геофизике. Эти знания и навыки являются неотъемлемой ча-

стью подготовки специалистов-геофизиков и отвечают современным 

требованиям, предъявляемым к выпускникам. 

Роль математического моделирования в части интерпретации гео-

физических данных трудно переоценить. Тем не менее, главным дей-

ствующим лицом при обработке полевого материала ещё долгое 

время будет оставаться человек, и итоговая геоэлектрическая модель 

зависит не от выбранной программы или метода решения обратной 

задачи, а по большей части от опыта и знаний геофизика-интерпрета-

тора. В данном пособии мы предложили обучаемому получить пер-

вые знания и опыт на этом интересном пути. 
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ПРАКТИЧЕСКИЕ ЗАДАНИЯ 

 

Работа № 1 

 

Обработка данных электротомографии  

при поисково-разведочных работах  

на золоторудном месторождении Гранитное 

Задание 

1. Ознакомиться с геологической характеристикой месторожде-

ния и методикой проведения исследований. 

2. Построить карту расположения профилей. 

3. Выполнить первичную обработку (препроцессинг) данных 

электротомографии в программе RiPPP. 

4. Провести 2-D инверсию данных электротомографии в про-

грамме Res2Dinv. 

5. С помощью программы Surfer построить геоэлектрические 

разрезы по профилям. 

6. Выполнить геологическую интерпретацию геоэлектрических 

разрезов, построить интерпретационный разрез по одному из профилей. 

7. Составить краткий отчёт о проделанной работе содержащий: 

цели и задачи работы, краткую геологическую характеристику место-

рождения, методику измерений и обработки данных, описание ре-

зультатов (интерпретацию), выводы. 

Входные данные 

1. Геологическая характеристика месторождения. 

2. Космоснимок участка работ 

3. Информация о методике измерений. 

4. Исходные файлы с данными ЭТ-ВП. 

5. Данные о топографии участка по профилям. 

Необходимое программное обеспечение 

1. RIPPP – препроцессинг данных ЭТ-ВП. 

2. SasPlanet – создание космоснимка участка работ. 

3. Res2Dinv – автоматическая двумерная инверсия данных ЭТ-ВП. 

4. Surfer – построение разрезов УЭС и ВП по профилям и интер-

претационного разреза. 
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Геологическая характеристика месторождения 

Месторождение относится к малосульфидному золото-кварце-

вому жильному типу [27]. Оно расположено в горной местности с аб-

солютными отметками высот 2300–2500 м, в зоне распространения 

многолетнемёрзлых пород до глубины 200 м. Мощность перекрыва-

ющих рыхлых отложений незначительна, за исключением осыпей. 

Золотоносные кварцевые жилы залегают преимущественно среди 

гнейсо-гранитов и приурочены к зонам рассланцевания и милонити 

элементами месторождения являются крутопадающие (60–70°) тек-

тонические зоны северо-западного простирания (рудная зона № 1, 2). 

Породы в рудной зоне № 1 интенсивно катаклазированы, рассланцо-

ваны, милонитизированы и подвергнуты вторичным гидротермаль-

ным изменениям. Общая глубина разведанности месторождения со-

ставляет 180 м. Сульфидная минерализация, в основном, представ-

лена пиритом (5–10 %), реже встречаются галенит, сфалерит, пирро-

тин, видимое золото. 

Методика измерений 

Электротомография с измерением вызванной поляризации выпол-

нялась по сети субпараллельных профилей. Расстояние между про-

филями изменялось № 1, 2 составило 180 м, между профилями № 2, 

3–125 м.  

Шаг измерений по профилям (расстояние между электродами) со-

ставляло 10 м. При этом общая длина расстановки составляла 630 м. 

Наращивание длины профиля проводилось способом нагоняющей 

(roll-a-long), когда первый сегмент косы из 32 электродов перено-

сится вперёд по профилю. Длина профилей № 1–3 составила 950 м. 

При измерениях применялась аппаратура «Скала-64». Последова-

тельность подключения электродов соответствовала прямой и 

встречной трёх-электродным установкам. Электрод С выносился в 

«бесконечность» на расстояние 2 км от профиля наблюдений. Мак-

симальный разнос АО составил 550 м, что обеспечило глубинность 

исследований около 200 м. 

В режиме измерения вызванной поляризации (ВП) длительность 

импульса зарядки среды составляла 100 мс, длительность паузы – 

160 мс. Поляризуемость среды оценивалась по параметру «заряжае-

мости» – интегральной характеристике, представляющей собой пло-

щадь под кривым спадом ВП в диапазоне времён 20–180 мс. 
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Работа № 2 

Построение трёхмерной геоэлектрической модели  

и карт участка исследований по данным электротомографии 

при поисково-разведочных работах  

на золоторудном месторождении Гранитное 

Задание 

1. С помощью программы Res2Dinv сгруппировать данные дву-

мерных измерений в трёхмерный массив.  

2. С помощью программы Res3Dinv выполнить трёхмерную ин-

версию и экспортировать результат в формат XYZ. 

3. Скопировать трёхмерный массив данных, содержащий ориги-

нальные координаты точек съёмки (The x, y and z original coordinates 

of the survey grid points) из файла *.XYZ и вставить в таблицу Excel. 

4. С помощью программы Voxler построить объёмную геоэлек-

трическую модель УЭС. 

5. В таблице Excel добавить к массиву данных географические 

координаты точек измерений. 

6. Выделить и перенести на разные листы данные, соответству-

ющие разным глубинам исследований. 

7. С помощью программы Surfer построить карты распределе-

ния УЭС и поляризуемости на глубинах 22, 51, 96 м в географических 

координатах. Экспортировать карты в файл *.kml и загрузить в про-

грамму GooglEarth. 

8. Провести качественную и геологическую интерпретацию 

данных, выделить предполагаемые рудные зоны, задать положение, 

азимут и глубину заверочных скважин. Оценить прогнозные ресурсы 

P1 предполагаемых рудных зон при среднем содержании золота 1 г/т. 

9. Составить отчёт о проделанной работе, содержащий краткую 

геологическую характеристику участка, краткую методику работ и 

обработки данных, результаты интерпретации. 

Входные данные 

1. Геологическая характеристика месторождения. 

2. Геологическая карта участка работ, масштаб 1 : 2000. 

3. Информация о методике измерений. 

4. Исходные файлы с 2-D данными ЭТ-ВП по профилям. 
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5. Управляющий файл 3D.txt для сшивания данных в трёхмер-

ный массив. 

 

Необходимое программное обеспечение 

1. Res2Dinv – сшивка 2-D файлов в 3-D массив (File>Collate). 

2. Res3Dinv – 3-D инверсия и экспорт в XYZ. 

3. Voxler – построение объёмных геоэлектрических моделей. 

4. Surfer v.13–15 – построение карт распределения УЭС и поля-

ризуемости на разных глубинах.  

5. GooglEarth – построение карт УЭС на рельефе земной поверх-

ности. 

Геологическая характеристика месторождения 

Использовать геологическую характеристику месторождения из 

практической работы № 1. 

Методика измерений 

Использовать методику измерений из практической работы № 1. 
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